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GPT for Excel

GPT for Excel is a Microsoft Excel add-in that integrates an AI agent into the Excel user interface.
Use plain-language instructions to automate everyday spreadsheet tasks — such as writing
formulas, fixing errors, formatting cells, or creating charts and pivot tables — or process large
datasets row by row with operations such as translation, categorization, enrichment, and scoring.

Use cases
Here are common use cases that you can easily handle with GPT for Excel.

Install for Microsoft
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Everyday spreadsheet tasks

Write spreadsheet formulas like a pro.

Format cells, ranges, or entire sheets to match your preferred style or conventions.

Standardize inconsistent date formats, trailing whitespace, or mixed capitalization across your
sheet.

Create charts and pivot tables from your existing data to visualize trends and summarize
results.

Find and fix errors in formulas, references, or inconsistent data.

Row-by-row bulk processing

Generate SEO-optimized product descriptions from product specifications.

Translate product descriptions to multiple target languages while observing appropriate
localization conventions.

Enrich company or contact records with data from AI-powered web lookups.

Categorize support tickets, survey responses, or product feedback into groups that match your
taxonomy.

Clean up customer relationship management (CRM) data by reformatting fields, recategorizing
records, and removing duplicates.

Score and qualify sales leads in a consolidated prospecting spreadsheet.

Analyze customer sentiment by rating reviews and support requests based on criteria relevant
to you.

Features
GPT for Excel provides the following main features for using AI in spreadsheets:

Agent

Bulk tools

GPT functions

Agent

The Agent is the chat interface for spreadsheet work in GPT for Excel. Describe what you need in
plain language — from everyday spreadsheet tasks to row-by-row bulk processing across large
datasets — and the Agent reads your data, determines the required steps, and executes them
directly in your spreadsheet.
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The following video shows you how to use the Agent to fill in missing company information in a
market research spreadsheet. Based on a simple prompt, the Agent fetches the missing
information from the web and fills the empty columns.

Bulk tools

Bulk tools allow you to run prompts on specific spreadsheet columns at once without writing any
formulas. You configure and run bulk tools from the add-in sidebar. You can also easily reuse past
prompts and configurations with the History feature.

GPT for Excel provides dedicated bulk tools for selected use cases, such as translation,
classification/categorization, and extraction, as well as a generic bulk tool for fully custom
prompts.

The following video shows you how to generate some text with the Custom prompt bulk tool. You
simply tell the tool what you want to generate and select the column where you want to place the
generated text. You do not need to define any other settings if the default setup meets your needs.
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GPT functions

GPT functions are custom spreadsheet functions that allow you to prompt AI from inside
spreadsheet cells. GPT functions work exactly like native functions in that you can use them on
their own or combine them with other functions when creating formulas.

GPT for Excel provides dedicated GPT functions for selected use cases, such as translation,
classification, and web search, as well as a generic GPT function for all other use cases. You can
define function-specific parameters to further refine how the AI generates responses. You can find
a list of all available functions with usage examples in the add-in sidebar.

The following video shows you how to generate some text in bulk with the GPT function.

Which feature to use when

The following table shows how easy it is to use the different features and describes the overall
experience of using each. As a rule, start with the Agent.

Agent Bulk tools GPT functions

Easy Moderate Advanced
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Agent Bulk tools GPT functions

Tell the AI what you want
in plain language.

Automate spreadsheet
tasks or workflows across
multiple columns.

Let the AI automatically
figure out the steps.

Process a column row by
row.

Precisely control the
prompt, model, and
settings.

Easily reuse prompts and
configurations.

Use AI directly inside
spreadsheet formulas.

Drag formulas across rows
or columns.

Get results that update
automatically when inputs
change.

Benefits
Prompt AIs from inside your spreadsheets. No more copy-pasting between Excel and AI
chatbots like ChatGPT.

Chat with your spreadsheets in plain language. Simply tell the Agent in your own words what
you want to do, and it will automatically plan and execute the task. No prompt engineering
required.

Run prompts at scale and at lightning speed. Execute up to 1,000 prompts per minute,
reliably process up to 1,000,000 rows in one go, and generate up to 10,000 results per hour.

Use the best AI model for your bulk tasks. Choose from a large selection of models from
OpenAI, Anthropic, Google, xAI, and Perplexity.

Bring an API key or set up your own API endpoint to get more features. You do not need
your own API keys or endpoints to use Excel, but they give you access to more models and
afford you more control and privacy.

What's next
Install GPT for Excel if you have not already.

Select an AI model that best meets your needs.
Get going with the Agent.

Get going with bulk tools.

Get going with GPT functions.
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Get started with GPT for Excel
GPT for Excel is an AI agent for spreadsheet work in Microsoft Excel. It integrates directly into
your spreadsheet and lets you automate spreadsheet tasks through plain-language instructions.

This guide gives you a quick walkthrough of the add-in from installation to trying out the Agent.

Install the add-in
To use GPT for Excel, install the add-in:

For detailed installation instructions, see Install GPT for Excel.

Open the add-in

Install for Microsoft

Create a new blank workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

The GPT for Excel sidebar opens.

2
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Use the Agent
The Agent is the chat interface for spreadsheet work in GPT for Excel. Describe what you need in
plain language — from everyday spreadsheet tasks to row-by-row bulk processing across large
datasets — and the Agent reads your data, determines the required steps, and executes them
directly in your spreadsheet.

Let's have the Agent do some quick market research for us. We'll use one of the built-in examples
for convenience.

In the sidebar, select Agent.1
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Click Examples and select Market research.

GPT for Excel:

2

i. Creates a new sheet prepopulated with example data. The data is a list of company names
and a series of empty columns for company information that we want the Agent to fill in.

1

ii. Prefills the Agent chat field with a prompt that will accomplish the example task: Fill 
out this table . This simple prompt is enough for the Agent to fetch the missing
company information from the web and fill the empty columns.

2
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The following video shows the entire process.

What's next
Learn more about GPT for Excel.

Learn more about the Agent.

Learn about the other features available in GPT for Excel:

Bulk tools

GPT functions

Try out different AI models.

Try out example Agent use cases for different business applications and product capabilities.

Click the send button.

The Agent:

TIP

You can follow the Agent's thinking and workflow live in the sidebar.

3

i. Analyzes the prompt and drafts a plan for accomplishing the requested task.1

ii. Executes the plan. In this example, the Agent fetches the missing company information
from the web and fills the empty columns B-E with what it found, one by one. Note that for
column F, which does not require web search, the Agent uses gpt-4.1 (no web search).

2
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Set up GPT for Excel
Install GPT for Excel, open the add-in, and sign in. If needed, configure API keys and endpoints to
access more models. If you no longer use GPT for Excel, remove its access to your Microsoft
account or uninstall the add-in.

Install

Install the GPT for Excel Word add-in to use AI in your Excel workbooks.

Open

Open the GPT for Excel Word add-in in Microsoft Excel.

Sign in

Use a Microsoft account to sign in to GPT for Excel, switch between accounts, and sign out.

Manage models

Connect AI models to Microsoft Excel with GPT for Excel.

Remove account access

Remove Microsoft account access from the GPT for Excel Word add-in.

Uninstall

Remove the GPT for Excel Word add-in from your Microsoft account.
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Install GPT for Excel
GPT for Excel is part of the GPT for Excel Word add-in. One installation covers Microsoft Excel and
Microsoft Word, on both desktop and the web; this guide focuses on installing and using the add-
in for Microsoft Excel.

The following table lists the minimum versions of Microsoft Excel compatible with the GPT
for Excel Word add-in on different Microsoft Office platforms.

Windows macOS Web

Microsoft 365 subscription:

Version 2002 (Build
12527.20092)

Retail perpetual:

Version 2002 (Build
12527.20092)

Volume-licensed perpetual:

Excel 2021: Version 2108 (Build
12527.20092)

Version 16.35 (Build
20030802)

Supported on:

Google Chrome
(latest version)
Microsoft Edge
(latest version)

Which version of Excel am I using?

Installation

Prerequisites

Go to the installation page.1

Click Open in Excel.

INFO

The add-in will be installed on your Microsoft account for both Excel and Word.

2
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A pop-up appears at the top of the window, requesting your permission to proceed.

Confirm to open the Excel desktop app.

INFO

If this method doesn't work, install the add-in from the app:

3

i. Open Excel.1

ii. On the ribbon, select Home > Add-ins.2

iii. Search for "GPT for Excel Word".3

iv. In the search results, click Add for GPT for Excel Word.4
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You have installed GPT for Excel Word on your Microsoft account. The add-in is now available from
the Home tab in the desktop and web versions of Excel. If you don't see it, go to Home > Add-ins >
My add-ins > GPT for Excel Word.

FOR IT ADMINISTRATORS

If your organization uses a firewall or proxy that restricts network access, you must whitelist
the following domains for the add-in to work:

Click Accept and Continue to accept the permissions.4

*.gptforwork.com
*.microsoft.com
*.microsoftonline.com
*.live.com
*.office.com
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Having trouble installing?
If you run into any issues while installing the add-in, see the troubleshooting guide.

What's next
Open GPT for Excel.

Learn about GPT for Excel.

Select a model:

Select the models for the Agent.

Select a model for bulk tools.

Select a model for GPT functions.

Get started with the Agent, bulk tools, and GPT functions.
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Open GPT for Excel
On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-ins
> My Add-ins > GPT for Excel Word. Learn more.

What's next
Sign in with your Microsoft account.

If you run into issues, see the troubleshooting guide.
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Sign in to GPT for Excel
This section explains how GPT for Excel authenticates your Microsoft account, how to check which
account you're using, and how to switch between accounts or sign out.

Sign in with your account

Sign in to GPT for Excel with your Microsoft account.

Check which account you're using

How to check which Microsoft account GPT for Excel is using.

Switch to another account

Use a different Microsoft account with GPT for Excel.

Sign out

How to sign out of GPT for Excel.
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Sign in with your Microsoft account
You need a Microsoft account to use GPT for Excel.

When you launch the GPT for Excel Word add-in:

From Excel desktop:

If you're already signed in with your Microsoft account, the add-in automatically uses that
account.

If you're not signed in or you're using multiple accounts, the add-in prompts you to choose an
account.

From Excel for the web: You need to sign in with your Microsoft account when you first launch
the add-in.

If you have multiple Microsoft accounts, such as a personal account and a work account, you can
switch between them to ensure you are using the correct account in GPT for Excel.

What's next
Check which account is used by GPT for Excel.

If needed, switch to another account.
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Check which Microsoft account you're
using
To check which Microsoft account you are using in GPT for Excel:

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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What's next
If needed, switch to another account.

In the sidebar, open the main menu. Your account is displayed at the bottom of the menu.3
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Switch to another Microsoft account
If the account currently used by GPT for Excel is not the one you want to use, switch to another
account:

You have switched to another account. You can now launch and use GPT for Excel with the new
account.

TIP

If you signed in with the wrong account during installation, contact support to request an
account transfer.

Launch Excel.1

In the upper-right corner of the application, click your account icon or picture.2

Select the account you want to switch to.

INFO

If the account you want to switch to is not in the list, click to add a new account and
complete the sign-in process.

3

If you are using the desktop version of Excel, close the application and reopen it.4
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Sign out of GPT for Excel
To sign out of GPT for Excel:

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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INFO

Signing out of GPT for Excel also signs you out of GPT for Word, since they use the same
Microsoft account session.

You have signed out of GPT for Excel. You'll need to sign in again when you next launch the add-in.

What's next
Sign in with your Microsoft account.

In the sidebar, open the main menu. Then, select Log out.3
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Manage models for GPT for Excel
Models are the engines that power GPT for Excel. GPT for Excel supports models from OpenAI,
Perplexity, Google, Anthropic, Parallel, DeepSeek, Mistral, and xAI. GPT for Excel also supports
Azure models and open-source models through any OpenAI-compatible API endpoint.

INFO

As a space owner or admin, you can control which models are available to users in your space
through the AI configuration section in the GPT for Work dashboard.

Which model is the right one depends on your specific needs in terms of response quality, speed,
privacy, and cost. The following table summarizes the kinds of models available in GPT for Excel,
from zero setup to more advanced options:

Use Setup When

Models
without an API
key

None.

Use the default model
or select a different
model:

Agent

Bulk tools

GPT functions

You want to get started quickly without setting
up API keys.

✅ Available models

Models with an
API key 🔑

AI provider models

Set an API key for an AI
provider.

You want to benefit from the terms of service
you have with an AI provider, such as cost,
privacy, and rate limits.

You want to use a model that is not available
without an API key.

You want more control.

✅ Available models
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Use Setup When

Models from
cloud
endpoints

Azure OpenAI models

Set up an Azure
OpenAI endpoint.

Your company is already using Azure with a
consumption commitment. Using Azure
OpenAI counts towards that commitment.

You want to use models that are available
through Azure OpenAI.

✅ Available models

OpenAI-compatible
models

Set up an OpenAI-
compatible platform
endpoint.

You want to use models available on a cloud-
based LLM platform such as Anyscale or
Fireworks AI.

You need a fast and powerful inference
infrastructure that scales to your performance
needs.

Local models

OpenAI-compatible
models

Set up an OpenAI-
compatible server
endpoint.

You want to use models available on a local
LLM server such as LM Studio or Ollama.

You want to run models on a local machine.

You do not want to send or receive any
prompt or response data over the internet.

What's next
Set and manage your API keys.

Use Azure OpenAI models.

Use OpenAI-compatible models through API endpoints.

Use Ollama models.
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Manage API keys for GPT for Excel
Using API keys offers several benefits:

More models. Access to a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage AI usage and costs directly on the AI provider's platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key. For
more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

If you're on a subscription plan, using an API key is mandatory since you do not have access to
models without a key.

Create API keys

INFO

Make sure your keys belong to an organization or project with the following rate limits:

RPM (requests per minute) ≥ 1,000

TPM (tokens per minute) ≥ 1,000,000

The actual limits required depend on your workload requirements.

To create an API key, go to the AI provider's platform and follow their instructions:

OpenAI Platform for GPT models and fine-tuned models

Anthropic Console for Claude models

DeepSeek Platform for DeepSeek models

Google AI Studio for Gemini models

Mistral AI for Mistral models

Perplexity for Perplexity models

xAI Cloud Console for xAI models
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Set API keys
You set API keys for your space in the GPT for Work dashboard. The keys you set for a Microsoft
account space apply to GPT for Excel.

INFO

The API keys you set work for all users in your space. Users automatically have access to
models associated with the keys, but only the space owner (you) and admins can set and
manage the keys. Billing for a key reflects its usage by all users.

Create an API key or request an API key from your AI provider platform admin. Learn more.1

Sign in to the GPT for Work dashboard with your Microsoft account.2

In the sidebar, select AI provider keys.3

In the AI providers list, click the provider whose API key you want to set.4

Set the API key:5

i. In the text field, enter the key.1

ii. Click Check to verify that the key is valid.2

iii. Click Save.3
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You have set the API key. You can now use any model available with the key in GPT for Excel.

Check API keys
You can verify whether the API keys you have set are valid.

Check all API keys at once

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click Check all API keys.

The page displays a warning for each key that is invalid.

3
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Check a specific API key

If a key is invalid, create a new key and replace the invalid value with the new one.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click the edit icon for the key you want to check.3

Click Check.

The UI displays a message indicating whether the key is valid or invalid.

4
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Troubleshoot OpenAI API keys
If your API key is not working, check on the OpenAI Platform that the key's permissions are not
restricted. The following permissions are required:

Permission Description

List models List all available models.

Model capabilities Use model capabilities, such as chat completion.

Fine-tuning Connect OpenAI fine-tuned models to Microsoft Excel.

What's next
Check which models you can use with an API key.

Select a model with an API key:

Select the Agent models.

Select a model for bulk tools.

Select a model for GPT functions.

Need to use your own LLM service endpoint for models? Connect to an OpenAI-compatible
endpoint.

If the key is invalid, create a new key and replace the invalid value with the new one.
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Connect to Azure OpenAI from Excel
GPT for Excel can connect to Azure AI to use OpenAI models. In Azure AI, each model has a
dedicated API endpoint that you use to access the model.

You have an Azure subscription with Azure AI service access.

You have deployed a model in an Azure OpenAI resource.

To use an Azure OpenAI model:

Get the Azure OpenAI endpoint details
To connect to Azure AI from GPT for Excel, you need the endpoint URL, name, and API key for the
Azure OpenAI model you want to use.

Prerequisites

Get the Azure OpenAI endpoint details for the model.1

Set up the Azure OpenAI endpoint.2

Select the Azure OpenAI model.3

Sign in to Azure AI Foundry.1

Select the Azure OpenAI resource that has the model you want to use.2
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In the sidebar, select My assets > Models + endpoints.3

In Model deployments, in the models list, click the name of the model you want to use.4
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Set up the Azure OpenAI endpoint

In the model details, copy the Target URI, Key, and Model name.5

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2
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Click Azure OpenAI endpoints.

TIP

If you already have Azure OpenAI endpoints set up, click Add another Azure OpenAI
endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the endpoint URL for the model.

Model name: Enter the model name.

API key: Enter the API key for accessing the endpoint.

Display name (optional): Enter a custom display name for the model. If not set, the model
switcher uses Model name as the display name.
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You have set up the Azure OpenAI endpoint. You can now use the endpoint model in GPT for Excel.

TIP

To set up another Azure OpenAI endpoint with a different model, click Add another Azure
OpenAI endpoint and repeat the previous two steps.

Select the Azure OpenAI model

Click Check to validate the settings and click Save.5

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.2
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GPT for Excel now uses the selected model to generate responses for bulk tools and GPT functions.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

In the sidebar, select Bulk tools and select one of the tools.3

Open the model switcher. You can find the Azure OpenAI model under Use your API key or
endpoint.

4

Select the model.5
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Connect to OpenAI-compatible API
endpoints from Excel
GPT for Excel can connect to any LLM service that provides an OpenAI-compatible API endpoint.
You can connect to two main types of services: cloud-based platforms, which provide access to
models over the internet with no software installation or setup required on your part, and local
servers, which you run on a local machine, such as your own computer or another computer on a
local network. Once connected, all models available through the service become available to use in
GPT for Excel.

Here are some popular services that provide an OpenAI-compatible API endpoint:

Cloud-based platforms:

Anyscale

Fireworks AI

Together AI

Local servers:

LM Studio

LocalAI

Ollama

You have an endpoint URL and, if needed, an API key for accessing the service.

The endpoint must support the following OpenAI-compatible API resource paths:

/v1/models

/v1/completions

INFO

You cannot currently use models from OpenAI-compatible API endpoints with the Agent.

INFO

Depending on the model you use, the model settings defined in GPT for Excel (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

To use models from an OpenAI-compatible API endpoint:

Prerequisites
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Set up an API endpoint

Set up the endpoint.1

Select a model available through the endpoint.2

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click OpenAI-compatible endpoints.

TIP

If you already have OpenAI-compatible API endpoints set up, click Add another OpenAI
compatible endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the URL of the service that provides the endpoint.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom/".

API key (optional): If required, enter the API key for accessing the service.
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Click Check to validate the settings and click Save.5
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You have set up the OpenAI-compatible API endpoint. You can now use all models available
through the endpoint in GPT for Excel.

TIP

To set up another OpenAI-compatible API endpoint, click Add another OpenAI compatible
endpoint and repeat the previous two steps.

Select a model from the API endpoint

TIP

If you get an error saying that the URL is invalid, make sure that the endpoint supports:

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for macOS
or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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GPT for Excel now uses the selected model to generate responses for bulk tools and GPT functions.

What's next
To try out an OpenAI-compatible LLM service with GPT for Excel, set up LM Studio on macOS or
Windows.

In the sidebar, select Bulk tools and select one of the tools.3

Open the model switcher. You can find the models under Use your API key or endpoint.

NOTE

The available models depend on the models provided by the service.

4

Select a model.5
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Set up LM Studio on macOS
This guide walks you through the main steps of setting up LM Studio for use in GPT for Excel on
macOS.

This guide assumes that you use GPT for Excel on the same machine that hosts LM Studio.

System requirements

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up LM Studio on macOS:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

(Optional) Enable HTTPS for the LM Studio server.3

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

1

Run LM Studio.2

On the welcome screen, click Skip.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the minimum setup required to access LM Studio from GPT for Excel on
the same machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for
Excel provided the add-in is not running on Safari or on Microsoft Excel for Mac.

If you use GPT for Excel on Safari or on Excel for Mac, enable HTTPS for the LM Studio server.

Click the Enable CORS toggle to enable the setting.

INFO

By default, the LM Studio server only accepts same-origin requests. Since GPT for Excel
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5
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Enable HTTPS for the LM Studio server
The LM Studio server uses HTTP to serve models, while GPT for Excel runs on HTTPS. By default,
therefore, any request from GPT for Excel to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the LM Studio server accessible over HTTPS if you use GPT
for Excel from:

Excel for the web on Safari

Excel for Mac (uses Safari)

You make the LM Studio server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the LM Studio server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \
  -nodes \
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The command generates two files in the current directory:

  -sha256 \
  -days 365 \
  -keyout lm-studio.key \
  -out lm-studio.crt \
  -subj '/CN=127.0.0.1' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=127.0.0.1\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

lm-studio.crt : Public self-signed certificate

lm-studio.key : Private key used to sign the certificate

iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./lm-studio.crt

Create a site configuration for the LM Studio server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       127.0.0.1:1235 ssl;
        server_name  127.0.0.1;

        http2 on;

        ssl_certificate      lm-studio.crt;
        ssl_certificate_key  lm-studio.key;

        location / {
            proxy_pass  http://127.0.0.1:1234;

            # Keep connection to backend alive.
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You have enabled HTTPS for the LM Studio server.

The configuration uses port 1235  for HTTPS. Requests to https://127.0.0.1:1235  are
forwarded to the LM Studio server running at http://127.0.0.1:1234 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf syntax 
is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /v1/models  endpoint of the LM Studio server works over the HTTPS
connection:

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

4

curl -k https://127.0.0.1:1235/v1/models

{
  "data": [
    {
      ...
    },
  ],
  "object": "list"
}
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WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Excel on the same
machine. You can now set https://127.0.0.1:1235  as the endpoint URL in GPT for Excel,
including when the add-in is running on Safari or on Microsoft Excel for Mac.
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Set up LM Studio on Windows
This guide walks you through the main steps of setting up LM Studio for use in GPT for Excel on
Windows.

This guide assumes that you use GPT for Excel on the same machine that hosts LM Studio.

System requirements

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up LM Studio on Windows:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer sets LM Studio to start automatically as a background service on system boot.

1

Run LM Studio.2

On the welcome screen, click Skip.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Excel on the same
machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for Excel.

Click the Enable CORS toggle to enable the setting.

INFO

By default, the LM Studio server only accepts same-origin requests. Since GPT for Excel
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5

GPT for Work Documentation (Microsoft) 2026-05-13

51 / 415

https://gptforwork.com/docs/gpt-for-excel/setup/manage-models/connect-to-api-endpoints#set-up-an-api-endpoint
https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
https://developer.mozilla.org/en-US/docs/Web/HTTP/CORS
http://127.0.0.1:1234/v1/models


Connect to Ollama from Excel
GPT for Excel can connect to an Ollama server to use locally running open-source models. Ollama
is an open-source platform that allows you to easily install, run, and serve models from a local
machine, keeping your prompting entirely offline. You can use any model from the Ollama library.

You have an Ollama server running with one or more models. For instructions on how to set
up the server, see:

Set up Ollama on macOS

Set up Ollama on Windows

INFO

You cannot currently use Ollama models with the Agent.

INFO

Depending on the model you use, the model settings defined in GPT for Excel (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

To use models from an Ollama server:

Set up the API endpoint for an Ollama server

Prerequisites

Set up the API endpoint for the Ollama server.1

Select a model available on the Ollama server.2

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click OpenAI-compatible endpoints.

TIP

If you already have OpenAI-compatible API endpoints set up, click Add another OpenAI
compatible endpoint.

3
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Define the endpoint settings:4

Endpoint URL: Enter the URL of the Ollama server.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom/".

API key (optional): Leave this field empty. The Ollama server does not require an API key
for access.

GPT for Work Documentation (Microsoft) 2026-05-13

53 / 415



You have set up the Ollama server API endpoint. You can now use all models available through the
endpoint in GPT for Excel.

Select a model from the Ollama server

Click Check to validate the settings and click Save.

TIP

If you get an error saying that the URL is invalid, make sure that the Ollama server
supports:

5

Cross-origin resource sharing (CORS). See the Ollama server setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the Ollama
server setup instructions for macOS.

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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GPT for Excel now uses the selected model to generate responses for bulk tools and GPT functions.

What's next
Set up an Ollama server on macOS or Windows.

In the sidebar, select Bulk tools and select one of the tools.3

Open the model switcher. You can find the Ollama models under Use your API key or
endpoint.

NOTE

The available models depend on the models available on the Ollama server.

4

Select a model.5
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Set up Ollama on macOS
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Excel on macOS.

This guide assumes that you use GPT for Excel on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for hardware support information)

macOS Sonoma (version 14) or newer (see the Ollama documentation for detailed system
requirements)

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up an Ollama server on macOS:

Install an Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

(Optional) Enable HTTPS for the server.4

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1
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You have installed the Ollama server.

For more information about installing and managing the server on macOS, see the Ollama
documentation.

Install a model on the Ollama server

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Enable CORS for the Ollama server
By default, the Ollama server only accepts same-origin requests. Since GPT for Excel always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Open Terminal and verify that the server is running:

Response if the server is running:

2

curl http://localhost:11434

Ollama is running

Install a model from the Ollama library:

For example, to install the Meta Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'

GPT for Work Documentation (Microsoft) 2026-05-13

57 / 415

https://docs.ollama.com/macos
https://docs.ollama.com/macos
https://docs.ollama.com/cli
https://developer.mozilla.org/en-US/docs/Web/Security/Same-origin_policy
https://developer.mozilla.org/en-US/docs/Web/HTTP/Guides/CORS
https://ollama.com/search
https://ollama.com/library/llama3.2


You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the minimum setup required to access the Ollama server from GPT for
Excel on the same machine. You can now set http://localhost:11434  as the endpoint URL
in GPT for Excel provided the add-in is not running on Safari or on Microsoft Excel for Mac.

If you use GPT for Excel on Safari or on Excel for Mac, enable HTTPS for the Ollama server.

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:

For example:

1

# Set a single origin
launchctl setenv OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
launchctl setenv OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "*"

Allow only GPT for Excel to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

Restart the server for the variable to take effect.2

Verify that the /api/tags  endpoint of the server works:

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [
    {
      ...
    }
  ]
}
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Enable HTTPS for the Ollama server
The Ollama server uses HTTP to serve models, while GPT for Excel runs on HTTPS. By default,
therefore, any request from GPT for Excel to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the Ollama server accessible over HTTPS if you use GPT for
Excel from:

Excel for the web on Safari

Excel for Mac (uses Safari)

You make the Ollama server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the Ollama server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \
  -nodes \
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The command generates two files in the current directory:

  -sha256 \
  -days 365 \
  -keyout ollama.key \
  -out ollama.crt \
  -subj '/CN=localhost' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=localhost\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

ollama.crt : Public self-signed certificate

ollama.key : Private key used to sign the certificate

iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./ollama.crt

Create a site configuration for the Ollama server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       11435 ssl;
        server_name  localhost;

        http2 on;

        ssl_certificate      ollama.crt;
        ssl_certificate_key  ollama.key;

        location / {
            proxy_pass  http://localhost:11434;

            # Keep connection to backend alive.
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You have enabled HTTPS for the Ollama server.

The configuration uses port 11435  for HTTPS. Requests to https://localhost:11435
are forwarded to the Ollama server running at http://localhost:11434 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf syntax 
is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /api/tags  endpoint of the Ollama server works over the HTTPS connection:

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

4

curl -k https://localhost:11435/api/tags

{
  "models": [
    {
      ...
    }
  ]
}
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WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Excel on the
same machine. You can now set https://localhost:11435  as the endpoint URL in GPT for
Excel, including when the add-in is running on Safari or on Microsoft Excel for Mac.
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Set up Ollama on Windows
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Excel on Windows.

This guide assumes that you use GPT for Excel on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for hardware support information)

Windows 10 22H2 or newer (see the Ollama documentation for detailed system
requirements)

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up an Ollama server on Windows:

Install an Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1

Open PowerShell as an administrator and verify that the server is running:2
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You have installed the Ollama server.

For more information about installing and managing the server on Windows, see the Ollama
documentation.

Install a model on the Ollama server

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Response if the server is running:

NOTE

Make sure you're using curl and not an aliased command, such as Invoke-WebRequest :

If curl  has an alias, the command removes it for the current terminal session, ensuring
that subsequent curl  commands in this guide work as expected.

curl http://localhost:11434

Ollama is running

Remove-Item alias:curl

Install a model from the Ollama library:

For example, to install the Meta Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'
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Enable CORS for the Ollama server
By default, the Ollama server only accepts same-origin requests. Since GPT for Excel always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:

For example:

INFO

By default, the setx  command sets a user variable. If you want to set a system variable,
which applies to all users of the current machine, run the command (as an administrator)
with the /m  parameter. For example:

1

# Set a single origin
setx OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
setx OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

setx OLLAMA_ORIGINS "*"

Allow only GPT for Excel to make requests to the server:

setx OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

setx OLLAMA_ORIGINS "*" /m

Restart the server for the variable to take effect.2

Verify that the /api/tags  endpoint of the server works:

GPT for Excel uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [
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You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Excel on the
same machine. You can now set http://localhost:11434  as the endpoint URL in GPT for
Excel.

    {
      ...
    }
  ]
}
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Remove account access from GPT for
Excel

WARNING

Removing Microsoft account access from GPT for Excel removes access from the GPT for Excel
Word add-in, which also removes access from GPT for Word.

INFO

The following instructions only apply to personal accounts. If you have a school or work
account, contact your organization administrator about add-in access.

In your browser, log in to the Microsoft account you use in GPT for Excel.1

Open the privacy dashboard for your Microsoft account.2
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In the Empower your productivity section, select App access.3
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The GPT for Excel Word add-in no longer has access to your Microsoft account.

INFO

Removing account access does not uninstall the add-in from Microsoft Excel. The next time
you open the add-in, Excel displays a welcome screen in the sidebar, after which you can sign
in with your Microsoft account and grant access again.

In the Manage your app access section, click Don't Allow for GPT for Excel Word.4
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Uninstall GPT for Excel
PREREQUISITES

Remove all GPT formulas from all of your workbooks before uninstalling the add-in. Leaving
any GPT formulas in a workbook causes Excel to reinstall the add-in automatically when you
open the workbook.

WARNING

Uninstalling GPT for Excel removes the GPT for Excel Word add-in from both Microsoft Excel
and Microsoft Word.

Open Excel.1

On the ribbon, select Home > Add-ins > More Add-ins. The Office Add-ins dialog opens.2

Select the My Add-ins tab.3

Hover over GPT for Excel Word and open its Options menu (⋯).4

Select Remove.

A confirmation pop-up opens.

5
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The GPT for Excel Word add-in is removed from your Microsoft account. If you ever need to use
the add-in again, follow the installation process.

INFO

Removing the add-in does not remove its app access permissions from your Microsoft
account. You can remove access manually.

TIP

If the Remove option is not available in the menu, clear the Microsoft Office cache:

i. Close all Office applications.1

ii. Follow Microsoft's instructions for clearing the cache.2

iii. Open Excel and try removing the add-in again.3

Click Remove to confirm.6

GPT for Work Documentation (Microsoft) 2026-05-13

71 / 415

https://gptforwork.com/docs/gpt-for-excel/setup/install
https://gptforwork.com/docs/gpt-for-excel/setup/remove-account-access
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache


Agent in Excel
The Agent is the chat interface for spreadsheet work in GPT for Excel. Describe what you need in
plain language — from everyday spreadsheet tasks to row-by-row bulk processing across large
datasets — and the Agent reads your data, determines the required steps, and executes them
directly in your spreadsheet.

Learn more about what the Agent can and cannot do.

Watch video on YouTube

How to use the Agent
To use the Agent in GPT for Excel:

Next, the Agent:

Open your spreadsheet.1

Open GPT for Excel.2

In the sidebar, in the Agent tab, enter your prompt and click the send button.3

Analyzes your request and drafts a plan.1

Processes the data in the current sheet according to the plan.2
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Examples
Find out what the Agent can do with the examples below. You can try these examples, and many
more, directly from the sidebar.

Translate into multiple languages

Translate spreadsheet content into multiple languages in bulk.

Translate these product titles into each language. Keep brand names intact. 
Capitalize the first letter of the product type.
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Search the web

When necessary, the Agent searches the web to find the information you need. Learn more about
the models used by the Agent.

Fill out this table
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TIP

To scrape specific URLs, use the Fetch content from URL bulk tool.

Generate and autofill formulas

Describe what you need in natural language, and the Agent generates the appropriate Excel
formula, inserts it in the starting cell, and automatically fills the formula across the range.

What the Agent can and cannot do
The Agent excels at both everyday spreadsheet tasks and row-by-row bulk processing across large
datasets.

Calculate employee seniority

GPT for Work Documentation (Microsoft) 2026-05-13

75 / 415

https://gptforwork.com/docs/gpt-for-excel/bulk-tools#fetch-content-from-url


The Agent can:

Add, remove, or reorganize columns and rows.

Create charts, pivot tables, and dashboards from your data.

Create, fix, and explain spreadsheet formulas using natural language.

Generate lists and tables from scratch based on a prompt.

Process data in bulk, including generating or rewriting content, translating text, categorizing or
tagging data, cleaning and preparing data, and searching the web.

Style your spreadsheet, including colors, text formatting, and conditional formatting.

Summarize large cell ranges.

The Agent cannot yet:

Scrape specific URLs. (Use the Fetch content from URL bulk tool instead.)

Take documents as input. (Use the Fetch content from URL bulk tool instead.)

Take images as input. (Use the Prompt images (Vision) bulk tool instead.)

FAQ

What models does the Agent use?

Agent models handle chat messages, create formulas, and execute complex tasks by breaking
them down into smaller tasks and delegating these to bulk models.

For a list of the models available for the Agent, see AI providers & models supported by GPT for
Work.

Can I change the models used by the Agent?

Yes, you can change the models used by the Agent:

Select the Agent model in the GPT for Excel sidebar.

Set the bulk models in the GPT for Work dashboard.

What's next
Select the models used by the Agent.

Try out example Agent use cases.
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Select the models for the Agent in Excel
In GPT for Excel, the Agent uses two types of models:

Agent models handle chat messages, create formulas, and execute complex tasks by breaking
them down into smaller tasks and delegating these to bulk models.

Bulk models handle bulk tasks and web search tasks. The Agent uses bulk models when
needed. The Agent can only use the bulk models you set in the GPT for Work dashboard.

Recommended models
The following tables list our recommended models for the Agent available without an API key.

Agent models

Use case Recommended model

General purpose gpt-5.4

Open-ended or complex tasks claude-4.6-opus

Tasks that require polished formatting claude-4.6-opus

Bulk models

Use case Recommended model

Bulk tasks gpt-5.4-mini

Bulk tasks with web search sonar

Select the Agent model
You can select the Agent model in the GPT for Excel sidebar. The models available depend on the
models enabled for your space in the GPT for Work dashboard.

In the sidebar, select Agent.1

Open the model switcher and select the Agent model.2
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The Agent now uses the selected Agent model.

Set the bulk models

You are the owner or an admin of the space.

You can set two bulk models for the Agent:

The Default model for bulk tasks is used by the Agent for bulk tasks. For new users in your
space, this model is also selected by default in the bulk tools and GPT functions model switcher.

The Default model for web search bulk tasks is used by the Agent for bulk tasks that require
web search. This model is also used by the GPT_WEB function.

The models available depend on the models enabled for your space.

NOTE

You cannot currently select models available through OpenAI-compatible API endpoints.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Bulk models.2
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The Agent now uses the selected default bulk models for bulk tasks and web searches.

What's next
Learn more about models:

AI providers & models supported by GPT for Work

LiveBench (a good model benchmark)

Select the bulk models you want the Agent to use for bulk tasks and web searches.3
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Bulk tools in Excel
Run any type of operation on an entire spreadsheet column at once, or on a specific section of
your data.

Get started

Learn the basics of using bulk tools in GPT for Excel.

Bulk tools reference

Learn how to use all the bulk tools available in GPT for Excel.

Select a model

Select the model used by bulk tools in GPT for Excel.

Select rows to process

Let GPT for Excel process only the relevant rows in your spreadsheet, or target a specific section of your
data.

Search the web

Learn how to use web search models in bulk tools to get up-to-date information from the web.

Use images in prompts

Include images in bulk tool prompts in Microsoft Excel.

Configure behavior

Configure model settings to customize how bulk tools behave in Microsoft Excel.
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Get started with bulk tools in Excel
Bulk tools allow you to run prompts on specific spreadsheet columns at once without writing any
formulas. You configure and run bulk tools from the add-in sidebar. You can also easily reuse past
prompts and configurations with the History feature.

To get started with bulk tools, let's generate some text with the Custom prompt tool:

Download our bulk tools starter template, and open it in Excel as a new workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, select Bulk tools and select Custom prompt.3

Define the following settings:4

Header row: Select 5. The bulk tool will process all rows with content below this row.

Prompt to run for each row: Enter the following prompt for the AI:

Write a short SEO-optimized product description for a bike based on its 
specifications: {{Specifications}}

Put results in column: Select C.

Leave all other settings to their default values.
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The following video shows the entire process.

What's next
Discover all bulk tools available in GPT for Excel.

Try out example use cases for different business applications and product capabilities.

Browse all our bulk tool resources.

Select the model that best fits your needs.

Configure the model settings to customize how the currently selected model behaves.

Run the bulk tool:

The bulk tool executes the prompt for every row with content, starting from row 6, and puts
the responses generated by the AI in column C.

5

i. Select All rows1

ii. Click Run all rows.2
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Bulk tools reference for Excel
Bulk tools allow you to run prompts on specific spreadsheet columns at once without writing any
formulas. You configure and run bulk tools from the add-in sidebar. You can also easily reuse past
prompts and configurations with the History feature.

This guide shows you how to use every bulk tool available in GPT for Excel.

Run a bulk tool
Open a workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, select Bulk tools and select the bulk tool you want to use.3
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Set up the bulk tool run:4

Custom prompt

Translate

Classify / Categorize

Extract

Prompt images (Vision)

Fetch content from URL

Generate

Rewrite

Reformat

Run the bulk tool:

The bulk tool runs, starting from the first empty cell in the results column(s).

INFO

GPT for Excel saves the setup in its bulk tool run history. You can reuse the setup by
selecting it from History.

5

i. Select a specific number of rows to run or select All rows. Learn more.1

ii. Click Run rows.2

Check the results.6

(Optional) If needed, try improving the results.7
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Custom prompt ▼

Use the Custom prompt bulk tool to perform high-volume, free-form prompting directly in Excel.
For example, if you have product specifications in one column, you can generate a unique product
description for each row based on the specification column value for that row.

INFO

Custom prompt and Prompt images (Vision) are the only bulk tools that accept images as
input.

To use Custom prompt with image input, you must select a vision model.

Settings (Custom prompt)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2
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Field Description Example

Prompt to run for
each row

Enter the prompt you want to run
for each row. You can use column,
cell, and range variables to
reference content in other columns
and cells in the spreadsheet. You
must define at least one column
variable for context. Learn more.

Put results in
column

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

B: Description

Improve results (Custom prompt)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

Write an SEO-
optimized 
description for a 
bike based on its 
specifications: 
{{Bike 
specifications}}
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve response quality by providing specific instructions that help the AI more closely
follow your requirements for tone, style, format, rules, target audience, context, consistency, and
other aspects.

Define the instructions as Global instructions in the Model settings. The instructions apply to all
bulk tools and GPT functions in the current workbook.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to add instructions to follow SEO best practices:

You are writing copy for a retail website. Take SEO into account.
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Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. The
higher the value, the greater the creativity.

For example:

If you're generating marketing content, set a high creativity level to generate more engaging
and imaginative text.

If you're generating technical specifications, set a low creativity level to ensure the generated
text is precise and factual.

If you need the AI to follow your instructions to the letter, set the creativity level to 0.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Use multiple variables in a custom prompt

You must define at least one column variable in a custom prompt for context, for example {{A}}
or {{Bike specifications}} . To generate more accurate results, provide more context by using
additional variables in the prompt.
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You can insert variables to reference columns, cells, and ranges in the prompt:

Variable Description Example

Column

Reference a column to include row-
specific information from an
adjacent column.

Column variables work like relative
references and are highlighted in
blue.

To add a column variable, use the
Insert variables menus above the
prompt. You can add a variable
either by column label or column
letter.

Cell or
range from
the
current
sheet

Reference a specific cell or range to
include the same content as context
for each row. Cell and range
variables work like absolute
references and are highlighted in
green. To add a cell or range
variable, type it directly in the
prompt.

Write a product description 
for {{Product name}} that 
costs {{Price}} and is made 
by {{Manufacturer}}.

Create a tagline for 
{{Company name}}.

Follow these rules: {{A1}}

Use 1 term from this list: 
{{A2:A100}}
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Variable Description Example

Cell or
range from
another
sheet

Reference a cell or a range from
another sheet in the same
spreadsheet. The content can be, for
example, reference data or other
shared information.

Use web search capabilities

To generate more up-to-date content, select a model with web search capabilities (indicated by the
🌐 icon in the model switcher). The available web search options vary depending on the model you
select. Learn more about web search options.

TIP

Enable Show sources to write the source references in the column to the right of the results
column. This helps you understand the origin of the content and assess its reliability.

Translate {{Source text}} to 
Japanese.

Use the glossary: 
{{Glossary!A1:B100}}
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Include images in a custom prompt

To include images in a custom prompt, select a vision model in the model switcher. Then, select the
columns that contain image URLs so they can be attached to the prompt for each corresponding
row. Learn more about vision options.

Translate ▼

Use the Translate bulk tool to translate product catalogs, website copy, customer reviews, or any
other content directly in Excel, and optimize your translations by adding specific instructions and a
glossary to guide the AI in the process. For example, you can translate a list of product names for a
shoe store into French.
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Settings (Translate)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Translate each
cell in column

Select the column that contains the
text you want to translate. A: Product Name

From (optional)

Enter the source language, or leave
the field empty if you want the AI to
detect the source language for each
cell.

Empty

To Enter the target language. French

Put results in
column

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

B: Product Name - FR
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Field Description Example

Translation
instructions
(optional)

Enter specific instructions for the
translation.

Translation
glossary (optional)

Enter a list of word pairs where the
first word is the source language
word and the second word is the
target language translation of the
first word.

Use the following syntax for each
pair:

<Source word>: <Target Word>

Enter one pair per line.

If your glossary is in the current
document, you can import it by
clicking Import from sheet.

We are translating 
a shoe store 
catalog.

Sneakers: Sneakers
Running: 
Chaussures de 
course

GPT for Work Documentation (Microsoft) 2026-05-13

93 / 415



Improve results (Translate)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve translation quality by providing specific instructions that help the AI more closely
follow your requirements for tone, style, format, rules, target audience, context, consistency, and
other aspects.

You can define the following types of instructions for the AI:

Translation instructions are defined for the current bulk tool run.

Global instructions are defined in the Model settings and apply to all bulk tools and GPT
functions in the current workbook.

If both bulk tool instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to omit the global instructions and only define translation instructions:

GPT for Work Documentation (Microsoft) 2026-05-13

94 / 415

https://gptforwork.com/docs/gpt-for-excel/bulk-tools/select-model#recommended-models
https://gptforwork.com/docs/gpt-for-excel/bulk-tools/select-model
https://gptforwork.com/docs/gpt-for-excel/bulk-tools/configure-behavior#add-global-instructions


Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. The
higher the value, the greater the creativity.

For example:

If you're generating marketing content, set a high creativity level to generate more engaging
and imaginative text.

If you're generating technical specifications, set a low creativity level to ensure the generated
text is precise and factual.

If you need the AI to follow your instructions to the letter, set the creativity level to 0.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Set the source language for translations

The AI can automatically detect the source language for translations, but manually defining it
helps if the source text contains short, ambiguous phrases, which can confuse the AI. For example,
"Trainers" in British English means "Sports shoes", whereas in American English, it means "People
who train others".
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Create a glossary for translations

Glossaries ensure that translations are consistent, respect corporate terminology, and remain on-
brand. If your glossary is in the current spreadsheet, you can import it by clicking Import from
sheet.

Classify / Categorize ▼

Use the Classify / Categorize bulk tool to classify your catalog items, press articles, customer
reviews, social media comments, or any other text directly in Excel. The tool classifies the content
of each cell into one of the categories you provide if a match is found; if not match is found, the
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tool fills in #N/A . For example, you can improve your lifecycle inventory management by
classifying apparel products according to the activity they are used for.

Settings (Classify / Categorize)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Classify each cell
in column

Select the column that contains the
text you want to classify.

B: Product Name
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Field Description Example

Into one of these
categories

Enter the categories to classify the
text into. If the categories are listed
in the current document, you can
import them by clicking Import
from sheet.

Put results in
column

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

C: Activity

Classify
instructions
(optional)

Enter specific instructions for the
classification. Learn more.

Improve results (Classify / Categorize)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

Running
Workout
Casual
Yoga
Golf
Tennis

Polos fall into 
the Golf category.
Do not classify 
items with 
technical 
properties as 
Casual.
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve classification quality by providing specific instructions that help the AI more
closely follow your requirements for tone, style, format, rules, target audience, context,
consistency, and other aspects.

You can define the following types of instructions for the AI:

Classify instructions are defined for the current bulk tool run.

Global instructions are defined in the Model settings and apply to all bulk tools and GPT
functions in the current workbook.

If both bulk tool instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to omit the global instructions and only define classify instructions:
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Set Creativity to 0

Ensure Creativity is set to 0. This helps the AI follow instructions more closely.

Set creativity

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Use full path for categories

If your categories form a hierarchy, use the full path of each category instead of just its name. This
helps avoid ambiguity and ensures that the classification is as precise as possible.

Using only category names can lead to ambiguity. For example, T-shirts  and Tops  could be
considered as very largely overlapping categories. By specifying Casual/T-shirts  and
Workout/Tops , you provide a clear context, ensuring that the AI classifies the items accurately

according to the intended category.

For example, instruct the AI to classify items according to these category paths:

Casual/T-shirts
Casual/Jeans
Workout/Tops
Workout/Bottoms/Shorts
Workout/Bottoms/Pants
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Extract ▼

Use the Extract bulk tool to extract key information like names, email addresses, and product
attributes from unstructured text directly in Excel. For example, you can extract name, weight, and
price from bike model descriptions to create a catalog.
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Settings (Extract)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Extract
Enter the entities you want to
extract.

From each cell in
column

Select the column that contains the
text from which you want to extract
entities.

A: Description

Name

Weight

Price
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Field Description Example

Put results in
column

Select the column or columns to put
the results in. Cells in these
columns won't be overwritten with
the results if they contain text.

B, C, D

Extraction
instructions
(optional)

Enter specific instructions for the
extraction.

Improve results (Extract)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

Name: Extract only 
the model name, 
without 
manufacturer or 
year
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve extraction quality by providing specific instructions that help the AI more closely
follow your requirements for tone, style, format, rules, target audience, context, consistency, and
other aspects.

You can define the following types of instructions for the AI:

Extraction instructions are defined for the current bulk tool run.

Global instructions are defined in the Model settings and apply to all bulk tools and GPT
functions in the current workbook.

If both bulk tool instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to omit the global instructions and only define extraction instructions:
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The following table provides examples of extraction instructions for different goals:

Goal Description Example

Remove
irrelevant
information

Define what should be
excluded from the extraction
to get cleaner results.

Normalize
entities

Set a consistent output for
variations of the same entity
in your text.

Extract numerical
values and units

Separate numbers from units
to simplify their manipulation.

Add Price value  and Price 
currency  as entities in the Extract
field, then instruct:

Name: Extract only the model 
name, without manufacturer 
or year

Weight: Extract weight in 
kilograms

Price value: Extract only 
the numerical value
Price currency: Extract only 
the currency code (for 
example USD, or EUR)
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Perform open-ended extraction

Open-ended extraction helps you gather a wide range of information without specifying each
entity. This approach works well when entities vary from one cell to another or when you want to
avoid missing any extraction.

For example, enter the following in the Extract field:

Prompt images (Vision) ▼

Use the Prompt images (Vision) bulk tool to generate content based on images directly in Excel.
For example, you can generate descriptions for your product images to improve your listings.

INFO

Custom prompt and Prompt images (Vision) are the only bulk tools that accept images as
input.

To use Prompt images (Vision), you must select a vision model.

All relevant product details as a comma-separated list.
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Settings (Vision)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

4

Prompt

Describe the task you want the AI to
perform based on the target
images. For example, ask a
question about the images or
request content based on the
images.

Write a short 
description of 
this product based 
on how it looks, 
how it's used, and 
its build quality.
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Field Description Example

Columns
containing image
URLs

Select up to five columns that
contain image URLs. For each row,
the tool processes all images
present in the selected columns.
URLs must be publicly accessible.

Supported image formats:

PNG

JPEG

WebP

Non-animated GIF

B: Front image, C: 
In-use image, D: 
Material detail image

Image resolution
(optional)

Choose the level of detail for image
processing:

High: Better image
understanding, higher latency
and cost

Low: Faster processing, lower
cost

Auto: Let the model decide
(default)

Low

Put results in
column (optional)

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

E: Description
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Improve results (Vision)
Use the recommended vision model

In the model switcher, select gpt-5.4 as the vision model. For more information about image-
related tasks, see Use images in prompts.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. The
higher the value, the greater the creativity.

For example:
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If you're generating marketing content, set a high creativity level to generate more engaging
and imaginative text.

If you're generating technical specifications, set a low creativity level to ensure the generated
text is precise and factual.

If you need the AI to follow your instructions to the letter, set the creativity level to 0.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Adjust image resolution

Choose the appropriate image resolution setting based on your needs:

High: Use for detailed analysis where image quality and understanding are critical. This setting
provides better image understanding but increases latency and cost.

Low: Use for faster processing and lower cost when basic image recognition is sufficient.

Auto: Let the model decide the optimal resolution (default).

For product descriptions and detailed analysis, consider using High resolution to ensure the AI
captures all important visual details.

Fetch content from URL ▼

Use the Fetch content from URL bulk tool to fetch and convert web page content from URLs
directly in Excel. This tool converts any publicly accessible URL into markdown, including PDFs. For
example, you can fetch product pages to extract details, or collect company information for
enrichment.

INFO

This bulk tool always uses the speed model from Parallel, regardless of the model selected in
the model switcher. For detailed pricing information, see Model prices.
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Settings (Fetch content from URL)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Column
containing URLs

Select the column that contains the
URLs to fetch content from.

A: URL

Put results in
column

Select the column to put the
fetched content in. Cells in this
column won't be overwritten with
the results if they contain text.

B: Content

INFO

Content exceeding 50,000 characters will be truncated from the end.
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Generate ▼

Use the Generate bulk tool to generate content by combining cells from multiple columns in Excel.
For example, you can generate product descriptions based on specifications from different
columns.

Settings (Generate)
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Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Using cells in
column(s)

Select one or more columns
containing the cells you want to use
as context for the generation.

A: Model name, B: 
Type, C: Price, D: 
Weight, E: Frame

Generate for each
row

Select the type of content you want
to generate, such as a title or
description. You can also enter a
custom content type to generate,
such as Social media ad  or
Email body .

Description

With these
instructions

Customize the output by setting the
language, tone, writing style,
audience, format, length, and
custom instructions specific to this
generation task.

Language: English

Tone: Optimistic

Custom instructions: 
Use a few emojis

Put results in
column

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

F: Description

Get 2 variants per
row (optional)

Enable this option to generate two
variants for each row. The variants
are placed in adjacent columns.

Disabled
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Improve results (Generate)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve generation quality by providing specific instructions that help the AI more closely
follow your requirements for tone, style, format, rules, target audience, context, consistency, and
other aspects.

You can define the following types of instructions for the AI:
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Generation instructions are defined for the current bulk tool run.

Global instructions are defined in the Model settings and apply to all bulk tools and GPT
functions in the current workbook.

If both bulk tool instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to set the current run to use a few emojis and instruct the AI to be concise in all runs:

Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. The
higher the value, the greater the creativity.

For example:

If you're generating marketing content, set a high creativity level to generate more engaging
and imaginative text.

If you're generating technical specifications, set a low creativity level to ensure the generated
text is precise and factual.

If you need the AI to follow your instructions to the letter, set the creativity level to 0.
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INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Use web search capabilities

To generate more up-to-date content, select a model with web search capabilities (indicated by the
🌐 icon in the model switcher). The available web search options vary depending on the model you
select. Learn more about web search options.

TIP

Enable Show sources to write the source references in the column to the right of the results
column. This helps you understand the origin of the content and assess its reliability.
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Rewrite ▼

Use the Rewrite bulk tool to rewrite existing content in Excel to match your desired tone and style.
For example, you can transform casual product descriptions into professional ones.

Settings (Rewrite)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Rewrite each cell
in column

Select the column that contains the
text you want to rewrite.

F: Description

With these
instructions

Customize how the text should be
rewritten by setting the tone,
writing style, audience, format,
length, and custom instructions,
and whether to fix grammar and
spelling errors.

Tone: Professional

Writing style: 
Business

Custom instructions: 
Remove emojis and 
casual language
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Field Description Example

Add context
(optional)

Select additional columns to provide
context for the rewrite.

A: Model name, B: 
Type, C: Price

Put results in
column

Select the column to put the
rewritten text in. Cells in this
column won't be overwritten if they
contain text.

G: Rewrite 
description

Get 2 variants per
row (optional)

Enable this option to generate two
rewrite variants for each row. The
variants are placed in adjacent
columns.

Disabled

Improve results (Rewrite)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve reformatting quality by providing specific instructions that help the AI more
closely follow your requirements for tone, style, format, rules, target audience, context,
consistency, and other aspects.

Define the instructions as Global instructions in the Model settings. The instructions apply to all
bulk tools and GPT functions in the current workbook.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to add instructions to follow SEO best practices:

You are writing copy for a retail website. Take SEO into account.
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Adjust the creativity level

Adjust the level of creativity (accuracy vs. freedom) the AI is allowed in generating results. The
higher the value, the greater the creativity.

For example:

If you're generating marketing content, set a high creativity level to generate more engaging
and imaginative text.

If you're generating technical specifications, set a low creativity level to ensure the generated
text is precise and factual.

If you need the AI to follow your instructions to the letter, set the creativity level to 0.

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

Reformat ▼

Use the Reformat bulk tool to standardize dates, phone numbers, or any other text to a consistent
format directly in Excel. For example, you can reformat product names before you include them in
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your catalog.

Settings (Reformat)

Field Description Example

Header row
(optional)

If your column headers aren't in the
first row, select the number of the
row that contains the headers. The
bulk tool will run on the rows below
this one.

2

Reformat each
cell in column

Select the column that contains the
text to reformat.

A: Name

To
Describe the format to which you
want to convert the text.

Color | Model | 
Size (S, M, or L)

GPT for Work Documentation (Microsoft) 2026-05-13

121 / 415



Field Description Example

Put results in
column

Select the column to put the results
in. Cells in this column won't be
overwritten with the results if they
contain text.

B: Standard format

Reformatting
instructions
(optional)

Enter specific instructions for the
reformatting.

Improve results (Reformat)
Try different models

Find out which model works best for your use case. You can try different models by selecting them
in the model switcher.

Use title case
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INFO

The model selection applies to all bulk tool runs and all GPT function executions in the current
workbook.

Provide additional instructions

You can improve response quality by providing specific instructions that help the AI more closely
follow your requirements for tone, style, format, rules, target audience, context, consistency, and
other aspects.

You can define the following types of instructions for the AI:

Reformatting instructions are defined for the current bulk tool run.

Global instructions are defined in the Model settings and apply to all bulk tools and GPT
functions in the current workbook.

If both bulk tool instructions and global instructions are defined, the AI uses both as a combined
set of instructions. For consistent results, make sure both sets of instructions are aligned and do
not contradict each other.

INFO

Global instructions apply to all bulk tool runs and all GPT function executions in the current
workbook.

For example, to omit the global instructions and only define reformatting instructions:
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Set Creativity to 0

Ensure Creativity is set to 0. This helps the AI follow instructions more closely.

Set creativity

INFO

The creativity level applies to all bulk tool runs and all GPT function executions in the current
workbook.

What's next
Select a model.

Search the web with bulk tools.

Use images with bulk tools.

Configure bulk tool behavior.
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Select a model for bulk tools in Excel
GPT for Excel supports a range of models that you can use with the bulk tools. To help you find the
model that offers the best balance of accuracy, speed, and cost for your use case, see our
recommended models.

The available models depend on:

The API keys set for your current space. GPT for Excel gives you access to a default set of
models available without API keys. To access additional models, set an API key for one or more
AI providers.

The API endpoints set up for your current space. To access even more models, set up a
connection to an Azure OpenAI endpoint or any OpenAI-compatible API endpoint.

The model settings for your current space. Space owners and admins can control which
models are available in GPT for Excel.

Recommended models
As a general rule, OpenAI models are more reliable and less likely to decline prompts than models
from other providers.

The following table lists our recommended models available without an API key.

Use case Recommended model Alternative model

General purpose gpt-5.4-mini gpt-5.4-nano

Translation claude-4.6-sonnet gpt-5.4-mini

Content creation claude-4.6-sonnet

TIP

For information about recommended models when working with web search and images, see:

Search the web

Use images in prompts

To learn more about a model, hover over the model info icon in the model switcher. A tooltip opens
with detailed information about the model.
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Select a model without an API key
Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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GPT for Excel now uses the selected model to generate responses for bulk tools.

In the sidebar, select Bulk tools and select any bulk tool.3

Open the model switcher.4

Under No API key needed, select a model.5
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Select a model with an API key

You have set an API key for the AI provider whose model you want to use.

If you want to use an Azure model or an OpenAI-compatible model from an API endpoint,
you have set up the correct endpoint.

Prerequisites

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, select Bulk tools and select any bulk tool.3
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GPT for Excel now uses the selected model to generate responses for bulk tools.

What's next
Learn more about models:

AI providers & models supported by GPT for Work

LiveBench (a good model benchmark)

Open the model switcher.4

Under Use your API key or endpoint, select a model with a key icon.5
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Select which rows to process with bulk
tools in Excel
Bulk tools in GPT for Excel are designed to process only the relevant rows in your spreadsheet. You
can additionally control where to start and how many rows to process, making it easy to test on a
small sample before processing your entire dataset.

Bulk tools automatically skip:

In the figure below, all rows with a green background will be processed by the Translate bulk tool.

Try a bulk tool on a few rows, then run all rows
The default settings for bulk tool runs is ideal for starting with a quick test:

Setting Value Description

Header
row

1 Row 1 contains the column headers.

The header row1

Rows with content in the result column2

Rows where all input columns are empty3

Hidden or filtered rows4
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Setting Value Description

Start from
row

Auto
The tool processes the first 3 rows after the header row. If a row has a
non-empty cell in the result column, the tool skips to the next row.

X rows 3 The tool processes 3 rows after the header row.

To run a bulk tool with the default settings, simply click Run 3 rows.

The following video shows you how to run the Extract tool on 3 rows to check that the
specifications for your product descriptions are extracted correctly.

When you're ready to run the tool on the whole spreadsheet, change the row setting to All rows
and click Run all rows. The tool skips the first 3 rows as they have already been processed.

Run a bulk tool on new content only
If you've already run a bulk tool on a spreadsheet and then add new data, you don't need to filter
the new rows to process them. Just run the tool again on all rows. It skips the rows that have
already been processed.

Setting Value Description

Start from
row

Auto The tool starts on the first empty cell in the result column.

X rows
All
rows

The tool processes all remaining rows, skipping the rows that have
already been processed.

The following video shows how to run the Classify / Categorize tool to process only new rows in a
product list. Even if the list is already sorted so that the new rows are not all at the end, the tool
only processes the new rows.

Run a targeted test
You can target a specific section of rows in a spreadsheet by explicitly defining the start row and
the number of rows to process:
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Setting Value Description

Start from
row

Fixed:
5

The tool starts on the first empty cell in the result column on or after
row 5.

X rows 2
The tool processes 2 rows, starting from the first empty cell in the
result column on or after row 5.

The following video shows you how to run the Translate tool on 2 rows to check that your glossary
is taken into account when translating your product names from English to French.

Rerun a bulk tool on a few cells
To rerun a bulk tool on a few cells, simply delete the cell content and rerun the tool. This allows you
to easily update a few selected rows without affecting the rest of the results:

Setting Value Description

Start from row Auto The tool starts at the first empty cell in the result column.

X rows All rows The tool processes all rows with empty cells in the result column.

The following video shows how to rerun the Custom tool on a few cells to update the results after
tweaking your prompt.

TIP

To rerun a bulk tool on the same rows, you can select a new column to write the results to.
This way, you can keep the original results and compare them with the new ones.

What's next
Discover all bulk tools available in GPT for Excel.

If you encounter issues with bulk tools, see the troubleshooting guide.
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Search the web with bulk tools in Excel
Search the web directly in GPT for Excel using bulk tools with web search models. These models
use fresh web search data, which allows you to generate up-to-date responses about companies,
current events, facts, and more, directly in your workbook. You can also fetch content from specific
URLs to extract information from web pages.

Choose the right web search model
Choose a web search model that best fits your use case.

Web search

Get information that is not in the model's built-in knowledge:

Example: Finding the current CEO of a company.

How it works:

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific focus.

Recommended models:

Sonar for quick results (cheapest).

Sonar Pro or OpenAI Search models for high quality results.

Gemini models with Web search for Google search quality (most expensive).

Content fetching

Focus on specific URLs and extract content from them:

Example: Extracting the product name and price from the URL of a product page.

How it works: Some web search models can access the full content from specific URLs. The full
content is added to the context of the models, so they can use it to answer questions about the
content or extract information from it.

Recommended models:

Gemini 2.5 models with URL context

Supported web search models

Click here for a list of all web search models supported by GPT for Excel ▼
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Provider Model Without API
key

With API key
🔑

URL fetch

Search... Search... All All All

Perplexity sonar Yes Yes No

Perplexity sonar-pro Yes Yes No

Perplexity sonar-reasoning-pro No Yes No

Google gemini-2.5-flash Yes Yes Yes

Google gemini-2.5-flash-lite No Yes Yes

Google gemini-2.5-pro No Yes Yes

Google gemini-3-flash-
preview

No Yes Yes

Google gemini-3.1-flash-lite-
preview

No Yes Yes

Google gemini-3.1-pro-
preview

No Yes Yes

OpenAI gpt-4o-mini-search-
preview

Yes Yes No

OpenAI gpt-4o-search-
preview

Yes Yes No

OpenAI gpt-5-search-api Yes Yes No

Parallel speed Yes No No

For detailed pricing information, see Model prices.

Use web search models
Use bulk tools to perform web searches with any model that has web search capabilities (🌐).

Open GPT for Excel.1
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In the sidebar, select Bulk tools and select the bulk tool you want to use.2

Open the model switcher.3
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Enable the web search filter and select a web search model (🌐).4

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

5

Set up your bulk tool run. For example, to set up a Custom prompt run:6
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Your search results appear in the output column. If you enabled source references, they appear in
the adjacent column.

For instructions on how to use the tools, see Bulk tools.

Model-specific settings
Use the model-specific settings to configure the web search model for your use case.

Field Description Example

Prompt to run
for each row

Enter the prompt you want to run
for each row.

Find and summarize 
reviews for: 
{'{{Event}}'}.

Put results in
column

Select the column to put the
results in. Cells in these columns
won't be overwritten with the
results if they contain text.

B: Information

Show sources
Enable this option to write source
references in the column to the
right of the results column.

Enabled

Click Run rows.7
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Google Gemini

Setting Description Example

Web search

Let Gemini decide when a Google search can
improve the answer. This allows Gemini to provide
more accurate answers and cite verifiable sources
beyond its built-in knowledge. Enabling Web
search incurs an additional search cost.

URL context

Provide up to 20 URLs (pages, images, PDFs) in
your prompt to focus your search. No search cost
is incurred, but the content retrieved from URLs
counts as input tokens.

Perplexity Sonar

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

Domains

Bulk tools only

Specify up to 20 domains to generate responses
based only on search results from these domains.
Use simple domain names (e.g., wikipedia.org )
without additional elements like the prefixes
https://  or www. .
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OpenAI Search

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

Location
To refine search results based on geography,
specify an approximate user location using
country, city, and/or region.
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Use images in bulk tool prompts in Excel
Use images in your prompts with GPT for Excel and vision models. These models are multimodal
and can process both text and images as input.

TIP

Don't have image URLs yet? Learn how to host images on Google Drive for AI processing.

INFO

Supported image formats: PNG, JPEG, WebP, non-animated GIF

Supported vision models
We recommend using gpt-5.4 to analyze images, but you can use any vision model supported by
GPT for Excel.

Click here for a list of all vision models supported by GPT for Excel ▼

Provider Model Without API
key

With API key
🔑

Search... Search... All All

OpenAI gpt-4.1 Yes Yes

OpenAI gpt-4.1-mini Yes Yes

OpenAI gpt-4.1-nano Yes Yes

OpenAI gpt-4o Yes Yes

OpenAI gpt-5 Yes Yes

OpenAI gpt-5-chat Yes Yes

OpenAI gpt-5-mini Yes Yes

OpenAI gpt-5-nano Yes Yes

OpenAI gpt-5.1 Yes Yes

OpenAI gpt-5.2 Yes Yes

OpenAI gpt-5.4 Yes Yes
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Provider Model Without API
key

With API key
🔑

OpenAI gpt-5.4-mini Yes Yes

OpenAI gpt-5.4-nano Yes Yes

OpenAI gpt-5.5 Yes Yes

OpenAI o1 Yes Yes

OpenAI o3 Yes Yes

OpenAI o4-mini Yes Yes

Anthropic claude-4-6-sonnet Yes Yes

Anthropic claude-4-sonnet Yes Yes

Anthropic claude-4.1-opus No Yes

Anthropic claude-4.5-haiku Yes Yes

Anthropic claude-4.5-opus Yes Yes

Anthropic claude-4.5-sonnet Yes Yes

Anthropic claude-4.6-opus Yes Yes

Anthropic claude-4.7-opus Yes Yes

Mistral mistral-medium No Yes

xAI grok-4-1-fast No Yes

xAI grok-4-1-fast-non-
reasoning

No Yes

Prompt images

TIP

Want to use both text and images in your prompt? Skip to Prompt images with additional text
input.
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Use the Prompt images (Vision) bulk tool to apply a prompt to images in your spreadsheet.

Open GPT for Excel.1

In the sidebar, select Bulk tools and select Prompt images (Vision).2

Open the model switcher.3

Select a vision model.4
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Set up your bulk tool run.

Field Description Example

Prompt
Enter the prompt you want to
apply to each image.

Write a short 
description of this 
product based on how 
it looks, how it's 
used, and its build 
quality.

Columns
containing
image URLs

Select up to five columns that
contain image URLs. For each row,
the tool processes all images
present in the selected columns.
URLs must be publicly accessible.

C: Front image, D: 
In-use image, E: 
Material detail 
image

5

GPT for Work Documentation (Microsoft) 2026-05-13

143 / 415



You have set up and run the Prompt images (Vision) bulk tool to apply a prompt to images in
your spreadsheet.

Field Description Example

Image resolution

Choose the level of detail for
image processing:

Low

Put results in
column

Select the column to put the
results in. Cells in this column
won't be overwritten with the
results if they contain text.

F: Description

High: Better image
understanding, higher latency
and cost

Low: Faster processing, lower
cost

Auto: Let the model decide
(default)

Click Run rows.6
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For instructions on how to improve the results, see the tool guide.

Prompt images with additional text input
Use the Custom prompt bulk tool to combine a prompt with text and images from your
spreadsheet.

INFO

In the Custom prompt bulk tool, the image resolution is fixed to Low and cannot be changed.

Open GPT for Excel.1

In the sidebar, select Bulk tools and select Custom prompt.2

Open the model switcher.3
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Select a vision model.4

Write your prompt and include any variables to be replaced with values from your
spreadsheet.

5

Write a short description of {{Product name}} based on how it looks, how 
it's used, and its build quality.

Click Configure image columns to show the Columns containing image URLs dropdown,6
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You have set up and run the Custom prompt bulk tool to include images and text from your
spreadsheet.

and select the columns that contain image URLs.

Click Run rows.7
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For instructions on how to improve the results, see the tool guide.

Host images on Google Drive for AI processing
To process an image in GPT for Excel, you need the direct URL of the image and the URL must be
publicly accessible.

To host an image on Google Drive so that GPT for Excel can access and process it:

You now have a direct image URL that you can access and process in GPT for Excel.

Upload the image to Google Drive.1

Share the image publicly using the Anyone with the link option. For more information, see
Google Drive Help.

TIP

To prevent other users from commenting or editing the image, set the access role to
Viewer.

2

Copy the link.3

Get the image file ID from the link URL, and build the following new URL with the ID:

For example:

4

https://drive.google.com/uc?id=<image-file-id>

# Original share URL from "Copy link"
https://drive.google.com/file/d/1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux/view

# Direct image URL
https://drive.google.com/uc?id=1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux
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Configure bulk tool behavior in Excel
Configure model settings to customize how bulk tools behave in your workbook.

Add global instructions
Provide global instructions to specify preferences or requirements that you'd like the AI to consider
when generating responses. The instructions apply to all bulk tools in the current workbook.

In the sidebar, select Bulk tools and select one of the tools.1

Expand Model settings.2

In the Global instructions section, select the type of instructions you'd like to add and edit3
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The AI takes the global instructions into account when generating responses for bulk tools in the
current workbook.

Set the creativity level
Control how creative the AI is by setting the creativity level (also called temperature). Lower
creativity generates responses that are straightforward and predictable, while higher creativity
generates responses that are more random and varied.

TIP

For more information about temperature as used by OpenAI to set the creativity level, see our
temperature guide.

them if needed.
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In the sidebar, select Bulk tools and select one of the tools.1

Expand Model settings.2
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The AI uses the creativity level when generating responses for bulk tools in the current workbook.

Adjust advanced settings
Adjust the advanced settings to have greater control over generated output for bulk tools in the
current workbook. For more information about the settings, see the OpenAI API documentation.

Term Definition

Token

A token is a unit of text, such as a word, subword, punctuation mark, or
symbol. Models split all input and output text into tokens for processing.
Model providers use tokens as the basic unit for measuring model usage.
The total number of tokens in a prompt (input) and the model's response
(output) determines your credit consumption. For more information, see
Tokens and How credits are consumed.

Top P
Helps adjust creativity level – Lower values result in more focused output,
while higher values allow for more creative responses.

Use the slider to set Creativity between 0 and 1.3
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Term Definition

Frequency
penalty (not
available for all
models)

Penalizes tokens based on their frequency in the text so far – Higher values
discourage the model from repeating the same tokens too frequently, as
the more they appear in the text, the more penalized they get.

Presence
penalty (not
available for all
models)

Penalizes new tokens based on whether they appear in the text so far –
Higher values encourage the model to use new tokens that are not
penalized.

In the sidebar, select Bulk tools and select one of the tools.1

Expand Model settings.2
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Expand View advanced settings.3

Use the corresponding sliders to set the values for:4

Top P: Adjust creativity by setting the value between 0 and 1.

Set the creativity level to 1 when the value for Top P is lower than 1.

Frequency penalty: Set a penalty between 0 and 2 to apply to tokens each time they are
repeated in the result.

Presence penalty: Set a one-time penalty between 0 and 2 for tokens that appear more
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GPT for Excel uses the advanced settings to generate responses for bulk tools in the current
workbook (when a model supporting the settings is selected).

What's next
Select the model that best fits your needs.

Run bulk tools.

than once in the result.
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GPT functions in Excel
Build formulas with GPT functions to prompt AI from inside spreadsheet cells. Use the GPT for
Excel sidebar to manage your GPT formulas.

Get started

Learn the basics of using GPT functions — from enabling GPT functions for a workbook to building
formulas that combine GPT functions with native functions.

GPT functions reference

All the GPT functions, with simple examples and an extensive list of parameters.

Select a model

Select the model used by GPT functions in GPT for Excel.

Create GPT formulas

Create GPT formulas in Microsoft Excel and control the execution of GPT formulas.

Manage GPT formulas

Manage your GPT formulas and avoid unexpected changes and costs.

Search the web

Learn how to use web search models in GPT functions to get up-to-date information from the web.

Use images in prompts

Include images in GPT function prompts in Microsoft Excel.
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Configure behavior

Configure model settings to customize how GPT functions behave in Microsoft Excel.
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Get started with GPT functions in Excel
GPT functions are custom spreadsheet functions in GPT for Excel that allow you to prompt AI from
inside spreadsheet cells. GPT functions work exactly like native functions in that you can use them
on their own or combine them with other functions when creating formulas.

GPT for Excel provides dedicated GPT functions for selected use cases, such as translation,
classification, and web search, as well as a generic GPT function for all other use cases. You can
define function-specific parameters to further refine how the AI generates responses. You can find
a list of all available functions with usage examples in the add-in sidebar.

This guide walks you through the basics of using GPT functions — from enabling GPT functions for
a workbook through building formulas with GPT functions to using functions for web search and
image processing. The focus is on the GPT  function, the simplest function included in GPT for
Excel, but the same rules apply to all GPT functions.

TIP

To try out the examples in this guide, download our GPT function starter examples template,
and open it in Excel as a new workbook.

Enable GPT functions
GPT for Excel must be running before you can use GPT functions for the first time in a workbook.

To start GPT for Excel:

GPT for Work Documentation (Microsoft) 2026-05-13

158 / 415

https://gptforwork.com/docs/resources/guides/concepts#function-spreadsheet
https://gptforwork.com/docs/gpt-for-excel
https://gptforwork.com/docs/resources/guides/concepts#formula-spreadsheet
https://gptforwork.com/docs/gpt-for-excel/gpt-functions/reference
https://drive.google.com/file/d/11tBtv4PMzaXKqim240uVwwuZOqfOtGrU/view


Use GPT functions
Learn the basics of using GPT functions, from how you type a function through how you use
functions in formulas to how you search the web and process images with functions.

GPT function syntax

Each GPT function follows a specific syntax that consists of a function name and one or more
parameters (also called "arguments") enclosed in parentheses. The parameters together tell the
function what to do. Some parameters are required, while others are optional. The syntax of a
function is presented as follows:

The order of the parameters matters, so always write them in the order required by the function
syntax. Optional parameters are in square brackets.

For example, the GPT  function has the following syntax:

The GPT  function takes the following four parameters:

Open the workbook where you want to use GPT functions.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

FUNCTION_NAME(parameter_1, parameter_2, [parameter_3])

GPT(prompt, [value], [temperature], [model])
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Parameter Required Description

prompt Yes

The prompt for the AI. The prompt can be:

Text: "Write a tagline for a tea house"

Cell reference: A1

Range reference: A1:A3

value No

Input that you want to combine with the prompt. The input can
be:

Text: "Tone: Calm and serene"

Cell reference: B1

Range reference: B1:B3

If you provide value , GPT for Excel uses the following template
to build the final prompt sent to the AI:

For example, if prompt  is Write a tagline for a tea 
house  and value  is Tone: Calm and serene , the final
prompt is:

INFO

The Output  line serves as a structural anchor that helps
constrain the model into returning a clean, direct, and well-
formatted response.

If you do not provide value , GPT for Excel sends prompt  as is.

<prompt>
Input: <value>
Output:

Write a tagline for a tea house
Input: Tone: Calm and serene
Output:
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Parameter Required Description

temperature No

Number between 0  and 1  that specifies how creative the AI
should be in generating the response:

0  sets minimum creativity. Responses to the same prompt
are predictable and very similar.

1  sets maximum creativity. Responses to the same prompt
can vary wildly. Highest risk of hallucination.

model No
Name of the AI model that you want to use. You can find the
model names in the model switcher in the add-in sidebar. Learn
more.

The first parameter of the GPT  function is required, so you always have to provide it. The
remaining three parameters are optional, so you only need to provide them when you want
additional control over how the function operates. You can provide one, two, or all three optional
parameters, depending on your needs.

DOUBLE QUOTES

If a parameter takes a text value, always enclose the text in double quotation marks. For
example:

✅ GPT("Write a tagline for a tea house")

❌ GPT(Write a tagline for a tea house)

The latter fails with an error because the function cannot interpret the words as valid
parameters.

EMPTY PARAMETERS

If you skip an optional parameter other than the last one, always provide a lone comma
("empty parameter") as a placeholder to maintain the correct syntax. For example:

✅ GPT("Write a tagline for a tea house", , 0.5, "claude-4-sonnet")

❌ GPT("Write a tagline for a tea house", 0.5, "claude-4-sonnet")

The latter fails with an error because the function treats 0.5  as the second parameter
( value , which expects text or a reference) and "claude-4-sonnet"  as the third parameter
( temperature , which expects a number).
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Run a GPT function

To use the GPT  function:

The function runs: It sends the prompt to the AI, receives a response, and displays the response in
the selected cell.

CALCULATED VALUES AND CONSTANTS

The text you see in the cell is the result of the formula — a dynamically calculated value. The
actual value of the cell is the formula expression: =GPT("Write a tagline for a tea 
house") . You cannot edit the result; you can only edit the formula. If you want to set the
result as the actual value of the cell, that is, if you want to turn the calculated value into a
constant that you can edit, replace the formula with its result.

Reference other cells from a GPT function

You can reference other cells and ranges from a GPT function. You can use relative, absolute, and
mixed references as you would with any function.

For example, to retrieve the prompt for the GPT  function from another cell:

Select a cell where you want the response to appear.1

Type the equal sign =  followed by the function. For example, to use the GPT  function with
just the prompt  parameter, type:

2

=GPT("Write a tagline for a tea house")

Press ENTER.3

Select a cell and enter the prompt:1

Write a tagline for a tea house
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Both GPT(B12)  and GPT("Write a tagline for a tea house")  work the same way — they
send the exact same prompt to the AI. The only difference is that the former retrieves the prompt
from a cell, while the latter provides it directly as a text constant in the function.

Apply the same prompt to multiple cells

You can apply the same GPT function and prompt to adjacent cells by filling the formula across a
range.

For example, suppose you want to generate unique taglines for multiple businesses. The
businesses are listed in one column of your sheet, and you want to fill another column with the
corresponding taglines. You can generate the taglines by using the GPT  function with the prompt
and value  parameters, where prompt  specifies the basic instructions and value  specifies a
specific business as a cell reference:

TIP

You do not need double quotation marks around the prompt here because Excel
automatically returns the value as text.

Select another cell and enter the GPT  function with the prompt cell as the only parameter. For
example, if the prompt is in cell B12 , enter:

The function runs and returns the AI's response in the selected cell.

2

=GPT(B12)

Select the first tagline cell and enter the GPT  function. For example, if the business whose
tagline you're generating is specified in cell B7 , enter:

The function combines the two parameters into a single prompt, based on the underlying
prompt template, which is then sent to the AI. For example, if B7  contains the text antique 
store , the final prompt sent to the AI is:

The function runs and returns the AI's response in the selected cell.

1

=GPT("Write a tagline", B7)

Write a tagline
Input: antique store
Output:

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the cell reference in the
function so that each row receives a tailored response based on its business. The formula in
row 8 will reference B8 , the formula in row 9 will reference B9 , and so on.

2
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To see how absolute references work, let's move the prompt to its own cell:

Create a prompt by combining text from multiple cells

You can use concatenation to combine text from two or more cells into a single text string. This
allows you to create advanced prompts, where different parts of the prompt come from different
cells in the sheet.

For example, suppose you want to further customize the taglines of the previous example, so that
they follow a specific tone and target a specific customer age range. The businesses are listed in
the first column, the tone in the second, and the age range in the third, with the fourth column
now reserved for the taglines.

To build the prompt by combining the information from the different columns:

Select an empty cell and enter the prompt:1

Write a tagline

Select the first tagline cell and update the GPT  function to reference the prompt cell. For
example, if the prompt is in cell C8  and the business whose tagline you're generating is now
specified in cell B11 , enter:

$C$8  is an absolute reference to C8 , which you need here since you do not want Excel to
automatically adjust the reference when you fill the formula to adjacent cells.

TIP

Since you're only filling vertically across a single column, it would be enough to fix the
prompt cell row using a mixed reference:

2

=GPT($C$8, B11)

=GPT(C$8, B11)

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill, overwriting the existing formulas. Excel automatically
updates the value cell reference for each row, while keeping the prompt cell reference fixed.

3

Select the first tagline cell and enter the GPT  function. For example, if the business whose
tagline you're generating is specified in cell B11 , with the tone in cell C11  and age range in
cell D11 , enter the following in cell E11 :

1

=GPT("Write a tagline for " & B11 & ", the tone is " & C11 & ", the 
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Combine a GPT function with a native function

You can combine GPT functions with native functions like you would any other function.

For example, suppose you want to run the GPT  function from above only when the current row
has a business specified. If the business cell is empty, you want to skip the row. You can do this by
combining the GPT  function with the native IF  function:

The function uses the &  operator to concatenate the different parts, which include literal text
values and cell references, into a single text string. For example, if B11  contains the text
antique store , C11  contains nostalgic and refined , and D11  contains 35-65 , the

final prompt sent to the AI is:

TIP

Instead of the &  operator, you can also use the native CONCAT  function:

The GPT  function uses the CONCAT  function as a nested function. Learn more.

If you want to concatenate without having to worry about white spaces and newlines, use
the GPT_CREATE_PROMPT  function:

audience is aged " & D11)

Write a tagline for antique store, the tone is nostalgic and refined, the 
audience is aged 35-65

=GPT(CONCAT("Write a tagline for ", B11, ", the tone is ", C11, ", the 
audience is aged ", D11))

=GPT(GPT_CREATE_PROMPT("Write a tagline for", B11, ", the tone is", 
C11, ", the audience is aged", D11))

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the cell references in the
function so that each row receives a tailored response based on its business. The formula in
row 12 will reference B12 , C12 , and D12 ; the formula in row 13 will reference B13 , C13 ,
and D13 ; and so on.

2

Select the first tagline cell and enter a formula that wraps GPT  inside an IF  function. For
example, if the business whose tagline you're generating is specified in cell B11  and the GPT
function for that is GPT($C$8, B11) , enter:

1
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Search the web with a GPT function

You can search the web with a GPT function simply by using a web search model. You can either
select the model in the model switcher or specify the model with the model  parameter.

For example, suppose you want to do a search for company CEOs. The companies are listed in one
column of your sheet, and you want to fill the next column with the CEO names.

The GPT  function runs only if cell B11  is not empty. If B11  is empty, the formula leaves the
current cell empty, too.

=IF(B11="", "", GPT($C$8, B11))

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill, overwriting the existing formulas. Excel automatically
updates the value cell reference for each row, while keeping the prompt cell reference fixed.

2

To see the conditional logic in action, empty one of the business cells. The formula for that row
reruns and removes the tagline.

3

In the sidebar, select GPT functions.1

Expand Model settings and open the model switcher.2
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Enable the web search filter and select a web search model (🌐).

INFO

If you select a Gemini model, make sure web search is enabled for Gemini models.

3

Select the first CEO cell and enter the GPT function. For example, if the company whose CEO
you're fetching is specified in cell B13 , enter:

TIP

If you want to override the model switcher selection, specify the model in the GPT
function with the model  parameter. For example, if you want to use the Sonar model,
enter:

4

=GPT("Give me this company's current CEO. I only want the name of the CEO, 
no citations.", B13)

=GPT("Give me this company's current CEO. I only want the name of the 
CEO, no citations.", B13, , "sonar")

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the company cell reference
for each row.

5
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For more information about web search, see Search the web with GPT for Excel.

Process images with GPT_VISION

You can apply a text prompt to an image using the GPT_VISION  function with a vision model. You
can either select the model in the model switcher or specify the model with the model  parameter.

For example, suppose you want to extract the brand name from product images featuring coffee
bean packs. The image URLs are listed in one column of your sheet, and you want to fill the next
column with the brand names.

In the sidebar, select GPT functions.1

Expand Model settings and open the model switcher.2

Select a vision model.

To determine whether a model supports vision, check its info popup. For a list of available
vision models, see Use images in prompts.

3
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For more information about AI vision, see Use images in prompts in Excel.

Set the model for a GPT function

You can run a GPT function with a specific model by providing the model  parameter. The function
will ignore what's currently selected in the model switcher and use the provided model instead.

For example, if you want the Perplexity Sonar model to answer a query about current events,
provide sonar  as the model:

INFO

If the model is available both with and without an API key in GPT for Excel, the function uses
the model with the API key.

Use the model  parameter when:

You want to lock a formula to a specific model. For example, if you have a web search
formula, you want it to consistently use the same web search model.

You want to compare how a specific model compares with other models. For example, use
the same GPT function and prompt in two formulas — the first with the model  parameter, the

Select the first image URL cell and enter the GPT function. For example, if the image URL that
you want to process is in cell C13 , enter:

TIP

If you want to override the model switcher selection, specify the model in the GPT
function with the model  parameter. For example, if you want to use the Claude Sonnet 4
model, enter:

4

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.", C13)

=GPT_VISION("Extract the coffee brand from this image. Normalize the 
brand name to title case.", C13, , , "claude-4-sonnet")

Fill the formula down to apply it to the rest of the column: Select the fill handle and drag it
down across the cells you want to fill. Excel automatically updates the image URL cell reference
for each row.

5

=GPT("What was the previous month's inflation rate in the US?", , , "sonar")
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second without — and then use the model switcher to change the model used by the second
formula, regenerating its response after each change.

Set the creativity level for a GPT function

You can run a GPT function with a specific creativity level by providing the temperature
parameter. The function will ignore the creativity level defined in the model settings and use the
provided level instead.

For example, if you're working on a creative task and want to experiment with highly creative
responses, set the temperature close to 1 :

For more information about temperature, see our temperature guide for OpenAI models.

GPT functions: Defaults, settings, behavior

Default model

By default, GPT functions use the currently selected model. If you want a GPT function to use a
specific model regardless of what's currently selected in the model switcher, use the model
parameter to explicitly set the model.

INFO

If you provide the model  parameter, and if the model is available both with and without an
API key in GPT for Excel, the function uses the model with the API key.

Default creativity level

By default, GPT functions use the creativity level defined in the model settings. If you want a GPT
function to use a specific creativity level regardless of what's defined the model settings, use the
temperature  parameter to explicitly set the creativity level.

=GPT("Write a tagline for a tea house", , , "claude-4-sonnet")

=GPT("Write a tagline for a tea house")

=GPT("Write a three-sentence horror story about a teahouse.", , 0.9);
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Global instructions and advanced settings

The global instructions and advanced settings defined in the GPT for Excel sidebar apply to GPT
functions. If you find that a function is not working as expected, check the model settings for a
possible cause.

Regional settings

The default characters used by Excel for parameter and decimal separators depend on your
currently selected region:

Parameters: Some regions use the comma ( , ) as the default parameter separator, while others
use the semicolon ( ; ).

Decimals: Some regions use the period ( . ) as the default decimal separator, while others use
the comma ( , ). As a rule, regions that use the period for decimals use the comma for
parameters, whereas regions that use the comma for decimals use the semicolon for
parameters.

The examples in the current documentation use the comma as the parameter separator and the
period as the decimal separator. If the examples fail with syntax errors in your workbook, check
your regional settings to verify which punctuation to use.

Formula auto-refresh

When your sheet auto-refreshes, Excel automatically recalculates some or all formulas on the
sheet, including GPT formulas. For each GPT formula:

If the GPT formula cache is enabled for the workbook, Excel reuses the formula's previously
generated result from the cache.

If the cached result has expired, or if you have the cache disabled, Excel runs the formula
normally.

In Excel, the following triggers cause a sheet to auto-refresh:

=GPT("Write a tagline", B7)

=GPT("Write a tagline"; B7)

=GPT("Write a tagline for a tea house", , 0.5)

=GPT("Write a tagline for a tea house"; ; 0,5)
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Recalculation trigger What gets recalculated

Insert, move, or delete a column All formulas on the sheet

Insert, move, or delete a row All formulas on the sheet

Filter rows by column All formulas on the sheet

Hide and unhide rows Formulas in the selected rows

Sort rows Formulas in the selected rows

Move a formula to a different cell All formulas on the sheet

Undo the deletion of a formula from a cell Restored formula

To prevent GPT formulas from being recalculated, replace the formulas with their results.

When to use bulk tools
Consider using bulk tools instead of GPT functions if:

You want AI responses saved as plain text in cells. Bulk tools fill cells with static text values,
or constants, so you don't need to replace any formulas. You also avoid formula auto-refresh,
reducing the risk of unintended data changes.

You want better tracking information about the progress of AI requests. Bulk tools provide
a live progress tracker that shows you how many rows have been successfully processed, how
many have resulted in an error, and how much time has elapsed.

Your formulas regularly become stuck in the #BUSY! state.

What's next
Discover all GPT functions available in GPT for Excel.

Learn how to use each GPT function with a real-world example.

Browse all our GPT function resources.

Select the model that best fits your needs.

Configure the model settings to customize how the currently selected model behaves.
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GPT functions reference for Excel
Discover all custom functions in GPT for Excel, along with simple examples and an extensive list of
parameters. If you're looking for more examples, download our GPT for Excel examples template,
and open it in Excel as a new workbook.

Watch video on YouTube

TIP

To generate responses based on fresh web search data, use a model with web search
capabilities (indicated by the 🌐 icon in the model switcher).

GPT function
The simplest function included in GPT for Microsoft Excel. Outputs the result in a single cell.

INFO

To process images, use GPT_VISION.

How to use

Syntax =GPT(prompt, [value], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A response to your prompt in a single cell

=GPT("Write a tagline for an ice cream shop.")
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Parameters

Parameter Definition

prompt (cannot be empty)

Instruction provided to the AI to generate a result in a single
cell.

The prompt parameter can be:

A string: "Write a tagline for an ice cream shop."
A cell: A1
A range of cells: A1:C3

(optional) value Text, cell or range you want your prompt to apply to

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_CLASSIFY function
Classifies a piece of text into a single category selected from a predefined list of categories.

How to use

Syntax
=GPT_CLASSIFY(value, categories, [instructions], [temperature],
[model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The best applicable category

=GPT_CLASSIFY("banana", "fruit, vegetable")
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Parameters

Parameter Definition

value (cannot be
empty)

Input text to classify.

The value parameter can be:

A string: "banana"
A cell: A1
A range of cells: A1:C3

categories (cannot be
empty)

Comma-separated categories or range of categories to choose from.
Only the most relevant category will be returned.

(optional) instructions Additional instructions for the classification. Can include examples.

(optional)
temperature, model See temperature and model.

See more usage examples.

GPT_EDIT function
Applies the given task to the given text. The default task is to fix grammar and spelling.

How to use

Syntax =GPT_EDIT(text, [task], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The edited text in a single cell

=GPT_EDIT("For sum reezon thoose nunsberz arnt addin 
up")
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Parameters

Parameter Definition

text (cannot be
empty)

Input text to edit.

The text parameter can be:

A string: "For sum reezon thoose nunsberz arnt addin up"
A cell: A1
A range of cells: A1:C3

(optional) task

Text, cell or range specifying how the text should be edited. Defaults
to fixing grammar and spelling. Other examples:

"Make it funnier"
"Make it shorter"
"Make it sound formal"

"Add an ending"

(optional)
temperature, model See temperature and model.

See more usage examples.

GPT_EXTRACT function
Extracts specific elements from text, such as names, dates, email addresses, URLs, or product
attributes. Outputs as comma-separated values.

How to use

Syntax GPT_EXTRACT(text, to_extract, [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters instead
of ","

=GPT_EXTRACT("I worked 5 years at Amazon.com and then 3 
years at Apple", "companies")
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Syntax GPT_EXTRACT(text, to_extract, [temperature], [model])

Output The extracted entities as comma-separated values in a single cell

Parameters

Parameter Definition

text (cannot be empty)

Input text to extract data from.

The text parameter can be:

A string: "I worked 5 years at Amazon.com and then 3 
years at Apple"

A cell: A1
A range of cells: A1:C3

to_extract (cannot be
empty)

Text, cell or horizontal range specifying what you want to
extract.

Examples:

"companies"
B3:E3

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_FORMAT function
Formats dates, currencies, addresses, names, etc. Fixes capitalization. And so much more.
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How to use

Syntax
=GPT_FORMAT(input, target_format, [source_format], [temperature],
[model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output
The converted input in a single cell unless it is converted a table, which
outputs a table

Parameters

Parameter Definition

input (cannot be
empty)

Input text to format.

The input parameter can be:

A string: "14 February 1971"
A cell: A1
A range of cells: A1:C3

target_format
(cannot be empty)

Target format for the input. Examples: "iso", "currency iso",
"international phone number", "lowercase/uppercase/camelcase/snake
case/title case/sentence case"…

(optional)
source_format

Source format of the input. Optional, but including it can yield better
results.

(optional)
temperature,
model

See temperature and model.

See more usage examples.

=GPT_FORMAT("14 February 71", "iso")
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GPT_LIST / GPT_HLIST function
Like GPT, but outputs the results in a column. Very practical when the output is a list.

Use GPT_LIST to return options listed vertically.

Use GPT_HLIST to return options listed horizontally.

How to use

Syntax =GPT_LIST(prompt, [value], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output As many responses to your prompt as you asked, one response per cell

Parameters

Parameter Definition

prompt (cannot be empty)

Instruction provided to the AI to generate a list.

The prompt parameter can be:

A string: "Give me 5 good short ads about 
spreadsheets."

A cell: A1
A range of cells: A1:C3

(optional) value Text, cell or range you want your prompt to apply to

(optional) temperature,
model See temperature and model.

See more usage examples.

=GPT_LIST("Give me 5 good short ads about 
spreadsheets.")
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GPT_MATCH function
Matches the values of two columns by similarity.

INFO

Regardless of the model you select in the model switcher, this function uses text-embedding-
ada-002, for a fixed cost of $0.25 per 1M tokens.

WARNING

GPT for Excel settings do not apply to the GPT_MATCH function.

You can only match up to about 1,000 rows at a time.

How to use

Syntax
=GPT_MATCH(search_keys, lookup_range, [confidence], [stats],
[top_k])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A column of the best matches to each value in the range

Parameters

Parameter Definition

search_keys (cannot be
empty)

The values that you want to look for in the range

lookup_range (cannot
be empty)

The range in which to look for values that are similar to search keys

confidence (optional)
Set a similarity threshold: only values with a superior similarity
score are matched. Must be comprised between 0 and 1

=GPT_MATCH(A1:A10,B1:B4)
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Parameter Definition

stats (optional) "true" to display similarity scores

top_k (optional)
Number of matching values to return per search_key (default: 1 -
only the best match)

GPT_SPLIT / GPT_HSPLIT function
Splits text semantically, such as by section, paragraph, sentence, customer…

Use GPT_SPLIT to return outputs listed vertically.

Use GPT_HSPLIT to return outputs listed horizontally.

How to use

Syntax =GPT_SPLIT(text, split_by, [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output Input text is split as requested, one element per cell

Parameters

Parameter Definition

text (cannot be empty)

Input text to split.

The text parameter can be:

A string: "Hello! How are you? Have you heard of GPT 
for Work?"

A cell: A1
A range of cells: A1:C3

=GPT_SPLIT("Hello! How are you? Have you heard of GPT for 
Work?", "sentences")

GPT for Work Documentation (Microsoft) 2026-05-13

181 / 415



Parameter Definition

split_by (cannot be empty)

How to split the text. Examples:

sections
paragraphs
sentences
punctuation

(optional) temperature,
model See temperature and model.

GPT_TABLE function
Like GPT, but outputs the results in a table. Very practical when the output is a table.

How to use

Syntax =GPT_TABLE(prompt, [head], [inputs], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The response to your prompt in the shape of a table

=GPT_TABLE("top 10 most eaten fruits and their 
nutrition data")
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Parameters

Parameter Definition

prompt (cannot be
empty)

Instruction to generate a table.

The prompt parameter can be:

A string: "top 10 most eaten fruits and their nutrition 
data"

A cell: A1
A range of cells: A1:C3

(optional) head
Range containing at least one row. the first row should be headers, the
following rows can be used to specify examples If left empty, headers
will be generated automatically.

(optional) inputs Range containing partial rows to complete with GPT_TABLE

(optional)
temperature,
model

See temperature and model.

GPT_TAG function
Applies user-defined tags to text or automatically suggests relevant tags if none are specified.

How to use

Syntax
=GPT_TAG(value, [tags], [instructions], [top_k], [temperature],
[model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output The applicable tags as csv in a single cell

=GPT_TAG("I love chocolate", "food, positive, 
negative")
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Parameters

Parameter Definition

value (cannot be
empty)

Input text to tag.

The value parameter can be:

A string: "I love chocolate"
A cell: A1
A range of cells: A1:C3

(optional) tags
Comma-separated tags or range of tags applicable. If left empty,
GPT_TAG will automatically come up with the tags

(optional) instructions
Additional instructions for the tag application. Can include
examples.

(optional) top_k Maximum number of tags to return

(optional)
temperature, model See temperature and model.

See more usage examples.

GPT_TRANSLATE function
Translates text from one language to another. Works better if you specify the source language.

How to use

Syntax
=GPT_TRANSLATE(text, [target_language], [source_language],
[instructions],[temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters instead
of ","

=GPT_TRANSLATE("Cool off with our delicious treats!", 
"spanish")

GPT for Work Documentation (Microsoft) 2026-05-13

184 / 415

https://gptforwork.com/docs/gpt-for-excel/gpt-functions/create-gpt-formulas/examples


Syntax
=GPT_TRANSLATE(text, [target_language], [source_language],
[instructions],[temperature], [model])

Output The requested translation in a single cell

Parameters

Parameter Definition

text (cannot be empty)

Input text to translate.

The text parameter can be:

A string: "Cool off with our delicious treats!"
A cell: A1
A range of cells: A1:C3

(optional)
target_language

Language of the output. Examples: "spanish", "chinese",
"french". Defaults to "english".

(optional)
source_language

Language of the input. Example: "english"

(optional) instructions
Additional instructions for the translation. Can include a
dictionary of translations.

(optional) temperature,
model See temperature and model.

See more usage examples.

GPT_VISION function
Applies a prompt to an image. For example you can ask a question about the image, ask for a
description of it, or generate alt text for images. Learn more.

INFO

GPT_VISION is the only function that accepts images as input.

If you want to use GPT_VISION, you must use a vision model, like gpt-5.4 .
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How to use

Syntax =GPT_VISION(prompt, image_url, [high_res], [temperature], [model])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output
A response to your prompt according to the information extracted from
the image

Parameters

Parameter Definition

prompt
(cannot be
empty)

Instruction provided to the AI to analyze an image.

The prompt parameter can be:

A string: "Write a short description for this product"
A cell: A1
A range of cells: A1:C3

image_url

Link to the image you want the AI to analyze. Supported formats are PNG, JPEG, 
non-animated GIF.

The image_url parameter can be:

A string:
"https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:e
6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png

A cell: A4

(optional)
high_res

How the AI processes the image and generates its textual understanding. Possib
true , false , and auto  (default). Learn more.

=GPT_VISION("Write a short description for this 
product", A1, , , "gpt-4.1")

GPT for Work Documentation (Microsoft) 2026-05-13

186 / 415

https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:eco/b5ab0a6c-6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png
https://static.nike.com/a/images/t_PDP_1280_v1/f_auto,q_auto:eco/b5ab0a6c-6393-4af6-abbc-4f1acaa6ed94/air-max-dawn-womens-shoes-224mWf.png
https://platform.openai.com/docs/guides/images-vision?api-mode=chat#specify-image-input-detail-level


Parameter Definition

(optional)
temperature,
model

See temperature and model.

See more usage examples.

GPT_WEB function

INFO

GPT_WEB uses the web search model set for your space. Learn more.

How to use

Syntax =GPT_WEB(prompt, [value])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A response to your prompt based on recent web search data

Parameters

Parameter Definition

prompt (cannot
be empty)

Instructions provided to the AI to generate results based on recent web
search data. Provide instructions in English for better results.

The prompt parameter can be:

A string: "Who won the last presidential elections in 
Argentina?"

A cell: A1

=GPT_WEB("Who won the last presidential elections in 
Argentina?")
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Parameter Definition

(optional) value Text, cell, or range you want your prompt to apply to

See more usage examples.

GPT_CREATE_PROMPT helper function
Like the native CONCAT function, but inserts spaces and newlines automatically. Helps you create a
prompt from scattered, disjointed cells and ranges. You can then use that prompt in GPT functions.
This function does not call any AI provider's API and thus does not incur any cost.

How to use

Syntax =GPT_CREATE_PROMPT(arg1, [arg2], [arg3], [...argn])

Copy/paste
example

⚠️ Localization
In some locales, you might need to use ";" to separate parameters
instead of ","

Output A prompt ready to use in GPT, GPT_LIST or GPT_TABLE

Parameters

Parameter Definition

arg1 (cannot be empty)

Cell or range to concatenate. For example:

A1

A1:C3

(optional) arg2 - argn

Cell or range to concatenate. For example:

A2
G2:H4

=GPT_CREATE_PROMPT(A1:B1, A2, C3:D5, E1:E6)
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temperature and model
These parameters are present in most GPT functions. They are always optional.

For example with the GPT function, you can set:

temperature to 0.1

model to "gpt-4o-mini"

You can also set these values from the sidebar under Model settings. In this case, they become
the default values for all future executions.

Parameter Definition

(optional)
temperature

Number between 0 and 1 that governs the creativity of the output:

0 - Strictly according to the prompt

0.5 - Slightly creative

1 - Very creative

INFO

In some locales, you might need to use "0,5" (comma) instead of
"0.5" (period).

(optional) model
Name of the model surrounded by quotes. You can find model names
in the model switcher in the sidebar.
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Select a model for GPT functions in Excel
GPT for Excel supports a range of models that you can use with the GPT functions. To help you find
the model that offers the best balance of accuracy, speed, and cost for your use case, see our
recommended models.

The available models depend on:

The API keys set for your current space. GPT for Excel gives you access to a default set of
models available without API keys. To access additional models, set an API key for one or more
AI providers.

The API endpoints set up for your current space. To access even more models, set up a
connection to an Azure OpenAI endpoint or any OpenAI-compatible API endpoint.

The model settings for your current space. Space owners and admins can control which
models are available in GPT for Excel.

Recommended models
As a general rule, OpenAI models are more reliable and less likely to decline prompts than models
from other providers.

The following table lists our recommended models available without an API key.

Use case Recommended model Alternative model

General purpose gpt-5.4-mini gpt-5.4-nano

Translation claude-4.6-sonnet gpt-5.4-mini

Content creation claude-4.6-sonnet

TIP

For information about recommended models when working with web search and images, see:

Search the web

Use images in prompts

To learn more about a model, hover over the model info icon in the model switcher. A tooltip opens
with detailed information about the model.
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Select a model without an API key
Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, select GPT functions.3
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GPT for Excel now uses the selected model to generate responses for GPT functions.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
model when you re-execute them.

To re-execute an existing formula with the new model:

The GPT_MATCH function uses text-embedding-ada-002 , not the model you select.

The GPT_WEB function uses the web search model set for your space.

Select a model with an API key

You have set an API key for the AI provider whose model you want to use.

Expand Model settings and open the model switcher.4

Under No API key needed, select a model.5

i. Set the model as a parameter in the formula.1

ii. Press Enter to re-execute the formula.2

Prerequisites
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If you want to use an Azure model or an OpenAI-compatible model from an API endpoint,
you have set up the correct endpoint.

Open a Microsoft Excel workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, select GPT functions.3

Expand Model settings and open the model switcher.4

Under Use your API key or endpoint, select a model with a key icon.5
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GPT for Excel now uses the selected model to generate responses for GPT functions.

INFO

When cache is enabled, existing GPT formulas will not automatically update to the new
model when you re-execute them.

To re-execute an existing formula with the new model:

The GPT_MATCH function uses text-embedding-ada-002 , not the model you select.

The GPT_WEB function uses the web search model set for your space.

What's next
Learn more about models:

AI providers & models supported by GPT for Work

LiveBench (a good model benchmark)

i. Set the model as a parameter in the formula.1

ii. Press Enter to re-execute the formula.2
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Create GPT formulas in Excel
Delay and chain GPT functions, and learn how to use different GPT functions by example.

Control GPT formula execution

Delay or sequence the execution of GPT formulas in Microsoft Excel.

GPT formula examples

Real-world examples using some of the functions included in GPT for Excel.
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Control GPT formula execution in Excel
You might want to delay the execution of your GPT for Excel functions until your workbook is
ready. Or you might want to sequence the execution of multiple chained calls. Avoid running into
errors or going over your rate limits by learning how to keep control over the executions of your
GPT functions in Microsoft Excel in this video.

Watch video on YouTube
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GPT formula examples for Excel
See GPT functions in action with real-world examples using some of the functions included in GPT
for Excel.

TIP

To try out the examples, download our GPT for Excel examples template, and open it in Excel.

Rewrite and generate
Use GPT functions to rewrite or create content adapted to your goals:

Rephrase existing text by adjusting length, style, grammar or tone.

Create content that matches your audience needs using the perfect level of creativity.

Rewrite or rephrase content

Shorten product names:

Clean up text:

Change tone:
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Learn more on GPT.

Create content

Generate button labels (CTAs):

Make your content more or less creative:

Generate sales marketing emails:
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Learn more on GPT.

Generate multiple outputs (vertical vs. horizontal)

Generate SEO keywords:

Generate content ideas side by side:
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Learn more on GPT_LIST and GPT_HLIST.

Translate
Leverage large language models for your machine translation tasks and benefit from:

High performance: AI models from leading providers (such as OpenAI) support translation
across a wide range of language pairs. See all supported models.
Support for many languages: The full list of supported language pairs isn’t public, but ChatGPT
is known to work in 80+ languages, with varying accuracy depending on language and context.
Integration of your corporate terminology: For on-brand, consistent translations.

Translate with GPT_TRANSLATE

Translate descriptions:

Translate with specific instructions

Translate with a custom dictionary:
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Your texts are translated in the target language, and the translations comply with the terminology
you provided.

Learn more on GPT_TRANSLATE.

Write a prompt and custom dictionary.1

Create the prompt instructions.2

Translate your texts.3
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Prepare data
Free up your teams from tedious data preparation so they can concentrate on high-value data
analysis:

Basic data cleaning tasks include formatting data according to known standards or by following
examples you set.
More advanced tasks like named entity extraction, which traditionally demanded a specific
pattern-based approach, are also an option.

Format data with GPT_FORMAT

Standardize dates:

Standardize cases:

Standardize phone numbers:

Standardize currencies:

Learn more on GPT_FORMAT.
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Extract data with GPT_EXTRACT

Extract postal addresses:

Extract email addresses:

Extract emails and URLs:

Learn more on GPT_EXTRACT.

Analyze
Get instant insights from large volumes of content through automated summarizing,
categorization, tagging, and sentiment analysis.

Summarize data with GPT

Summarize customer tickets across languages:
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Summarize long descriptions:

Learn more on GPT.

Categorize or classify data with GPT_CLASSIFY

Categorize customer feedback:

Analyze sentiment:
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Categorize customer feedback with examples:

Learn more on GPT_CLASSIFY.

Assign tags with GPT_TAG

Tag products:
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Learn more on GPT_TAG.

Analyze images with GPT_VISION
Applies a prompt to an image. GPT_VISION is the only function that can process images. For
example, you can ask a question about the image, generate a description or generate alt text for
images.

INFO

To use GPT_VISION, you need to select a model that supports images (Vision).

Create content from an image

Write product descriptions:

Extract information from an image

Extract amounts from invoices:

Extract info from an ID:
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Explain elements in an image

Identify elements of an image:

Understand an image:

Explain formulas:
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Learn more on GPT_VISION.

Search the web

Get answers from the web with GPT

INFO

To search the web with a GPT function, select a model with web search capabilities.

Get average hotel prices:

Get most-spoken languages:

Fetch top newspaper website URLs:

GPT for Work Documentation (Microsoft) 2026-05-13

208 / 415

https://gptforwork.com/docs/gpt-for-excel/gpt-functions/reference#gpt_vision-function
https://gptforwork.com/docs/gpt-for-excel/gpt-functions/search-web#choose-the-right-web-search-model


GPT for Work Documentation (Microsoft) 2026-05-13

209 / 415



Manage GPT formulas from the sidebar
in Excel
Use the GPT for Excel sidebar to manage your GPT formulas and avoid unexpected changes and
costs.

Retry GPT formulas on error

Re-execute all formulas on error in your current sheet.

Regenerate GPT formula results

Re-execute selected formulas in your current sheet.

Replace GPT formulas with results

Replace GPT formulas with their results to prevent recalculation permanently.

Manage GPT formula cache

Minimize costs by reusing previous results.

Disable GPT formulas

Prevent the execution of GPT formulas in your workbook for an indefinite period of time.
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Retry GPT formulas on error in Excel
After troubleshooting GPT for Excel errors, you can recalculate all GPT formulas in cells tagged
with #ERROR!  or #VALUE! .

All GPT formulas that were on error in the current sheet are recalculated. If some errors persist, let
us know by submitting a support request.

TIP

Replace GPT formulas with their results in the selected cells to prevent any further
recalculation.

In the sidebar, select GPT functions.1

Check that the GPT formulas aren't disabled for your workbook.2

Click Retry errors.3
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Regenerate GPT formula results in Excel
Re-execute GPT formulas to update results in selected cells.

In the sidebar, select GPT functions.1

Check that the GPT formulas are not disabled and that caching is disabled for your workbook.2

Select cells with active GPT formulas in the current sheet. Ensure all cells generated by
formulas like GPT_LIST are included to prevent data loss.

3
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GPT formula results within the selected cells are regenerated.

Click Regenerate selection.4

(Optional) Disable the formulas to prevent recalculations in this sheet and the rest of the
document.

5
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Replace GPT formulas with results in
Excel
Convert GPT formulas to static values and prevent any further recalculation, either on a selected
number of cells or across an entire sheet. If you need to recover the original formulas later, you
can use the version history of your Microsoft workbook.

Replace formulas manually

GPT formulas within the manually selected cells are replaced by their respective results.

Replace formulas in selection

Select the cells that contain the GPT formulas.1

Copy them by pressing Ctrl+C (or Cmd+C on Mac).

INFO

For GPT formulas with multi-row results, copy all rows with results, not just the formula
row.

2

Paste the results as values by pressing Ctrl+Shift+V (or Cmd+Shift+V on Mac).3

Select cells with active GPT formulas in the current sheet, ensuring all cells generated by
formulas like GPT_LIST are included to prevent data loss.

1

In the sidebar, select GPT functions.2
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GPT formulas within the selected cells are replaced by their respective results.

Replace formulas in entire sheet

All GPT formulas within the sheet are replaced by their corresponding results.

Choose In selection in the Replace formulas dropdown.3

In the sidebar, select GPT functions.1

Refresh the formula count to see the number of active GPT formulas in the current sheet.
Formulas on error won't be replaced.

2

Choose In sheet in the Replace formulas dropdown.3
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Manage GPT formula cache for your
spreadsheet in Excel
Cache the results of your GPT formulas to minimize costs by reusing previous results, or disable
caching to experiment with sidebar settings.

Enable cache to save costs and reuse previous results
when reloading a formula
You can enable cache usage to avoid being charged for reusing formulas. This mode ensures that
results for the same formula are retrieved from the cache instead of generating new results.

Caching is enabled for GPT formula results in your workbook. You can now save costs and reuse all
future results of your GPT formulas.

In the sidebar, select GPT functions.1

Click on the Enable cache switch to start saving results.2
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Disable cache to experiment with sidebar settings
If you want to quickly experiment with various settings, you can disable cache usage. Disabling
your cache doesn’t clear its content. It stops storing new executions and fetching existing ones
from it.

Caching is disabled for GPT formula results in your workbook. Each time the formulas are
reloaded, they will be executed again, incur costs, and may return new results.

(Optional) Replace GPT formulas with their results if you want to preserve the current results.1

In the sidebar, select GPT functions.2

Click on the Enable cache switch to put it in disabled state.3
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Disable GPT formulas for your
spreadsheet in Excel
If the GPT for Excel cache is disabled, reloading active GPT formulas triggers their re-execution,
which incurs costs and potentially returns new results. To preserve your results and avoid
additional costs, disable GPT formula execution in your workbook.

In the sidebar, select GPT functions, and click Disable.

The button label changes to Run.

The GPT formulas in your workbook will not be executed until you click Run. If your workbook
contains multiple sheets, the GPT formulas across all these sheets are prevented from executing.
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Search the web with GPT functions in
Excel
Search the web directly in GPT for Excel using GPT functions with web search models. These
models use fresh web search data, which allows you to generate up-to-date responses about
companies, current events, facts, and more, directly in your workbook. You can also fetch content
from specific URLs to extract information from web pages.

Choose the right web search model
Choose a web search model that best fits your use case.

Web search

Get information that is not in the model's built-in knowledge:

Example: Finding the current CEO of a company.

How it works:

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific focus.

Recommended models:

Sonar for quick results (cheapest).

Sonar Pro or OpenAI Search models for high quality results.

Gemini models with Web search for Google search quality (most expensive).

Content fetching

Focus on specific URLs and extract content from them:

Example: Extracting the product name and price from the URL of a product page.

How it works: Some web search models can access the full content from specific URLs. The full
content is added to the context of the models, so they can use it to answer questions about the
content or extract information from it.

Recommended models:

Gemini 2.5 models with URL context
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Supported web search models

Click here for a list of all web search models supported by GPT for Excel ▼

Provider Model Without API
key

With API key
🔑

URL fetch

Search... Search... All All All

Perplexity sonar Yes Yes No

Perplexity sonar-pro Yes Yes No

Perplexity sonar-reasoning-pro No Yes No

Google gemini-2.5-flash Yes Yes Yes

Google gemini-2.5-flash-lite No Yes Yes

Google gemini-2.5-pro No Yes Yes

Google gemini-3-flash-
preview

No Yes Yes

Google gemini-3.1-flash-lite-
preview

No Yes Yes

Google gemini-3.1-pro-
preview

No Yes Yes

OpenAI gpt-4o-mini-search-
preview

Yes Yes No

OpenAI gpt-4o-search-
preview

Yes Yes No

OpenAI gpt-5-search-api Yes Yes No

Parallel speed Yes No No

For detailed pricing information, see Model prices.

Use web search models
Use GPT functions to perform web searches with any model that has web search capabilities (🌐).
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Using the model switcher

Open GPT for Excel.1

In the sidebar, select GPT functions.2

Expand Model settings and open the model switcher.3

Enable the web search filter and select a web search model (🌐).4

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

5

In the workbook, select a cell and write your formula:6

=GPT("Find the Instagram handle for 'Berlin Salsa Festival 2025'.")
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Specifying the model in the formula

For instructions on how to write formulas with GPT functions, see the GPT functions reference.

Model-specific settings
Use the model-specific settings to configure the web search model for your use case.

The formula uses the web search model selected in the model switcher.

Open GPT for Excel.1

In the sidebar, select GPT functions.2

(Optional) Configure the model-specific settings in the sidebar. For Gemini models, make sure
web search is enabled.

3

In the workbook, select a cell and write your formula, specifying a web search model directly in
the formula, for example the Perplexity Sonar model:

The formula uses the web search model regardless of what's currently selected in the model
switcher.

4

=GPT("Find the Instagram handle for 'Berlin Salsa Festival 2025'.", , , 
"sonar")
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Google Gemini

Setting Description Example

Web search

Let Gemini decide when a Google search can
improve the answer. This allows Gemini to provide
more accurate answers and cite verifiable sources
beyond its built-in knowledge. Enabling Web
search incurs an additional search cost.

URL context

Provide up to 20 URLs (pages, images, PDFs) in
your prompt to focus your search. No search cost
is incurred, but the content retrieved from URLs
counts as input tokens.

Perplexity Sonar

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

Domains

Bulk tools only

Specify up to 20 domains to generate responses
based only on search results from these domains.
Use simple domain names (e.g., wikipedia.org )
without additional elements like the prefixes
https://  or www. .
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OpenAI Search

Setting Description Example

Context size
Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

Location
To refine search results based on geography,
specify an approximate user location using
country, city, and/or region.
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Use images in GPT function prompts in
Excel
Use images in your prompts with GPT for Excel and vision models. These models are multimodal
and can process both text and images as input.

TIP

Don't have image URLs yet? Learn how to host images on Google Drive for AI processing.

INFO

Supported image formats: PNG, JPEG, WebP, non-animated GIF

Supported vision models
We recommend using gpt-5.4 to analyze images, but you can use any vision model supported by
GPT for Excel.

Click here for a list of all vision models supported by GPT for Excel ▼

Provider Model Without API
key

With API key
🔑

Search... Search... All All

OpenAI gpt-4.1 Yes Yes

OpenAI gpt-4.1-mini Yes Yes

OpenAI gpt-4.1-nano Yes Yes

OpenAI gpt-4o Yes Yes

OpenAI gpt-5 Yes Yes

OpenAI gpt-5-chat Yes Yes

OpenAI gpt-5-mini Yes Yes

OpenAI gpt-5-nano Yes Yes

OpenAI gpt-5.1 Yes Yes

OpenAI gpt-5.2 Yes Yes
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Provider Model Without API
key

With API key
🔑

OpenAI gpt-5.4 Yes Yes

OpenAI gpt-5.4-mini Yes Yes

OpenAI gpt-5.4-nano Yes Yes

OpenAI gpt-5.5 Yes Yes

OpenAI o1 Yes Yes

OpenAI o3 Yes Yes

OpenAI o4-mini Yes Yes

Anthropic claude-4-6-sonnet Yes Yes

Anthropic claude-4-sonnet Yes Yes

Anthropic claude-4.1-opus No Yes

Anthropic claude-4.5-haiku Yes Yes

Anthropic claude-4.5-opus Yes Yes

Anthropic claude-4.5-sonnet Yes Yes

Anthropic claude-4.6-opus Yes Yes

Anthropic claude-4.7-opus Yes Yes

Mistral mistral-medium No Yes

xAI grok-4-1-fast No Yes

xAI grok-4-1-fast-non-
reasoning

No Yes

Prompt images
Use the GPT_VISION function to describe or analyze images in individual cells.
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Using the model switcher

Open GPT for Excel.1

In the sidebar, select GPT functions.2

Expand Model settings and open the model switcher.3

Select a vision model.4

In the workbook, select a cell and write your formula:

The formula uses the vision model selected in the model switcher.

5

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.",C9)
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For instructions on how to write formulas with the GPT_VISION function and set the image
resolution, see the GPT_VISION reference.

Specifying the model in the formula

For instructions on how to write formulas with the GPT_VISION function and set the image
resolution, see the GPT_VISION reference.

Host images on Google Drive for AI processing
To process an image in GPT for Excel, you need the direct URL of the image and the URL must be
publicly accessible.

To host an image on Google Drive so that GPT for Excel can access and process it:

Open GPT for Excel.1

In the workbook, select a cell and write your formula, specifying a vision model directly in the
formula:

The formula uses the vision model regardless of what's currently selected in the model
switcher.

2

=GPT_VISION("Extract the coffee brand from this image. Normalize the brand 
name to title case.",C9, , , "gpt-4.1")

Upload the image to Google Drive.1

Share the image publicly using the Anyone with the link option. For more information, see
Google Drive Help.

TIP

To prevent other users from commenting or editing the image, set the access role to
Viewer.

2

Copy the link.3

Get the image file ID from the link URL, and build the following new URL with the ID:4

https://drive.google.com/uc?id=<image-file-id>
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You now have a direct image URL that you can access and process in GPT for Excel.

For example:

# Original share URL from "Copy link"
https://drive.google.com/file/d/1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux/view

# Direct image URL
https://drive.google.com/uc?id=1dTZrIkAHsV_hKnvL2KjH1pfcOOSpYVux
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Configure GPT function behavior in Excel
Configure model settings to customize how GPT functions behave in your workbook.

INFO

When cache is enabled, existing GPT formulas will not automatically update to new model
settings when you re-run the formulas.

To re-run an existing formula with the new settings:

Change a parameter in the formula and press Enter.

Disable the cache, select the formula, and regenerate its results.

Add global instructions
Provide global instructions to specify preferences or requirements that you'd like the AI to consider
when generating responses. The instructions apply to all GPT functions in the current workbook.

In the sidebar, select GPT functions.1
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The AI takes the global instructions into account when generating responses for GPT functions in
the current workbook.

Set the creativity level
Control how creative the AI is by setting the creativity level (also called temperature). Lower
creativity generates responses that are straightforward and predictable, while higher creativity
generates responses that are more random and varied.

Expand Model settings.2

In the Global instructions section, select the type of instructions you'd like to add and edit
them if needed.

3
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TIP

For more information about temperature as used by OpenAI to set the creativity level, see our
temperature guide.

In the sidebar, select GPT functions.1

Expand Model settings.2
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The AI uses the creativity level when generating responses for GPT functions in the current
workbook.

Adjust advanced settings
Adjust the advanced settings to have greater control over generated output for GPT functions in
the current workbook. For more information about the settings, see the OpenAI API
documentation.

Term Definition

Token

A token is a unit of text, such as a word, subword, punctuation mark, or
symbol. Models split all input and output text into tokens for processing.
Model providers use tokens as the basic unit for measuring model usage.
The total number of tokens in a prompt (input) and the model's response
(output) determines your credit consumption. For more information, see
Tokens and How credits are consumed.

Top P
Helps adjust creativity level – Lower values result in more focused output,
while higher values allow for more creative responses.

Use the slider to set Creativity between 0 and 1.3
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Term Definition

Frequency
penalty (not
available for all
models)

Penalizes tokens based on their frequency in the text so far – Higher values
discourage the model from repeating the same tokens too frequently, as
the more they appear in the text, the more penalized they get.

Presence
penalty (not
available for all
models)

Penalizes new tokens based on whether they appear in the text so far –
Higher values encourage the model to use new tokens that are not
penalized.

In the sidebar, select GPT functions.1

Expand Model settings.2
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Expand View advanced settings.3

Use the corresponding sliders to set the values for:4

Top P: Adjust creativity by setting the value between 0 and 1.

Set the creativity level to 1 when the value for Top P is lower than 1.

Frequency penalty: Set a penalty between 0 and 2 to apply to tokens each time they are
repeated in the result.

Presence penalty: Set a one-time penalty between 0 and 2 for tokens that appear more
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GPT for Excel uses the advanced settings to generate responses for GPT functions in the current
workbook (when a model supporting the settings is selected).

What's next
Select the model that best fits your needs.

Run GPT functions.

than once in the result.
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GPT for Word

GPT for Word is a Microsoft Word add-in that integrates an AI writing assistant into the Word
user interface. Use plain-language instructions to create and edit content, summarize sections or
explain terms, translate text, correct grammar and style, and more.

Use cases
Here are a few common use cases that you can easily handle with GPT for Word:

Rewrite or rephrase content in a different style, tone, or voice.

Check and correct the grammar and spelling in your document.

Generate a document template, or a document draft or outline that you can then flesh out.

Translate content to multiple target languages while observing appropriate localization
conventions.

Install for Microsoft
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Summarize a document into a few bullet points.

Explain individual words, phrases, and paragraphs in your document.

Review your document for logical structure, clarity and consistency of content, and other
aspects that you want to validate.

Features
Prompt an AI as you would in ChatGPT or another AI chatbot.

Use a highlighted selection or the whole document as context for your prompts.

Preserve common formatting elements such as headings, lists, tables, and basic text styles
when inserting generated content.

Preview and refine content in a chat interface before inserting the content into your document.

Enable Word's Track changes mode to keep track of your AI edits.

The following video shows you how to translate selected text and replace the selection with the
translation while preserving formatting.

Benefits
Integrate AI into your content workflow. Prompt your favorite AI directly from inside your
documents. No more copy-pasting between Word and AI chatbots like ChatGPT.

Choose your preferred AI model. Use models from OpenAI, Anthropic, Google, xAI, or
Perplexity. You can also connect to local models with any LLM server that provides an OpenAI-
compatible API.

Bring an API key to get more features at reduced cost. You do not need an API key to use
GPT for Word, but using a key gives you access to more models, affords you more control and
privacy, and you pay a reduced service fee.

What's next
Install GPT for Word if you have not already.

Select an AI model that best meets your needs.
Author text with GPT for Word.
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Set up GPT for Word
Install GPT for Word, open the add-in, and sign in. If needed, configure API keys and endpoints to
access more models. If you no longer use GPT for Word, remove its access to your Microsoft
account or uninstall the add-in.

Install

Install the GPT for Excel Word add-in to use AI in your Word documents.

Open

Open the GPT for Excel Word add-in in Microsoft Word.

Sign in

Use a Microsoft account to sign in to GPT for Word, switch between accounts, and sign out.

Manage models

Connect AI models to Microsoft Word with GPT for Word.

Remove account access

Remove Microsoft account access from the GPT for Excel Word add-in.

Uninstall

Remove the GPT for Excel Word add-in from your Microsoft account.
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Install GPT for Word
GPT for Word is part of the GPT for Excel Word add-in. One installation covers Microsoft Word and
Microsoft Excel, on both desktop and the web; this guide focuses on installing and using the add-in
for Microsoft Word.

The following table lists the minimum versions of Microsoft Word compatible with the GPT
for Excel Word add-in on different Microsoft Office platforms.

Windows macOS Web

Microsoft 365 subscription:

Version 2205 (Build
15202.10000)

Retail perpetual:

Version 2205 (Build
15202.10000)

Volume-licensed perpetual:

Word 2024: Version 2205 (Build
15202.10000)

Version 16.61 (Build
22040100)

Supported on:

Google Chrome
(latest version)
Microsoft Edge
(latest version)

Installation

Prerequisites

Go to the installation page.1

Click Open in Word.

INFO

The add-in will be installed on your Microsoft account for both Word and Excel.

2
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A pop-up appears at the top of the window, requesting your permission to proceed.

Confirm to open the Word desktop app.

INFO

If this method doesn't work, install the add-in from the app:

3

i. Open Word.1

ii. On the ribbon, select Home > Add-ins.2

iii. Search for "GPT for Excel Word".3

iv. In the search results, click Add for GPT for Excel Word.4
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You have installed GPT for Excel Word on your Microsoft account. The add-in is now available from
the Home tab in the desktop and web versions of Word. If you don't see it, go to Home > Add-ins >
My add-ins > GPT for Excel Word.

FOR IT ADMINISTRATORS

If your organization uses a firewall or proxy that restricts network access, you must whitelist
the following domains for the add-in to work:

Click Accept and Continue to accept the permissions.4

*.gptforwork.com
*.microsoft.com
*.microsoftonline.com
*.live.com
*.office.com
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Having trouble installing?
If you run into any issues while installing the add-in, see the troubleshooting guide.

What's next
Open GPT for Word.

Learn about GPT for Word.

Select a model.

Start authoring text with GPT for Word.
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Open GPT for Word
On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-ins
> My Add-ins > GPT for Excel Word. Learn more.

What's next
Sign in with your Microsoft account.

If you run into issues, see the troubleshooting guide.
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Sign in to GPT for Word
This section explains how GPT for Word authenticates your Microsoft account, how to check which
account you're using, and how to switch between accounts or sign out.

Sign in with your account

Sign in to GPT for Word with your Microsoft account.

Check which account you're using

How to check which Microsoft account GPT for Word is using.

Switch to another account

Use a different Microsoft account with GPT for Word.

Sign out

How to sign out of GPT for Word.
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Sign in with your Microsoft account
You need a Microsoft account to use GPT for Word.

When you launch the GPT for Excel Word add-in:

From Word desktop:

If you're already signed in with your Microsoft account, the add-in automatically uses that
account.

If you're not signed in or you're using multiple accounts, the add-in prompts you to choose an
account.

From Word for the web: You need to sign in with your Microsoft account when you first launch
the add-in.

If you have multiple Microsoft accounts, such as a personal account and a work account, you can
switch between them to ensure you are using the correct account in GPT for Word.

What's next
Check which account is used by GPT for Word.

If needed, switch to another account.
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Check which Microsoft account you're
using
To check which Microsoft account you are using in GPT for Word:

Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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What's next
If needed, switch to another account.

In the sidebar, open the main menu. Your account is displayed at the bottom of the menu.3
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Switch to another Microsoft account
If the account currently used by GPT for Word is not the one you want to use, switch to another
account:

You have switched to another account. You can now launch and use GPT for Word with the new
account.

TIP

If you signed in with the wrong account during installation, contact support to request an
account transfer.

Launch Word.1

In the upper-right corner of the application, click your account icon or picture.2

Select the account you want to switch to.

INFO

If the account you want to switch to is not in the list, click to add a new account and
complete the sign-in process.

3

If you are using the desktop version of Word, close the application and reopen it.4
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Sign out of GPT for Word
To sign out of GPT for Word:

Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2
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INFO

Signing out of GPT for Word also signs you out of GPT for Excel, since they use the same
Microsoft account session.

You have signed out of GPT for Word. You'll need to sign in again when you next launch the add-in.

What's next
Sign in with your Microsoft account.

In the sidebar, open the main menu. Then, select Log out.3
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Manage models for GPT for Word
Models are the engines that power GPT for Word. GPT for Word supports models from OpenAI,
Perplexity, Google, Anthropic, Parallel, DeepSeek, Mistral, and xAI. GPT for Word also supports
Azure models and open-source models through any OpenAI-compatible API endpoint.

INFO

As a space owner or admin, you can control which models are available to users in your space
through the AI configuration section in the GPT for Work dashboard.

Which model is the right one depends on your specific needs in terms of response quality, speed,
privacy, and cost. The following table summarizes the kinds of models available in GPT for Word,
from zero setup to more advanced options:

Use Setup When

Models
without an API
key

None.

Use the default model
or select a different
model.

You want to get started quickly without setting
up API keys.

✅ Available models

Models with an
API key 🔑

AI provider models

Set an API key for an AI
provider.

You want to benefit from the terms of service
you have with an AI provider, such as cost,
privacy, and rate limits.

You want to use a model that is not available
without an API key.

You want more control.

✅ Available models
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Use Setup When

Models from
cloud
endpoints

Azure OpenAI models

Set up an Azure
OpenAI endpoint.

Your company is already using Azure with a
consumption commitment. Using Azure
OpenAI counts towards that commitment.

You want to use models that are available
through Azure OpenAI.

✅ Available models

OpenAI-compatible
models

Set up an OpenAI-
compatible platform
endpoint.

You want to use models available on a cloud-
based LLM platform such as Anyscale or
Fireworks AI.

You need a fast and powerful inference
infrastructure that scales to your performance
needs.

Local models

OpenAI-compatible
models

Set up an OpenAI-
compatible server
endpoint.

You want to use models available on a local
LLM server such as LM Studio or Ollama.

You want to run models on a local machine.

You do not want to send or receive any
prompt or response data over the internet.

What's next
Set and manage your API keys.

Use Azure OpenAI models.

Use OpenAI-compatible models through API endpoints.

Use Ollama models.
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Manage API keys for GPT for Word
Using API keys offers several benefits:

More models. Access to a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage AI usage and costs directly on the AI provider's platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key. For
more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

If you're on a subscription plan, using an API key is mandatory since you do not have access to
models without a key.

Create API keys

INFO

Make sure your keys belong to an organization or project with the following rate limits:

RPM (requests per minute) ≥ 1,000

TPM (tokens per minute) ≥ 1,000,000

The actual limits required depend on your workload requirements.

To create an API key, go to the AI provider's platform and follow their instructions:

OpenAI Platform for GPT models and fine-tuned models

Anthropic Console for Claude models

DeepSeek Platform for DeepSeek models

Google AI Studio for Gemini models

Mistral AI for Mistral models

Perplexity for Perplexity models

xAI Cloud Console for xAI models
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Set API keys
You set API keys for your space in the GPT for Work dashboard. The keys you set for a Microsoft
account space apply to GPT for Word.

INFO

The API keys you set work for all users in your space. Users automatically have access to
models associated with the keys, but only the space owner (you) and admins can set and
manage the keys. Billing for a key reflects its usage by all users.

Create an API key or request an API key from your AI provider platform admin. Learn more.1

Sign in to the GPT for Work dashboard with your Microsoft account.2

In the sidebar, select AI provider keys.3

In the AI providers list, click the provider whose API key you want to set.4

Set the API key:5

i. In the text field, enter the key.1

ii. Click Check to verify that the key is valid.2

iii. Click Save.3
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You have set the API key. You can now use any model available with the key in GPT for Word.

Check API keys
You can verify whether the API keys you have set are valid.

Check all API keys at once

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click Check all API keys.

The page displays a warning for each key that is invalid.

3
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Check a specific API key

If a key is invalid, create a new key and replace the invalid value with the new one.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click the edit icon for the key you want to check.3

Click Check.

The UI displays a message indicating whether the key is valid or invalid.

4
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Troubleshoot OpenAI API keys
If your API key is not working, check on the OpenAI Platform that the key's permissions are not
restricted. The following permissions are required:

Permission Description

List models List all available models.

Model capabilities Use model capabilities, such as chat completion.

What's next
Check which models you can use with an API key.

Select a model.

Need to use your own LLM service endpoint for models? Connect to an OpenAI-compatible
endpoint.

If the key is invalid, create a new key and replace the invalid value with the new one.
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Connect to Azure OpenAI from Word
GPT for Word can connect to Azure AI to use OpenAI models. In Azure AI, each model has a
dedicated API endpoint that you use to access the model.

You have an Azure subscription with Azure AI service access.

You have deployed a model in an Azure OpenAI resource.

To use an Azure OpenAI model:

Get the Azure OpenAI endpoint details
To connect to Azure AI from GPT for Word, you need the endpoint URL, name, and API key for the
Azure OpenAI model you want to use.

Prerequisites

Get the Azure OpenAI endpoint details for the model.1

Set up the Azure OpenAI endpoint.2

Select the Azure OpenAI model.3

Sign in to Azure AI Foundry.1

Select the Azure OpenAI resource that has the model you want to use.2
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In the sidebar, select My assets > Models + endpoints.3

In Model deployments, in the models list, click the name of the model you want to use.4
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Set up the Azure OpenAI endpoint

In the model details, copy the Target URI, Key, and Model name.5

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2
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Click Azure OpenAI endpoints.

TIP

If you already have Azure OpenAI endpoints set up, click Add another Azure OpenAI
endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the endpoint URL for the model.

Model name: Enter the model name.

API key: Enter the API key for accessing the endpoint.

Display name (optional): Enter a custom display name for the model. If not set, the model
switcher uses Model name as the display name.
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You have set up the Azure OpenAI endpoint. You can now use the endpoint model in GPT for Word.

TIP

To set up another Azure OpenAI endpoint with a different model, click Add another Azure
OpenAI endpoint and repeat the previous two steps.

Select the Azure OpenAI model

Click Check to validate the settings and click Save.5

Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.2
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GPT for Word now uses the selected model to generate responses.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

Open the model switcher. You can find the Azure OpenAI model under Use your API key or
endpoint.

3

Select the model.4
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Connect to OpenAI-compatible API
endpoints from Word
GPT for Word can connect to any LLM service that provides an OpenAI-compatible API endpoint.
You can connect to two main types of services: cloud-based platforms, which provide access to
models over the internet with no software installation or setup required on your part, and local
servers, which you run on a local machine, such as your own computer or another computer on a
local network. Once connected, all models available through the service become available to use in
GPT for Word.

Here are some popular services that provide an OpenAI-compatible API endpoint:

Cloud-based platforms:

Anyscale

Fireworks AI

Together AI

Local servers:

LM Studio

LocalAI

Ollama

You have an endpoint URL and, if needed, an API key for accessing the service.

The endpoint must support the following OpenAI-compatible API resource paths:

/v1/models

/v1/completions

INFO

Depending on the model you use, the model settings defined in GPT for Word (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

To use models from an OpenAI-compatible API endpoint:

Prerequisites

Set up the endpoint.1

Select a model available through the endpoint.2
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Set up an API endpoint
Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click OpenAI-compatible endpoints.

TIP

If you already have OpenAI-compatible API endpoints set up, click Add another OpenAI
compatible endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the URL of the service that provides the endpoint.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom/".

API key (optional): If required, enter the API key for accessing the service.
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You have set up the OpenAI-compatible API endpoint. You can now use all models available
through the endpoint in GPT for Word.

TIP

To set up another OpenAI-compatible API endpoint, click Add another OpenAI compatible
endpoint and repeat the previous two steps.

Select a model from the API endpoint

Click Check to validate the settings and click Save.

TIP

If you get an error saying that the URL is invalid, make sure that the endpoint supports:

5

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for macOS
or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.

Open a Microsoft Word document.1
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GPT for Word now uses the selected model to generate responses.

What's next
To try out an OpenAI-compatible LLM service with GPT for Word, set up LM Studio on macOS or
Windows.

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

Open the model switcher. You can find the models under Use your API key or endpoint.

NOTE

The available models depend on the models provided by the service.

3

Select a model.4
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Set up LM Studio on macOS
This guide walks you through the main steps of setting up LM Studio for use in GPT for Word on
macOS.

This guide assumes that you use GPT for Word on the same machine that hosts LM Studio.

System requirements

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up LM Studio on macOS:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

(Optional) Enable HTTPS for the LM Studio server.3

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

1

Run LM Studio.2

On the welcome screen, click Skip.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the minimum setup required to access LM Studio from GPT for Word on
the same machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for
Word provided the add-in is not running on Safari or on Microsoft Word for Mac.

If you use GPT for Word on Safari or on Word for Mac, enable HTTPS for the LM Studio server.

Click the Enable CORS toggle to enable the setting.

INFO

By default, the LM Studio server only accepts same-origin requests. Since GPT for Word
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5
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Enable HTTPS for the LM Studio server
The LM Studio server uses HTTP to serve models, while GPT for Word runs on HTTPS. By default,
therefore, any request from GPT for Word to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the LM Studio server accessible over HTTPS if you use GPT
for Word from:

Word for the web on Safari

Word for Mac (uses Safari)

You make the LM Studio server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the LM Studio server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \
  -nodes \

GPT for Work Documentation (Microsoft) 2026-05-13

272 / 415

https://developer.mozilla.org/en-US/docs/Web/Security/Mixed_content
https://en.wikipedia.org/wiki/Reverse_proxy
https://nginx.org/
https://developers.cloudflare.com/cloudflare-one/connections/connect-networks/
https://ngrok.com/


The command generates two files in the current directory:

  -sha256 \
  -days 365 \
  -keyout lm-studio.key \
  -out lm-studio.crt \
  -subj '/CN=127.0.0.1' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=127.0.0.1\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

lm-studio.crt : Public self-signed certificate

lm-studio.key : Private key used to sign the certificate

iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./lm-studio.crt

Create a site configuration for the LM Studio server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       127.0.0.1:1235 ssl;
        server_name  127.0.0.1;

        http2 on;

        ssl_certificate      lm-studio.crt;
        ssl_certificate_key  lm-studio.key;

        location / {
            proxy_pass  http://127.0.0.1:1234;

            # Keep connection to backend alive.
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You have enabled HTTPS for the LM Studio server.

The configuration uses port 1235  for HTTPS. Requests to https://127.0.0.1:1235  are
forwarded to the LM Studio server running at http://127.0.0.1:1234 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf syntax 
is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /v1/models  endpoint of the LM Studio server works over the HTTPS
connection:

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

4

curl -k https://127.0.0.1:1235/v1/models

{
  "data": [
    {
      ...
    },
  ],
  "object": "list"
}
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WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Word on the same
machine. You can now set https://127.0.0.1:1235  as the endpoint URL in GPT for Word,
including when the add-in is running on Safari or on Microsoft Word for Mac.
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Set up LM Studio on Windows
This guide walks you through the main steps of setting up LM Studio for use in GPT for Word on
Windows.

This guide assumes that you use GPT for Word on the same machine that hosts LM Studio.

System requirements

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up LM Studio on Windows:

Install LM Studio and download a model

Prerequisites

Install LM Studio and download a model.1

Start and configure the LM Studio server.2

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer sets LM Studio to start automatically as a background service on system boot.

1

Run LM Studio.2

On the welcome screen, click Skip.3

In LM Studio, in the sidebar, select Discover.4

Find and select the model you want to use, and click Download. For example, to get started5
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You have installed LM Studio and downloaded your first model. For more information about
working with models, see the LM Studio documentation.

Start and configure the LM Studio server

with a small model, select Llama 3.2 3B.

After the download completes, the model is available for prompting in LM Studio.

In LM Studio, in the sidebar, select Developer.1

Click the Status toggle to change the status from Stopped to Running. You have started the
LM Studio server.

2

Click Settings.3
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You have started and configured the LM Studio server.

WHAT'S NEXT

You have completed the setup required to access LM Studio from GPT for Word on the same
machine. You can now set http://127.0.0.1:1234  as the endpoint URL in GPT for Word.

Click the Enable CORS toggle to enable the setting.

INFO

By default, the LM Studio server only accepts same-origin requests. Since GPT for Word
always has a different origin from the LM Studio server, you must enable cross-origin
resource sharing (CORS) for the server.

4

To verify that the /v1/models  endpoint of the LM Studio server works, open
http://127.0.0.1:1234/v1/models.

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a data  property listing all currently installed
models:

5
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Connect to Ollama from Word
GPT for Word can connect to an Ollama server to use locally running open-source models. Ollama
is an open-source platform that allows you to easily install, run, and serve models from a local
machine, keeping your prompting entirely offline. You can use any model from the Ollama library.

You have an Ollama server running with one or more models. For instructions on how to set
up the server, see:

Set up Ollama on macOS

Set up Ollama on Windows

INFO

Depending on the model you use, the model settings defined in GPT for Word (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

To use models from an Ollama server:

Set up the API endpoint for an Ollama server

Prerequisites

Set up the API endpoint for the Ollama server.1

Select a model available on the Ollama server.2

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click OpenAI-compatible endpoints.

TIP

If you already have OpenAI-compatible API endpoints set up, click Add another OpenAI
compatible endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the URL of the Ollama server.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom/".
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API key (optional): Leave this field empty. The Ollama server does not require an API key
for access.

Click Check to validate the settings and click Save.5
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You have set up the Ollama server API endpoint. You can now use all models available through the
endpoint in GPT for Word.

Select a model from the Ollama server

TIP

If you get an error saying that the URL is invalid, make sure that the Ollama server
supports:

Cross-origin resource sharing (CORS). See the Ollama server setup instructions for
macOS or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the Ollama
server setup instructions for macOS.

Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

Open the model switcher. You can find the Ollama models under Use your API key or3
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GPT for Word now uses the selected model to generate responses.

What's next
Set up an Ollama server on macOS or Windows.

endpoint.

NOTE

The available models depend on the models available on the Ollama server.

Select a model.4
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Set up Ollama on macOS
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Word on macOS.

This guide assumes that you use GPT for Word on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for hardware support information)

macOS Sonoma (version 14) or newer (see the Ollama documentation for detailed system
requirements)

Mac user account with administrator (sudo) privileges

Installed software:

curl (ships with macOS)

Homebrew

OpenSSL (ships with macOS)

To set up an Ollama server on macOS:

Install an Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

(Optional) Enable HTTPS for the server.4

Download and run the macOS installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1
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You have installed the Ollama server.

For more information about installing and managing the server on macOS, see the Ollama
documentation.

Install a model on the Ollama server

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Enable CORS for the Ollama server
By default, the Ollama server only accepts same-origin requests. Since GPT for Word always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Open Terminal and verify that the server is running:

Response if the server is running:

2

curl http://localhost:11434

Ollama is running

Install a model from the Ollama library:

For example, to install the Meta Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'
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You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the minimum setup required to access the Ollama server from GPT for
Word on the same machine. You can now set http://localhost:11434  as the endpoint URL
in GPT for Word provided the add-in is not running on Safari or on Microsoft Word for Mac.

If you use GPT for Word on Safari or on Word for Mac, enable HTTPS for the Ollama server.

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:

For example:

1

# Set a single origin
launchctl setenv OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
launchctl setenv OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "*"

Allow only GPT for Word to make requests to the server:

launchctl setenv OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

Restart the server for the variable to take effect.2

Verify that the /api/tags  endpoint of the server works:

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [
    {
      ...
    }
  ]
}
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Enable HTTPS for the Ollama server
The Ollama server uses HTTP to serve models, while GPT for Word runs on HTTPS. By default,
therefore, any request from GPT for Word to the server is a mixed-content request (HTTP vs.
HTTPS). Modern web browsers do not allow mixed content, as a rule. The only exceptions are
mixed-content requests to http://127.0.0.1  and http://localhost , which most browsers
treat as safe and therefore allow. Safari, however, blocks mixed-content requests even on the
current machine.

To avoid mixed content, you must make the Ollama server accessible over HTTPS if you use GPT for
Word from:

Word for the web on Safari

Word for Mac (uses Safari)

You make the Ollama server accessible over HTTPS by setting up a reverse proxy that hides the
server behind an HTTPS interface. This guide uses nginx to set up the reverse proxy.

TIP

You can also use Cloudflare Tunnel, ngrok, or a similar cloud-based tunneling service to set up
HTTPS with minimal configuration. Note that with a cloud-based service your traffic will be
routed through an external service over the internet.

To set up the reverse proxy:

Install nginx:1

brew install nginx

Create a self-signed SSL certificate for the Ollama server:2

i. Change to the nginx configuration directory (varies based on your Mac version):1

# Mac with an Apple silicon processor
cd /opt/homebrew/etc/nginx

# Mac with an Intel processor
cd /usr/local/etc/nginx

ii. Generate the certificate:2

openssl req \
  -x509 \
  -newkey rsa:2048 \
  -nodes \
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The command generates two files in the current directory:

  -sha256 \
  -days 365 \
  -keyout ollama.key \
  -out ollama.crt \
  -subj '/CN=localhost' \
  -extensions extensions \
  -config <(printf "
[dn]\nCN=localhost\n[req]\ndistinguished_name=dn\n[extensions]\nsubjectAl

ollama.crt : Public self-signed certificate

ollama.key : Private key used to sign the certificate

iii. Add the certificate to trusted root certificates:3

sudo security add-trusted-cert -d -r trustRoot -k 
/Library/Keychains/System.keychain ./ollama.crt

Create a site configuration for the Ollama server:3

i. Open the nginx.conf  file in your preferred text editor. The file is in the nginx
configuration directory:

1

# Mac with an Apple silicon processor
/opt/homebrew/etc/nginx/nginx.conf

# Mac with an Intel processor
/usr/local/etc/nginx/nginx.conf

ii. Replace the content of the file with the following configuration:2

events {}

http {
    server {
        listen       11435 ssl;
        server_name  localhost;

        http2 on;

        ssl_certificate      ollama.crt;
        ssl_certificate_key  ollama.key;

        location / {
            proxy_pass  http://localhost:11434;

            # Keep connection to backend alive.
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You have enabled HTTPS for the Ollama server.

The configuration uses port 11435  for HTTPS. Requests to https://localhost:11435
are forwarded to the Ollama server running at http://localhost:11434 .

            proxy_http_version  1.1;
            proxy_set_header    Connection '';
        }
    }
}

iii. Save and close the file.3

iv. Test the nginx configuration:

Response if the configuration is valid:

4

sudo nginx -t

nginx: the configuration file /opt/homebrew/etc/nginx/nginx.conf syntax 
is ok
nginx: configuration file /opt/homebrew/etc/nginx/nginx.conf test is 
successful

v. Start nginx:5

sudo nginx

Verify that the /api/tags  endpoint of the Ollama server works over the HTTPS connection:

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

4

curl -k https://localhost:11435/api/tags

{
  "models": [
    {
      ...
    }
  ]
}
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WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Word on the
same machine. You can now set https://localhost:11435  as the endpoint URL in GPT for
Word, including when the add-in is running on Safari or on Microsoft Word for Mac.
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Set up Ollama on Windows
This guide walks you through the main steps of setting up an Ollama server for use in GPT for
Word on Windows.

This guide assumes that you use GPT for Word on the same machine that hosts Ollama.

Local machine with enough processing power and memory to run LLMs (see the Ollama
documentation for hardware support information)

Windows 10 22H2 or newer (see the Ollama documentation for detailed system
requirements)

Windows user account with administrator privileges

Installed software:

curl (ships with Windows)

PowerShell 7

To set up an Ollama server on Windows:

Install an Ollama server

Prerequisites

Install the server.1

Install a model on the server.2

Enable CORS for the server.3

Download and run the Windows installer. Follow the on-screen instructions to complete the
installation.

The installer starts the Ollama server in the background and sets the server to start
automatically on system boot. The installer also installs the Ollama desktop application for
easily starting and stopping the server.

TIP

You can manually start a new instance of the Ollama server in a terminal by running
ollama serve . However, to avoid port conflicts, make sure no other Ollama server

instances are running at the same time.

1

Open PowerShell as an administrator and verify that the server is running:2
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You have installed the Ollama server.

For more information about installing and managing the server on Windows, see the Ollama
documentation.

Install a model on the Ollama server

You have installed the model on the Ollama server. For more information about working with
models, see the Ollama documentation.

Response if the server is running:

NOTE

Make sure you're using curl and not an aliased command, such as Invoke-WebRequest :

If curl  has an alias, the command removes it for the current terminal session, ensuring
that subsequent curl  commands in this guide work as expected.

curl http://localhost:11434

Ollama is running

Remove-Item alias:curl

Install a model from the Ollama library:

For example, to install the Meta Llama 3.2 3B model:

After the installation completes, the model is available for prompting on the Ollama server.

1

ollama pull <model-name>

ollama pull llama3.2

Verify that the model works:

The above request asks the server to generate a response for the specified prompt with the
specified model and to return the response in a single reply. If the model works, the server
returns a JSON object containing the response and metadata about the response.

2

curl http://localhost:11434/api/generate -d '{ "model": "llama3.2", 
"prompt": "Who are you?", "stream": false }'
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Enable CORS for the Ollama server
By default, the Ollama server only accepts same-origin requests. Since GPT for Word always has a
different origin from the Ollama server, you must enable cross-origin resource sharing (CORS) for
the server using the OLLAMA_ORIGINS  environment variable.

To enable CORS for the Ollama server:

Set OLLAMA_ORIGINS  with the origins that are allowed to access the server:

For example:

INFO

By default, the setx  command sets a user variable. If you want to set a system variable,
which applies to all users of the current machine, run the command (as an administrator)
with the /m  parameter. For example:

1

# Set a single origin
setx OLLAMA_ORIGINS "<ORIGIN>"

# Set multiple origins
setx OLLAMA_ORIGINS "<ORIGIN_1>, <ORIGIN_2>, ..."

Allow any origin to make requests to the server:

setx OLLAMA_ORIGINS "*"

Allow only GPT for Word to make requests to the server:

setx OLLAMA_ORIGINS "https://excel-addin.gptforwork.com"

setx OLLAMA_ORIGINS "*" /m

Restart the server for the variable to take effect.2

Verify that the /api/tags  endpoint of the server works:

GPT for Word uses the endpoint to fetch a list of models installed on the server. If the endpoint
works, the server returns a JSON object with a models  property listing all currently installed
models:

3

curl http://localhost:11434/api/tags

{
  "models": [
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You have enabled CORS for the Ollama server.

WHAT'S NEXT

You have completed the setup required to access the Ollama server from GPT for Word on the
same machine. You can now set http://localhost:11434  as the endpoint URL in GPT for
Word.

    {
      ...
    }
  ]
}
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Remove account access from GPT for
Word

WARNING

Removing Microsoft account access from GPT for Word removes access from the GPT for
Excel Word add-in, which also removes access from GPT for Excel.

INFO

The following instructions only apply to personal accounts. If you have a school or work
account, contact your organization administrator about add-in access.

In your browser, log in to the Microsoft account you use in GPT for Word.1

Open the privacy dashboard for your Microsoft account.2
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In the Empower your productivity section, select App access.3
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The GPT for Excel Word add-in no longer has access to your Microsoft account.

INFO

Removing account access does not uninstall the add-in from Microsoft Word. The next time
you open the add-in, Word displays a welcome screen in the sidebar, after which you can sign
in with your Microsoft account and grant access again.

In the Manage your app access section, click Don't Allow for GPT for Excel Word.4
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Uninstall GPT for Word
WARNING

Uninstalling GPT for Word removes the GPT for Excel Word add-in from both Microsoft Word
and Microsoft Excel.

Open Word.1

On the ribbon, select Home > Add-ins > More Add-ins. The Office Add-ins dialog opens.2

Select the My Add-ins tab.3

Hover over GPT for Excel Word and open its Options menu (⋯).4

Select Remove.

A confirmation pop-up opens.

TIP

If the Remove option is not available in the menu, clear the Microsoft Office cache:

5

i. Close all Office applications.1

ii. Follow Microsoft's instructions for clearing the cache.2

iii. Open Word and try removing the add-in again.3

Click Remove to confirm.6
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The GPT for Excel Word add-in is removed from your Microsoft account. If you ever need to use
the add-in again, follow the installation process.

INFO

Removing the add-in does not remove its app access permissions from your Microsoft
account. You can remove access manually.
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Use GPT for Word
Author text with GPT for Word. Manage how the add-in handles text formatting and search the
web for up-to-date information. Browse example prompts for common use cases.

Author text

Use AI to plan, create, edit, and review your Word documents.

Manage text formatting

Manage how GPT for Word handles formatting in your documents.

Search the web

Learn how to use web search models to get up-to-date information from the web.

Example prompts

Learn how to use GPT for Word effectively through practical examples.
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Author text with GPT for Word
GPT for Word is an AI assistant that helps you plan, create, edit, and review content directly in
Microsoft Word documents, whether you're drafting from scratch, refining existing text, or
analyzing content.

How it works
To use GPT for Word:

Here are some common ways to use GPT for Word:

Translate content to other languages.

Fix grammar and spelling errors.

Summarize document content.

Prompt the AI
Configure the AI and send prompts to generate AI responses for your document.

Prompt the AI with your request.1

(Optional) Use the AI's response in your document.2

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

1
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(Optional) Select an AI model.

INFO

To customize how the AI responds, you can set Custom instructions.

2

In the document, select the text you want to work with and, in the sidebar, select Use
selection as context. If no text is selected, GPT for Word uses the entire document as context.

3

Type your prompt in the chat. For example: Translate to French4

Click Send. GPT for Word generates a response.5
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The AI generates responses based on your settings, selected context, and prompts.

Use AI responses in your document
Once you are satisfied with the AI-generated content, you can:

Insert the AI response at the cursor position or under the selected text.

(Optional) Refine the AI-generated response and click Send. For example: Make it shorter6
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Replace the selected text with the AI response.

Copy the AI response to clipboard.

INFO

You can also Replace, Insert, or Copy part of the AI response by selecting the text in the
response. When Plain text mode is disabled, you can only Copy part of the AI response.
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TIP

To include AI-generated responses as suggestions in your documents with Microsoft Word,
you can activate Track Changes. Learn more

What's next
Choose between formatted or plain text responses.

Guide how the AI responds with custom instructions.

Choose the model that works best for you.

Explore practical use cases with examples.
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Manage text formatting in GPT for Word
GPT for Word generates formatted AI responses in a sidebar. By default, the add-in analyzes and
extracts common formatting elements from your document, including headings, lists, tables, and
basic text styles, then applies similar formatting to the generated content. If you don't need
formatting, you can generate plain text responses.

INFO

The generating formatted text is slightly slower and uses about 20% more tokens than
generating plain, unformatted text.

Formatted text vs. plain text
Use formatted text mode (default) when:

You want the add-in to analyze your document's formatting and apply similar formatting to the
generated content. This is particularly useful for translations.

You want to preserve formatting elements when inserting or replacing text from the sidebar
into your document.

INFO

When using formatted text mode, GPT for Word cannot generate or preserve:

Font properties (family, size, color)

Text alignment and spacing

Background colors

Text decorative effects (shadows, glow, reflection)

Media and embedded objects (images, charts, icons)

Use plain text mode when:

You don't need to preserve formatting in responses. This is particularly useful when drafting or
summarizing content or analyzing text.

You want to increase speed and/or reduce token consumption.

Enable and disable plain text mode
To manage the text formatting mode in GPT for Word:
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WARNING

Changing the plain text mode setting clears your chat history.

What's next
To assign a specific role to the AI and more closely define how it responds, add custom
instructions.

See more GPT for Word examples.

Open GPT for Word.1

In the sidebar header, click the settings icon (⚙).2

Select the Chat tab.3

Choose the mode that best suits your needs:4

Enable Plain text mode to process text without formatting.

Disable Plain text mode to preserve and work with formatting.
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Search the web with GPT for Word
Search the web directly in GPT for Word using web search models. These models use fresh web
search data, which allows you to generate up-to-date responses about companies, current events,
facts, and more, directly in your document. You can also fetch content from specific URLs to extract
information from web pages.

Choose the right web search model
Choose a web search model that best fits your use case.

Web search

Get information that is not in the model's built-in knowledge:

Example: Writing a report about the latest AI trends in your business.

How it works:

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific focus.

Recommended models:

Sonar for quick results (cheapest).

Sonar Pro for high quality results.

Gemini models with Web search for Google search quality (most expensive).

Content fetching

Focus on specific URLs and extract content from them:

Example: Extracting key requirements from a job posting URL and writing a tailored cover letter.

How it works: Some web search models can access the full content from specific URLs. The full
content is added to the context of the models, so they can use it to answer questions about the
content or extract information from it.

Recommended models:

Gemini 2.5 models with URL context

Supported web search models

Click here for a list of all web search models supported by GPT for Word ▼
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Provider Model Without API
key

With API key
🔑

URL fetch

Search... Search... All All All

Perplexity sonar Yes Yes No

Perplexity sonar-pro Yes Yes No

Perplexity sonar-reasoning-pro No Yes No

Google gemini-2.5-flash Yes Yes Yes

Google gemini-2.5-flash-lite No Yes Yes

Google gemini-2.5-pro No Yes Yes

Google gemini-3-flash-
preview

No Yes Yes

Google gemini-3.1-flash-lite-
preview

No Yes Yes

Google gemini-3.1-pro-
preview

No Yes Yes

OpenAI gpt-4o-mini-search-
preview

Yes Yes No

OpenAI gpt-4o-search-
preview

Yes Yes No

OpenAI gpt-5-search-api Yes Yes No

Parallel speed Yes No No

For detailed pricing, see How credits are consumed.

Use web search models
Open GPT for Word.1
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Expand the model switcher and select a web search model (indicated by the 🌐 icon).2

(Optional) Click the settings icon and configure the model-specific settings in the sidebar. For
Gemini models, make sure web search is enabled.

3

Type your search prompt in the chat. For example:4

What are the latest trends in AI technology?

Click Send. The model generates a response using up-to-date web search data.5

Once you're satisfied with the response, you can:6

Insert the response at your cursor position

Replace the selected text with the response

Copy the response to your clipboard
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Model-specific settings
Use the model-specific settings to configure the web search model for your use case.

Google Gemini

Setting Description Example

Web search

Let Gemini decide when a Google search can
improve the answer. This allows Gemini to provide
more accurate answers and cite verifiable sources
beyond its built-in knowledge. Enabling Web
search incurs an additional search cost.

URL context

Provide up to 20 URLs (pages, images, PDFs) to
focus your search. No search cost is incurred, but
the content retrieved from URLs counts as input
tokens.
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Perplexity Sonar

Setting Description Example

Search context
size

Choose how much content to retrieve from each
source. Larger sizes produce richer and more
detailed responses at a higher cost.

What's next
Choose between formatted or plain text responses.

Guide how the AI responds with custom instructions.

Explore practical use cases with examples.
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Example prompts for GPT for Word
Learn how to use GPT for Word effectively through practical examples. Each example
demonstrates a common use case and includes step-by-step instructions.

Translate a document
You can follow along using either your own Word document or our translation example template.

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

1

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Choose the Copywriter pre-defined instruction.2
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iii. Click Save.3

In the document, select the text you want to translate and, in the sidebar, select Use selection
as context.

4

Type your prompt:5

Translate to French

Make sure plain text mode is disabled.6
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GPT for Word has replaced the original text with the AI-generated translation, while preserving all
formatting.

Correct grammar or spelling errors of a document
You can follow along using either your own Word document or our grammar correction template.

Click Send. GPT for Word generates a response.7

Refine the AI-generated response:8

i. Type the prompt:1

Make it shorter

ii. Click Send. GPT for Word generates a new response.2

To replace the selected text with the response, click Replace.9

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

1

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Select Write custom instructions.2
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GPT for Word has replaced the original text with the AI-generated corrected response.

TIP

To review the AI's corrections, enable Track Changes in Word. Go to Review > Track Changes
or press Ctrl/Cmd+Shift+E.

Summarize a document into a table
You can follow along using either your own Word document or our summarization example
template.

iii. Replace the existing instructions with:3

Act as a professional editor focusing on grammar, spelling, and 
clarity

iv. Click Save.4

In the document, select the text you want to improve and, in the sidebar, select Use selection
as context.

4

Type your prompt:5

Correct grammar or spelling errors

Make sure plain text mode is disabled.6

Click Send. GPT for Word generates a response.7

To replace the selected text with the response, click Replace.8

On the ribbon, select Home > GPT for Excel Word.1
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GPT for Word has inserted the AI-generated table into the Word document.

Summarize a document into one paragraph
You can follow along using either your own Word document or our summarization example
template.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

Select the model of your choice.2

In the document, select the text you want to summarize into a table and, in the sidebar, select
Use selection as context.

3

Type your prompt:4

Summarize this document into a table

Make sure plain text mode is disabled.5

Click Send. GPT for Word generates a response.6

To add the table at the cursor position or under the selected text, click Insert.7

On the ribbon, select Home > GPT for Excel Word.1
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GPT for Word has generated a one-paragraph summary of the document. You can now Copy or
Insert the summary.

Create a job description draft
You can follow along using your own Word document.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

Select the model of your choice.2

Select Use full document as context.3

Type your prompt:4

Create a concise summary of this document

Make sure plain text mode is enabled.5

Click Send. GPT for Word generates a response.6

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

1
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GPT for Word has inserted the AI-generated job description into the Word document.

Analyze a text selection
You can follow along using either your own Word document or our product review template.

Select the model of your choice.2

Define custom instructions to improve the AI response:3

i. Click the settings icon.1

ii. Choose the HR Consultant pre-defined instruction.2

iii. Click Save.3

(Optional) Deselect Use selection or document for context. Since you're starting from a
blank document, there's nothing to use as context.

4

Type your prompt:5

Write a job description for a Senior Software Engineer position, including 
qualifications, responsibilities, and benefits

Make sure plain text mode is disabled.6

Click Send. GPT for Word generates a response.7

Refine the AI-generated response:8

i. Type the prompt:1

Add more emphasis on collaboration skills and remote work experience

ii. Click Send. GPT for Word updates the content.2

To add the job description at the cursor position, click Insert.9
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GPT for Word has generated an analysis of the selected text. You can now Copy or Insert the
analysis.

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

1

Select the model of your choice.2

In the document, select the text you want to analyze and, in the sidebar, select Use selection
as context.

3

Type your prompt:4

What are the pros and cons mentioned here?

Make sure plain text mode is enabled.5

Click Send. GPT for Word generates a response.6
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Configure GPT for Word
Select the AI model for GPT for Word and configure how the model behaves.

Select a model

Select the model used by GPT for Word.

Configure AI behavior

Configure model settings to customize how GPT for Word generates responses.
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Select a model in GPT for Word
GPT for Word supports a range of models that you can use with your AI work in Word. To help you
find the model that offers the best balance of accuracy, speed, and cost for your use case, see our
recommended models.

The available models depend on:

The API keys set for your current space. GPT for Word gives you access to a default set of
models available without API keys. To access additional models, set an API key for one or more
AI providers.

The API endpoints set up for your current space. To access even more models, set up a
connection to an Azure OpenAI endpoint or any OpenAI-compatible API endpoint.

The model settings for your current space. Space owners and admins can control which
models are available in GPT for Word.

Recommended models
As a general rule, OpenAI models are more reliable and less likely to decline prompts than models
from other providers.

The following table lists our recommended models available without an API key.

Use case Recommended model Alternative model

General purpose claude-4.6-sonnet claude-4.6-opus

Translation claude-4.6-sonnet claude-4.6-opus

TIP

For information about recommended models when working with web search, see Search the
web.

To learn more about a model, hover over the model info icon in the model switcher. A tooltip opens
with detailed information about the model.
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Select a model without an API key
Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

Open the model switcher.3

Under No API key needed, select a model.4
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GPT for Word now uses the selected model to generate responses.

Select a model with an API key

GPT for Word now uses the selected model to generate responses.

What's next
Learn more about models:

AI providers & models supported by GPT for Work

LiveBench (a good model benchmark)

Open a Microsoft Word document.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

Open the model switcher.3

Under Use your API key or endpoint, select a model with a key icon.4
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Configure AI behavior in GPT for Word
Configure model settings to customize how GPT for Word generates responses.

INFO

Model settings are specific to each document.

Add custom instructions
Provide custom instructions to specify preferences or requirements that you'd like the AI to
consider when generating responses.

The AI takes the custom instructions into account when generating responses in the current
document.

TIP

To revert the custom instructions to the default, click Reset to default.

Set the creativity level
Control how creative the AI is by setting the temperature and top-p parameters. The parameters
work together to define overall creativity. Lower creativity generates responses that are
straightforward and predictable, while higher creativity generates responses that are more
random and varied.

TIP

For more information about temperature as used by OpenAI to set the creativity level, see our
temperature guide.

In the GPT for Word sidebar, click Settings.1

In the Custom instructions dropdown, select the type of instructions you'd like to add and
edit them if needed.

2

Click Save.3
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Parameter Description How to use

Temperature Controls randomness in the output.

Possible values: 0-1

Keep at 1 if adjusting Top P

Lower for factual, higher for
creative

Top P Controls diversity of word choices.

Possible values: 0-1

Keep at 1 for most use cases

Only lower if Temperature is 1

The AI uses the new temperature and top-p values when generating responses in the current
document.

Reduce AI response repetition
Set frequency and presence penalties to reduce the tendency of OpenAI and xAI models towards
repetition.

Parameter Description How to use

Frequency
penalty

Controls how much to penalize new
tokens based on their frequency in
the text so far.

Possible values: 0-2

Keep at 0 by default

Higher values reduce repetition

Presence
penalty

Controls how much to penalize new
tokens based on whether they
appear in the text so far.

Possible values: 0-2

Keep at 0 by default

Higher values increase diversity

In the GPT for Word sidebar, click Settings.1

Use the slider to set Creativity between 0 and 1.2

(Optional) Use the slider to set Top P between 0 and 1.3

Click Save.4
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The AI uses the new penalty values when generating responses in the current document.

What's next
Manage text formatting.

Select the model that best fits your needs.

In the GPT for Word sidebar, click Settings.1

Use the sliders to set Frequency penalty and Presence penalty between 0 and 2.2

Click Save.3
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Admin
Manage users, AI configuration, and billing for your space from the GPT for Work dashboard.

User management

Create a team in your space, and add and remove users from the space. If needed, promote users to
admins or transfer ownership of your space.

AI configuration

Manage the models available to users in your space: Set which Agent and bulk models are available, and
configure API keys and endpoints.

Billing

Buy credits, set spending limits, pause usage, and download invoices and usage reports for your space.
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User management
Create a team in your space, and add and remove users from the space. If needed, promote users
to admins or transfer ownership of your space.

Create a team

Create a team in the GPT for Work dashboard so that all team members can use the add-ons with shared
billing as well as shared API keys and endpoints.

Add and remove users

Add and remove users from your GPT for Work space to ensure only the right people have access to the
space and its resources.

Promote users to admins

Promote regular users to admins in your GPT for Work space to give them access to all the dashboard
features.

Transfer space ownership

Transfer the ownership of your GPT for Work space to any other user in the space. The new owner takes full
control of the space, while you remain in the space as an admin.
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Create a team
You can create a team in GPT for Work so that all team members can use the add-ons with shared
billing as well as shared API keys and endpoints.

To set up your team:

Create a GPT for Work account

INFO

If you already have a GPT for Work account, skip to Set up your space.

Microsoft

You have created the GPT for Work account. The account comes with a space that you own.

Set up your space
Before inviting users, set up your space to provide access to the necessary models:

Manage API keys for your space.

Manage API endpoints for your space.

Set up the model switcher for users.

Create a GPT for Work account (if you don't already have one).1

Set up your space.2

Invite users to your space.3

Open the GPT for Work dashboard.1

Click Sign in with Microsoft.2

Choose the Microsoft account you want to associate with the GPT for Work account.3

Click Continue to sign in with your Microsoft account.4
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Invite users to your space

You are the owner or an admin of the space.

Microsoft

You have successfully invited users to your space. You can resend or cancel an invitation while its
status remains Pending.

What's next
Install the add-ons on your domain or have your team members install the add-ons individually.

Manage API keys, API endpoints, and models for your space.

Set spending limits for your space and for individual users.

Manage users in your team.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

Click Invite users.3

Enter the email addresses of the users you want to invite, separated by commas or spaces.4

Click Send invitations.5
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Add and remove users
As your team grows and changes, you can add and remove users from your GPT for Work space to
ensure only the right people have access to the space and its resources.

You are the owner or an admin of the space.

Add users to your team
You can add users to your team at any time by inviting them to your space.

Microsoft

You have successfully invited users to your space. You can resend or cancel an invitation while its
status remains Pending.

Remove users from your team
You can remove users from your team at any time by removing them from your space.

When you remove a user from your space, they can still use the GPT for Work add-ons. However,
they are no longer able to use your space's credits, or its API keys and endpoints.

INFO

The space owner cannot be removed. If you want to remove the space owner from the team,
you must transfer ownership to another user first.

Microsoft

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

Click Invite users.3

Enter the email addresses of the users you want to invite, separated by commas or spaces.4

Click Send invitations.5

Sign in to the GPT for Work dashboard with your Microsoft account.1
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You have successfully removed the user from the space. When they next sign in to the dashboard,
they only see their personal space, not your team space.

What's next
Promote a user to an admin.

Transfer the ownership of your space.

In the sidebar, select Users.2

In the users list, click the three horizontal dots (…) for the user you want to remove and select
Remove user. If the user has yet to accept their invitation to the space, select Cancel
invitation instead.

3
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Promote users to admins
As a space owner or admin, you can promote regular users to admins in your space. Admins have
access to all the dashboard features and can do everything the owner can do, except transfer the
ownership of the space.

You are the owner or an admin of the space.

Microsoft

You have successfully promoted the user to admin. They can now access all the dashboard
features.

INFO

You can revoke admin permissions at any time by clicking the three horizontal dots (…) in the
admin user's row and selecting Remove admin role.

What's next
Remove a user from your space.

Transfer the ownership of your space.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Users.2

In the users list, click the three horizontal dots (…) for the user you want to promote and select
Set as admin.

3
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Transfer space ownership
You can transfer the ownership of your space to any other user in the space. After the transfer, the
new owner takes full control of the space, while you remain in the space as an admin.

You are the owner of the space.

Microsoft

You have successfully transferred the ownership of the space to the user. You remain in the space
as an admin.

What's next
Manage users in your team.

Manage API keys, API endpoints, and models for your space.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Settings.2

In the Transfer ownership section, select the user to whom you want to transfer the
ownership.

3

Click Save to confirm.4
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AI configuration
Manage the models available to users in your space: Set which Agent and bulk models are
available, and configure API keys and endpoints to provide access to more models.

Manage Agent models

Configure which AI models are available to users in your team space from the GPT for Work dashboard.

Manage bulk models

Configure which AI models are available to users in your team space from the GPT for Work dashboard.

Manage API keys

Set API keys for your space to give your users access to more models.

Manage API endpoints

Set up API endpoints for your space to give your users access to more models.
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Manage Agent models
As a space owner or admin, you can control which AI models are available to the users of your
space. This allows you to customize model access for your team and control costs.

INFO

These settings apply to GPT for Sheets, GPT for Excel, and GPT for Word. You cannot enable
and disable models or otherwise control model access for GPT for Docs (apart from setting
API keys).

You are the owner or an admin of the space.

Set the default Agent model
You can set the default Agent model for all users in your space. You can only select enabled Agent
models.

Microsoft

The Agent now uses the selected default Agent model for new users in the space. Users can
override this default from the model switcher in the add-on sidebar.

Set the bulk models for the Agent
You can set two bulk models for the Agent:

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Agent models.2

In the Default Agent model dropdown, select the default Agent model for your space.

For information about recommended Agent models, see Select the models for the Agent in
Excel.

INFO

To select an Agent model with an API key, you must first set an API key for your space.

3

GPT for Work Documentation (Microsoft) 2026-05-13

336 / 415

https://gptforwork.com/docs/resources/guides/concepts#model
https://gptforwork.com/docs/resources/guides/concepts#space
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys?platform=google
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys?platform=google
https://gptforwork.com/docs/resources/guides/concepts#agent-model
https://dashboard.gptforwork.com/
https://gptforwork.com/docs/gpt-for-excel/agent/select-models#recommended-models
https://gptforwork.com/docs/gpt-for-excel/agent/select-models#recommended-models
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys


The Default model for bulk tasks is used by the Agent for bulk tasks. For new users in your
space, this model is also selected by default in the bulk tools and GPT functions model switcher.

The Default model for web search bulk tasks is used by the Agent for bulk tasks that require
web search. This model is also used by the GPT_WEB function.

The models available depend on the models enabled for your space.

Microsoft

The Agent now uses the selected bulk models for bulk tasks and web searches for all users.

Enable and disable models
You can enable and disable individual models for your space. This includes both Agent models and
bulk models. Users can only select enabled models from the model switchers in the add-ons.

Microsoft

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Bulk models.2

Select the bulk models you want the Agent to use for bulk tasks and web searches.

For information about recommended bulk models, see Select the models for the Agent in
Excel.

For information about recommended web search models, see Search the web with bulk tools
in Excel.

3

Sign in to the GPT for Work dashboard with your Microsoft account.1
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TIP

To enable or disable all models without an API key or all models with an API key, click Toggle
all in the corresponding section of the model switcher.

What's next
Set spending limits for your space and for individual users.

Invite users to your space.

Manage users in your team.

In the sidebar, select Bulk models or Agent models.2

In the model switcher, use the toggle next to a model to enable or disable the model.3
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Manage bulk models
As a space owner or admin, you can control which AI models are available to the users of your
space. This allows you to customize model access for your team and control costs.

INFO

These settings apply to GPT for Sheets, GPT for Excel, and GPT for Word. You cannot enable
and disable models or otherwise control model access for GPT for Docs (apart from setting
API keys).

You are the owner or an admin of the space.

Set the default Agent model
You can set the default Agent model for all users in your space. You can only select enabled Agent
models.

Microsoft

The Agent now uses the selected default Agent model for new users in the space. Users can
override this default from the model switcher in the add-on sidebar.

Set the bulk models for the Agent
You can set two bulk models for the Agent:

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Agent models.2

In the Default Agent model dropdown, select the default Agent model for your space.

For information about recommended Agent models, see Select the models for the Agent in
Excel.

INFO

To select an Agent model with an API key, you must first set an API key for your space.

3

GPT for Work Documentation (Microsoft) 2026-05-13

339 / 415

https://gptforwork.com/docs/resources/guides/concepts#model
https://gptforwork.com/docs/resources/guides/concepts#space
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys?platform=google
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys?platform=google
https://gptforwork.com/docs/resources/guides/concepts#agent-model
https://dashboard.gptforwork.com/
https://gptforwork.com/docs/gpt-for-excel/agent/select-models#recommended-models
https://gptforwork.com/docs/gpt-for-excel/agent/select-models#recommended-models
https://gptforwork.com/docs/admin/ai-configuration/manage-api-keys


The Default model for bulk tasks is used by the Agent for bulk tasks. For new users in your
space, this model is also selected by default in the bulk tools and GPT functions model switcher.

The Default model for web search bulk tasks is used by the Agent for bulk tasks that require
web search. This model is also used by the GPT_WEB function.

The models available depend on the models enabled for your space.

Microsoft

The Agent now uses the selected bulk models for bulk tasks and web searches for all users.

Enable and disable models
You can enable and disable individual models for your space. This includes both Agent models and
bulk models. Users can only select enabled models from the model switchers in the add-ons.

Microsoft

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Bulk models.2

Select the bulk models you want the Agent to use for bulk tasks and web searches.

For information about recommended bulk models, see Select the models for the Agent in
Excel.

For information about recommended web search models, see Search the web with bulk tools
in Excel.

3

Sign in to the GPT for Work dashboard with your Microsoft account.1
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TIP

To enable or disable all models without an API key or all models with an API key, click Toggle
all in the corresponding section of the model switcher.

What's next
Set spending limits for your space and for individual users.

Invite users to your space.

Manage users in your team.

In the sidebar, select Bulk models or Agent models.2

In the model switcher, use the toggle next to a model to enable or disable the model.3
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Manage API keys
As a space owner or admin, you can set API keys for your space. Models available with the keys will
be accessible to all users in the space.

Using API keys offers several benefits:

More models. Access to a wider range of models from a bigger pool of AI providers than what is
available without API keys.

More control. Monitor and manage AI usage and costs directly on the AI provider's platform.

Improved privacy. We do not log inputs and outputs when you use a model with an API key. For
more information, see our security and privacy FAQ.

Reduced costs. If you're on usage-based pricing, using an API key reduces costs. You pay the
model usage fees directly to the AI provider, while paying a reduced service fee for GPT for
Work.

Create API keys

INFO

Make sure your keys belong to an organization or project with the following rate limits:

RPM (requests per minute) ≥ 1,000

TPM (tokens per minute) ≥ 1,000,000

The actual limits required depend on your workload requirements.

To create an API key, go to the AI provider's platform and follow their instructions:

OpenAI Platform for GPT models and fine-tuned models

Anthropic Console for Claude models

DeepSeek Platform for DeepSeek models

Google AI Studio for Gemini models

Mistral AI for Mistral models

Perplexity for Perplexity models

xAI Cloud Console for xAI models
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Set API keys

You are the owner or an admin of the space.

Microsoft

Prerequisites

Create an API key or request an API key from your AI provider platform admin. Learn more.1

Sign in to the GPT for Work dashboard with your Microsoft account.2

In the sidebar, select AI provider keys.3

In the AI providers list, click the provider whose API key you want to set.4

Set the API key:5

i. In the text field, enter the key.1

ii. Click Check to verify that the key is valid.2

iii. Click Save.3
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You have set the API key. All users in the space can now use any model available with the key in
GPT for Excel and GPT for Word.

Check API keys
You can verify whether the API keys you have set are valid.

Check all API keys at once

Microsoft

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click Check all API keys.

The page displays a warning for each key that is invalid.

3
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Check a specific API key

Microsoft

If a key is invalid, create a new key and replace the invalid value with the new one.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select AI provider keys.2

Click the edit icon for the key you want to check.3

Click Check.

The UI displays a message indicating whether the key is valid or invalid.

4
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What's next

Microsoft

Invite users to your space.

Manage API endpoints for your space.

Manage models for your space.

Manage users in your team.

If the key is invalid, create a new key and replace the invalid value with the new one.
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Manage API endpoints
As a space owner or admin, you can set up API endpoints for your space. Models available through
the endpoints will be accessible to all users in the space

INFO

API endpoints are available only for Microsoft accounts.

Connect to Azure OpenAI
GPT for Excel and GPT for Word can connect to Azure AI to use OpenAI models. In Azure AI, each
model has a dedicated API endpoint that you use to access the model.

You are the owner or an admin of the space.

You have an Azure subscription with Azure AI service access.

You have deployed a model in an Azure OpenAI resource.

To connect to an Azure OpenAI endpoint:

Get the Azure OpenAI endpoint details

To connect to Azure AI from GPT for Excel and Word, you need the endpoint URL, name, and API
key for the Azure OpenAI model you want to use.

Prerequisites

Get the Azure OpenAI endpoint details.1

Set up the Azure OpenAI endpoint.2

Sign in to Azure AI Foundry.1

Select the Azure OpenAI resource that has the model you want to use.2
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In the sidebar, select My assets > Models + endpoints.3

In Model deployments, in the models list, click the name of the model you want to use.4
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Set up the Azure OpenAI endpoint

In the model details, copy the Target URI, Key, and Model name.5

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2
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Click Azure OpenAI endpoints.

TIP

If you already have Azure OpenAI endpoints set up, click Add another Azure OpenAI
endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the endpoint URL for the model.

Model name: Enter the model name.

API key: Enter the API key for accessing the endpoint.

Display name (optional): Enter a custom display name for the model. If not set, the model
switcher uses Model name as the display name.
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You have set up the Azure OpenAI endpoint. All space users can now use the endpoint model in
GPT for Excel and GPT for Word.

TIP

To set up another Azure OpenAI endpoint with a different model, click Add another Azure
OpenAI endpoint and repeat steps 4 and 5.

Connect to OpenAI-compatible API endpoints
GPT for Excel and GPT for Word can connect to any LLM service that provides an OpenAI-
compatible API endpoint. You can connect to two main types of services: cloud-based platforms,
which provide access to models over the internet with no software installation or setup required on
your part, and local servers, which you run on a local machine, such as your own computer or
another computer on a local network. Once connected, all models available through the service
become available to use in the add-ins.

Here are some popular services that provide an OpenAI-compatible API endpoint:

Cloud-based platforms:

Anyscale

Click Check to validate the settings and click Save.5
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Fireworks AI

Together AI

Local servers:

LM Studio

LocalAI

Ollama

You are the owner or an admin of the space.

You have an endpoint URL and, if needed, an API key for accessing the service.

The endpoint must support the following OpenAI-compatible API resource paths:

/v1/models

/v1/completions

INFO

You cannot currently use models from OpenAI-compatible API endpoints with the Agent.

INFO

Depending on the model you use, the model settings defined in GPT for Work (temperature
(creativity), top-p, frequency penalty, and presence penalty) may not work as expected. If you
get bad results, try tweaking the settings.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select API endpoints.2

Click OpenAI-compatible endpoints.

TIP

If you already have OpenAI-compatible API endpoints set up, click Add another OpenAI
compatible endpoint.

3

Define the endpoint settings:4

Endpoint URL: Enter the URL of the service that provides the endpoint.

Display name (optional): Enter a short name that is prefixed to the model names in the
model switcher. By default, the model names are prefixed with "custom/".

API key (optional): If required, enter the API key for accessing the service.
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Click Check to validate the settings and click Save.5
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You have set up the OpenAI-compatible API endpoint. All space users can now use all models
available through the endpoint in GPT for Excel and GPT for Word.

TIP

To set up another OpenAI-compatible API endpoint, click Add another OpenAI compatible
endpoint and repeat steps 4 and 5.

What's next
Manage API keys for your space.

Manage models for your space.

Manage users in your team.

TIP

If you get an error saying that the URL is invalid, make sure that the endpoint supports:

Cross-origin resource sharing (CORS). See the LM Studio setup instructions for macOS
or Windows.

HTTPS (needed with Safari and with Microsoft Office for Mac). See the LM Studio
setup instructions for macOS.
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Billing
Buy credits, set spending limits, pause usage, and download invoices and usage reports for your
space.

Buy credits

Buy credits to use the GPT for Work add-ons.

Set spending limits

Set monthly spending limits for your space and for individual users from the GPT for Work dashboard.

Pause usage

Pause or resume all credit usage for the GPT for Work add-ons.

Download usage reports

As a space owner or admin, you can generate and download CSV usage reports with detailed per-user
information about feature and model usage, token consumption, and credit consumption.

Download invoices

Download invoices and receipts for credit pack purchases from the GPT for Work dashboard.
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Buy credits
You can buy credits at any time to use the GPT for Work Google add-on (GPT for Sheets and Docs)
or the GPT for Work Microsoft add-in (GPT for Excel Word). Credits expire one year after the last
purchase.

Microsoft

Once your payment is processed, your credits increase by the purchased amount.

TIP

To estimate your credit usage based on common use cases, try our estimation tools.

What's next
Download an invoice or a receipt for a credit pack purchase.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the Remaining credits section, click Buy credits.

INFO

If this option is not available, you can ask the owner of the space to buy credits.

2

Click Buy for the credit pack that best suits your needs.3

Enter your billing information and click Go to checkout.4

Enter your payment details and click Pay.5
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Set spending limits
Set monthly spending limits to control how much can be spent in your space each month. You can
set a limit for the entire space and individual limits per user.

Only the space owner or a space admin can set spending limits for a space.

Set a space monthly limit
A space monthly limit restricts the total amount that can be spent across all users in your space
per calendar month. When the limit is reached, all usage is blocked until you raise the limit or the
limit resets at the end of the calendar month.

Microsoft

The space monthly limit immediately applies to all users in the space.

EDIT OR REMOVE

To edit the space monthly limit, click Edit space monthly limit, edit the amount, and click
Apply.

To remove the space monthly limit, click Edit space monthly limit and click Remove.

Set user monthly limits
User monthly limits restrict the amount that an individual user can spend per calendar month.
When a user reaches their limit, that user's usage is blocked until the limit is raised or the limit
resets at the end of the calendar month. Other users in the space can continue using the add-ons
normally.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, click Limits.2

In the Space monthly limit section, click Set space monthly limit.3

Enter the amount, and click Apply.4

GPT for Work Documentation (Microsoft) 2026-05-13

357 / 415

https://gptforwork.com/docs/resources/guides/concepts#space
https://dashboard.gptforwork.com/


Set a default limit for future users

You can set a default monthly limit that applies to all new users who join the space. You can adjust
the monthly limit for individual users after they join.

Microsoft

The default monthly limit automatically applies to all users who join the space after this point.

EDIT OR REMOVE

To edit the default monthly limit, click Edit limit, edit the amount, and click Apply.

To remove the default monthly limit, click Edit limit and click Remove.

Set limits for current users

You can set monthly limits for individual users in your space. You can also apply the same limit to
all current users in the space in one go.

Microsoft

The user monthly limit immediately applies.

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, click Limits.2

In the User monthly limits section, click Set default monthly limit for new users.3

Enter the amount, and click Apply.4

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, click Limits.2

In the User monthly limits section, find the user and click Set limit.3

Enter the amount.4

(Optional) Select Apply to all users to apply the same limit to all current users in the space.5

Click Apply.6
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EDIT OR REMOVE

To edit monthly limits:

Single user: Click Edit limit for the user, edit the amount, and click Apply.

All users: Click Edit limit for any user, edit the amount, select Apply to all users, and
click Apply.

To remove monthly limits:

Single user: Click Edit limit for the user and click Remove.

All users: Click Edit limit for any user, select Apply to all users, and click Remove.

What's next
Manage users in your team.

Buy more credits.

GPT for Work Documentation (Microsoft) 2026-05-13

359 / 415

https://gptforwork.com/docs/admin/user-management
https://gptforwork.com/docs/admin/billing/buy-credits


Pause usage
Pause usage from the GPT for Work dashboard to prevent users in your space from running the
Google add-on (GPT for Sheets and Docs) or the Microsoft add-in (GPT for Excel and GPT for Word).
To control costs without fully blocking usage, set monthly spending limits instead.

Only the space owner or a space admin can pause or resume usage for a space.

Microsoft

To pause usage:

You've paused usage for the Microsoft add-in. Space users can no longer use GPT for Excel and
Word.

What's next
When you are ready to use the add-ons again, go to the GPT for Work dashboard, and click
Enable space usage.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the Remaining credits section, use the toggle to disable space credit usage.2
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Download usage reports
As a space owner or admin, you can generate and download CSV-format usage reports for your
space. You can select a predefined time range or define a custom time range for a report. The
reports provide detailed per-user information about feature and model usage, token consumption,
and credit consumption.

You are the owner or an admin of the space.

Microsoft

You've generated and downloaded the usage report. You can now view it on your computer.

What's next
Manage users in your team.

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, select Usage.2

Select the time range for which you want to generate the report.

If you want to define a custom time range:

The range is inclusive, so the report will include usage data from both the start date and end
date.

3

i. Select Custom range.1

ii. Select Start date.2

iii. Select End date.3

Click Generate usage report. The dashboard generates the report for the selected time
range.

4

Click Download. Your browser downloads the CSV file to your computer.5
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Download credit pack invoices and
receipts
Download invoices and receipts for past credit pack purchases for the GPT for Work Google add-on
(GPT for Sheets and Docs) or the GPT for Work Microsoft add-in (GPT for Excel Word).

You have purchased a credit pack.

Microsoft

What's next
Buy credits

Prerequisites

Sign in to the GPT for Work dashboard with your Microsoft account.1

In the sidebar, click Billing.

INFO

If this option is not available, you can ask the owner of the space for an invoice or a
receipt.

2

Click See and download invoices.3

In the Invoice history section, click on the purchase whose invoice or receipt you want to
download.

4

Click Download invoice or Download receipt.5
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Resources
Explore release notes, supported AI models, security and privacy, pricing, and user guides for GPT
for Work.

Release notes

Stay informed about the latest GPT for Work product updates on Sheets, Excel, Word, and Docs: New
models, new features, improvements, and fixes.

Models

Explore the AI providers and models supported by GPT for Work, and learn how rate limits and tokens
affect your usage.

Security and privacy FAQ

Learn how Talarian, the maker of GPT for Work, secures your data, protects your privacy, and complies with
international standards and regulations such as ISO 27001 and GDPR.

Pricing

Learn how GPT for Work's usage-based pricing works, how much AI models cost, how to buy more credits,
and estimate your costs.

Guides

Explore Agent use cases, familiarize yourself with basic AI concepts, and learn how to write better prompts
and scrape the web from Google Sheets.
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Models
Explore the AI providers and models supported by GPT for Work, and learn how rate limits and
tokens affect your usage.

AI providers and models

Explore the AI providers and models supported by GPT for Work on Microsoft Excel and Word, and Google
Sheets and Docs, and check the pricing per model.

Rate limits

Learn how GPT for Work relies on AI services that enforce rate limits.

Tokens

Learn what tokens are, how they work, and how they affect your credit usage in GPT for Work add-ons.
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AI providers and models supported by
GPT for Work
GPT for Work supports two types of models:

Agent models are used by the Agent to handle chat messages, create formulas, and execute
complex tasks by breaking them down into smaller tasks and delegating these to bulk models.

Bulk models handle bulk tasks and web search tasks. The Agent uses bulk models when
needed, and you use bulk models with bulk tools and GPT functions. The Agent can only use the
bulk models you set in the GPT for Work dashboard.

INFO

For information about the prices for each model, see Model prices.

Agent models
The following table lists the Agent models available in GPT for Work, without and with an API key.

Provider Model Without an API key With an API key 🔑

Anthropic Opus 4.7 Yes Yes

Anthropic Opus 4.6 Yes Yes

OpenAI GPT 5.5 Yes Yes

OpenAI GPT 5.4 Yes Yes

OpenAI GPT 5.1 Yes Yes

Bulk models
The following tables list the bulk models available in GPT for Work, without and with an API key.

Models without an API key

You can use models from OpenAI, Perplexity, Google, Anthropic, and Parallel.
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Provider Model Reasoning Vision Web search URL fetch

Search... Search... All All All All

OpenAI gpt-5.5 Yes Yes No No

OpenAI gpt-5.4 Yes Yes No No

OpenAI gpt-5.4-mini Yes Yes No No

OpenAI gpt-5.4-nano Yes Yes No No

OpenAI gpt-5.2 Yes Yes No No

OpenAI gpt-5.1 Yes Yes No No

OpenAI gpt-5-mini Yes Yes No No

OpenAI gpt-5-nano Yes Yes No No

OpenAI gpt-4.1 No Yes No No

OpenAI gpt-4.1-mini No Yes No No

OpenAI gpt-4.1-nano No Yes No No

OpenAI gpt-5-search-
api

No No Yes No

OpenAI gpt-4o-search-
preview

No No Yes No

OpenAI gpt-4o-mini-
search-preview

No No Yes No

OpenAI gpt-4o No Yes No No

OpenAI gpt-4o-mini No No No No

OpenAI gpt-5 Yes Yes No No

OpenAI gpt-5-chat No Yes No No

OpenAI gpt-4-turbo No No No No

OpenAI o1 Yes Yes No No

OpenAI o3-mini Yes No No No

OpenAI o3 Yes Yes No No
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Provider Model Reasoning Vision Web search URL fetch

OpenAI o4-mini Yes Yes No No

OpenAI gpt-3.5-turbo No No No No

Perplexity sonar No No Yes No

Perplexity sonar-pro No No Yes No

Google gemini-2.5-flash Yes No Optional Yes

Anthropic claude-4-6-
sonnet

Yes Yes No No

Anthropic claude-4-sonnet No Yes No No

Anthropic claude-4.5-
sonnet

No Yes No No

Anthropic claude-4.7-opus Yes Yes No No

Anthropic claude-4.6-opus Yes Yes No No

Anthropic claude-4.5-opus Yes Yes No No

Anthropic claude-4.5-
haiku

No Yes No No

Parallel speed No No Yes No

INFO

GPT for Docs ONLY supports OpenAI and Anthropic models.

Models with an API key

You can use models from OpenAI, Perplexity, Google, Anthropic, DeepSeek, Mistral, and xAI.

Provider Model Reasoning Vision Web search URL fetch

Search... Search... All All All All

OpenAI gpt-5.5 Yes Yes No No
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Provider Model Reasoning Vision Web search URL fetch

OpenAI gpt-5.4 Yes Yes No No

OpenAI gpt-5.4-mini Yes Yes No No

OpenAI gpt-5.4-nano Yes Yes No No

OpenAI gpt-5.2 Yes Yes No No

OpenAI gpt-5.1 Yes Yes No No

OpenAI gpt-5-mini Yes Yes No No

OpenAI gpt-5-nano Yes Yes No No

OpenAI gpt-4.1 No Yes No No

OpenAI gpt-4.1-mini No Yes No No

OpenAI gpt-4.1-nano No Yes No No

OpenAI gpt-5-search-api No No Yes No

OpenAI gpt-4o-search-
preview

No No Yes No

OpenAI gpt-4o-mini-
search-preview

No No Yes No

OpenAI gpt-4o No Yes No No

OpenAI gpt-4o-mini No No No No

OpenAI gpt-5 Yes Yes No No

OpenAI gpt-5-chat No Yes No No

OpenAI gpt-4-turbo No No No No

OpenAI o1 Yes Yes No No

OpenAI o3-mini Yes No No No

OpenAI o3 Yes Yes No No

OpenAI o4-mini Yes Yes No No

OpenAI gpt-3.5-turbo No No No No
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Provider Model Reasoning Vision Web search URL fetch

OpenAI gpt-3.5-turbo
(fine-tuned)

No No No No

OpenAI gpt-4o (fine-
tuned)

No No No No

OpenAI gpt-4o-mini
(fine-tuned)

No No No No

OpenAI gpt-4.1 (fine-
tuned)

No Yes No No

OpenAI assistant No No No No

Perplexity sonar No No Yes No

Perplexity sonar-pro No No Yes No

Perplexity sonar-
reasoning-pro

Yes No Yes No

Google gemini-3.1-
flash-lite-
preview

Yes No Optional Yes

Google gemini-3-flash-
preview

Yes No Optional Yes

Google gemini-3.1-pro-
preview

Yes No Optional Yes

Google gemini-2.5-flash Yes No Optional Yes

Google gemini-2.5-
flash-lite

Yes No Optional Yes

Google gemini-2.5-pro Yes No Optional Yes

xAI grok-4-1-fast Yes Yes No No

xAI grok-4-1-fast-
non-reasoning

No Yes No No

Anthropic claude-4-6-
sonnet

Yes Yes No No

Anthropic claude-4-sonnet No Yes No No
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Provider Model Reasoning Vision Web search URL fetch

Anthropic claude-4.5-
sonnet

No Yes No No

Anthropic claude-4.7-opus Yes Yes No No

Anthropic claude-4.6-opus Yes Yes No No

Anthropic claude-4.5-opus Yes Yes No No

Anthropic claude-4.1-opus No Yes No No

Anthropic claude-4.5-
haiku

No Yes No No

DeepSeek deepseek-
reasoner

Yes No No No

Mistral mistral-large No No No No

Mistral mistral-medium No Yes No No

Mistral mistral-small No No No No

Mistral ministral-8b No No No No

Mistral ministral-3b No No No No

INFO

GPT for Docs ONLY supports OpenAI and Anthropic models.

GPT for Word doesn't support DeepSeek models.

Models from an API endpoint

You can use any OpenAI-compatible API endpoint with GPT for Excel and Word. You can connect to
two main types of services:

Cloud-based LLM platforms provide access to models over the internet with no software
installation or setup required on your part. Popular examples include Anyscale, Azure AI,
Fireworks AI, and Together AI. The available models vary from platform to platform.

Local LLM servers run on a local machine, such as your own computer or another computer on
a local network. Popular examples include LM Studio, LocalAI, and Open WebUI. The available
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models depend on what's installed on the server you're using.

Models available through dedicated API endpoints do not consume credits, but require credits to
be available.

INFO

The Agent doesn't support bulk models from API endpoints.

What's next
Model prices

Manage available models

Estimate your costs

TIP

The tables on this page were created with Awesome Table Apps.
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Rate limits
GPT for Work extensions rely on services that enforce rate limits to ensure smooth and fair access
to everyone.

If you choose not to set up API keys, you will share rate limits with other GPT for Work users. By
setting API keys, you benefit from your own rate limits, which you can manage from these links:

For OpenAI models

For Anthropic models

For Mistral AI models

For Gemini models

Google rate limits:

If you use the GPT for Sheets and Docs add-on, you are also subject to the rate limits enforced by
Google, based on your type of account:

External service calls daily limits (URL fetch)

gmail.com 20k / day / gmail.com account

Google Workspace 100k / day / Google Workspace account

INFO

Google's rate limits apply to all add-ons and scripts, not just ours. If you use multiple
scripts or add-ons, your usage counts towards the same rate limits. GPT for Excel and Word
are not affected by Google's rate limits.
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Tokens
Tokens are the basic unit for measuring AI model usage. They directly affect your credit
consumption.

What is a token?
A token is a small unit of text that a model processes. Tokens can be:

Whole words (like "hello")
Parts of a word (like "mor" and "ning")
Punctuation marks (like "." or ",")

Symbols (like "$" or "@")
Spaces

The process of splitting text into tokens is called tokenization. The way text is split into tokens
depends on the model's tokenizer, which is specific to each AI provider. To see how text is split into
tokens, use our tokenizer tool.

Token counts for languages
Token counts vary by language because the way text is split into tokens differs from one language
to another.

English: 1 word ≈ 1.3 tokens

French/Spanish: 1 word ≈ 1.4 tokens

Chinese: 1 word ≈ 1.9 tokens

These figures are based on Beyond Fertility: Analyzing STRR as a Metric for Multilingual
Tokenization Evaluation and OpenAI documentation.
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INFO

These are rough estimates. Actual token counts vary based on the specific words, punctuation,
and formatting in your text. To see how text is split into tokens, use our tokenizer tool.

What counts as tokens in GPT for Work?
GPT for Work uses the following types of tokens:

Input tokens: The text you send to a model, including your prompt, cell values, global
instructions, and any internal instructions used by the add-on. Images can also be used as input
and are converted to tokens.

Output tokens: The text the model generates in response, such as translations, summaries, or
extracted data.

Reasoning models are trained to think before they answer, producing an internal chain of thought
before responding to a prompt. They generate two types of output tokens:

Reasoning tokens make up the model's internal chain of thought. These tokens are typically
not visible in the output from most providers.

Completion tokens make up the model's final visible response.

For more information, see How credits are consumed.

What's next
How credits are consumed

Model prices

Estimate your usage
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Security and privacy FAQ
In this article, we (Talarian, maker of GPT for Work) aim to answer the most frequent questions
about the security and privacy measures we implement and our compliance with global
regulations like the GDPR. For more details, check the Talarian security portal.

Compliance

Is your organization ISO 27001 certified?

Yes, we are certified under the ISO 27001 standard. The certificate is available through the Talarian
security portal.

Do you comply with GDPR and other privacy regulations?

Yes, we comply with GDPR. As a data controller, we process personal data in a fair, transparent and
secure way in accordance with our Privacy Policy. As a data processor, we process personal data
according to our Data Processing Agreement.

Security

Do you conduct independent third-party security testing?

Yes, we rely on annual third-party security assessments. The resulting reports are available
through the Talarian security portal. Also, our infrastructure is hosted on Google Cloud Platform,
which undergoes its own independent security audits.

We are certified under the CASA Tier 3 certification for Google, ensuring GPT for Work meets
Google's standards for security and privacy. Additionally, we have completed the Microsoft
publisher attestation for the Microsoft 365 App Compliance Program.

Is my data encrypted at rest and in transit?

Yes. We rely on Google's encryption-at-rest mechanism (which is based on the AES algorithm with a
key size of 256 bits). Google Cloud Platform's security infrastructure uses a common cryptographic
library called Tink, which includes the FIPS 140-2 validated module (named BoringCrypto) to
implement encryption consistently across Google Cloud.

For data in transit, we exclusively use TLS 1.2 and TLS 1.3 to ensure secure transmission. The
following data is also encrypted when in use: API keys, bulk tools configuration history (when GPT
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for Work is used with Google Sheets and Excel spreadsheets) and GPT functions cache (when GPT
for Work is used with Google Sheets and cache is enabled).

What measures are in place to prevent unauthorized access to
customer data?

We restrict and monitor access to production data on an as-needed basis. We use a robust access
control policy with quarterly admin rights reviews. We enforce stringent password security policies
and enforce Multi-factor Authentication (MFA) for all our personnel.

How do you ensure secured user identification?

We offer Single Sign-On (SSO) access to GPT for Work with Microsoft 365 (for GPT for Excel Word)
or Google Workspace (for GPT for Sheets and Docs). User identification security levels are therefore
those provided by either Microsoft or Google.

How do you handle software and hardware vulnerabilities?

With respect to the devices used to develop our application: hardware and software provided to our
employees are controlled under a centralized Mobile Device Management (MDM) solution. This
allows us to control our fleet and its usage. In this respect, critical software (such as antivirus and
vulnerability management solutions) are deployed on personnel's devices and strictly controlled
via our MDM solution.

With respect to the hosting of our application: we rely on the infrastructure provided by Google Cloud
Platform (GCP) and on its vulnerability and patch management programs.

Finally, the GPT for Work application is subject to our software development lifecycle (SDLC)
process where security by design is key, from the product initiative stage until the product delivery
stage. Through our continuous integration and continuous delivery (CI/CD) process, every new
piece of application code is subject to state-of-the-art code security scanning (which includes
detecting public vulnerabilities and ensuring compliance with frameworks such as OWASP Top10).

How do you ensure data center physical security?

As our application is hosted within data centers provided by Google, the physical security of our
infrastructure is managed by Google Cloud Platform. Additional information can be found in
Google Cloud Platform's security documentation available at:
https://www.google.com/about/datacenters/data-security/.
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Do you have a formal incident response plan?

Yes, as part of our ISO 27001 compliance framework, Talarian has security incident management
procedures in place. The customer notification process in the event of a data incident involving
personal identifiable information is set forth in our Data Processing Agreement.

Data & Privacy

What permissions are needed to use GPT for Work?

GPT for Work includes add-ons for Google Sheets and Google Docs (GPT for Sheets and Docs) as
well as add-ins for Microsoft Excel and Microsoft Word (GPT for Excel Word). GPT for Work requires
permissions to interact with these Google and Microsoft applications. Only the authorization
scopes necessary for GPT for Work's performance are requested.

Google permissions for GPT for Sheets and Docs

Authorization scope

When you install GPT for Sheets and Docs from the marketplace, you are asked to allow the
following:

INFO

By clicking 'Allow' or 'Continue', you indicate your acceptance of the Terms of Service and
Privacy Policy of GPT for Work.

Authorization scopes Why does GPT for Work need it

See your primary Google
account email address

Required to identify the user and fetch their associated
metadata.See your personal info,

including any personal info
you've made publicly available

View and manage documents
that this application has been
installed in

Allows GPT for Work to fetch the user-selected Google Docs
content in accordance with requests launched by the user
on the application. Also allows GPT for Work to insert data in
Google Docs in response to a user's request.
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Authorization scopes Why does GPT for Work need it

View and manage spreadsheets
that this application has been
installed in

Allows GPT for Work to fetch the user-selected Google
Sheets data in accordance with requests launched by the
user on the application. Also allows GPT for Work to insert
data in Google Sheets in response to a user's request.

Connect to an external service

Required to allow GPT for Work add-on to send/retrieve
information from its backend.
Even if this authorization is described as an 'external
service', it still stays within the Google environment because
GPT for Work is hosted on Google Cloud Platform.

Display and run third-party web
content in prompts and
sidebars inside Google
applications

Required to display GPT for Work sidebars inside Google
Sheets and Google Docs.

When you enable the 'Bulk Tools' functionality, you are asked to allow the following:

Authorization scopes Why does GPT for Work need it

See, edit, create, and
delete all your Google
Sheets spreadsheets

Allows GPT for Work to write results from AI providers into the
user's spreadsheets in response to an asynchronous user
request (through bulk tool runs).

There is unfortunately no way to limit that scope to specific
spreadsheets with the way that the Google Sheets API works.
However, GPT for Work never reads from or writes to
spreadsheets you didn't launch the add-on in.

How to review or revoke permissions

At any point in time, you can review the permissions you have granted for GPT for Sheets and
Docs. See more details here.

Microsoft Permissions for GPT for Excel Word

Authorization scope

When you install GPT for Excel Word from the marketplace, you are asked to allow the following:
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INFO

By clicking Accept, you indicate your acceptance of the Terms of Service and Privacy Policy of
GPT for Work.

Authorization scopes Why does GPT for Work need it

User's email address

Required to identify the user and fetch their associated
metadata.

User basic profile information
(including name, surname,
preferred username)

OpenID (user's unique identifier
and token)

offline_access
Required to keep the user signed-in. The offline_access
scope allows GPT for Work to receive refresh tokens from
the Microsoft identity platform token endpoint.

How to review or revoke permissions

At any point in time, you can review the permissions you have granted for GPT for Excel Word. See
more details here.

How is my data processed?

Here are some details as to the customer data used by GPT for Work, and which of this data is
being stored on GPT for Work's infrastructure (i.e., Google Cloud Platform).

User identification

This includes the following stored data: username, account email address, basic profile
information, GoogleID or MicrosoftID (as applicable). No other user identification data is stored.

Documents, Inputs, Outputs and Configurations

First, let's introduce three key concepts used in this paragraph:

Documents mean the spreadsheets (Google Sheets or Microsoft Excel) and documents (Google
Docs or Microsoft Word) in which the GPT for Work add-on is used;
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Inputs are the information you submit through GPT for Work. This includes:

the prompts and custom instructions you give (e.g. generating text, summarizing data or
analyzing content). When using the 'Bulk tools' functionality in Google Sheets or Excel, you
can configure these prompts and instructions, and these configurations are saved in your
history for easy reuse (Configurations); and

the portion of the Documents submitted along with these prompts and instructions (e.g.
relevant cells of your spreadsheets and parts of your documents) (Submitted Document
Portions). To avoid any doubt, Configurations do not contain any Submitted Document
Portions; and

Outputs are the results generated by AI providers based on your Inputs.

Here is how GPT for Work uses your Documents, Inputs, Outputs and Configurations:

Documents

Except when you are using the 'Agent' functionality, GPT for Work does not read or store any
data from your Documents that you do not use as an Input in your prompt.

When using the 'Agent' functionality, GPT for Work automatically selects the relevant parts of
the Document that are necessary to respond effectively to your request. As of July 21, 2025, the
'Agent' feature is available in Beta mode to a select number of users only in Google Sheets and
operates exclusively via Talarian’s own API key(s) (OpenAI's model).

GPT for Work sends your Inputs to the relevant AI provider's API or custom endpoint and writes
the resulting Outputs in your Document.

Inputs & Outputs

If you use a custom endpoint (as opposed to a model with API keys), such as on-premise
inference servers (e.g., Ollama) or an Azure endpoint, the Inputs submitted and Outputs
received do not go through our infrastructure, as the GPT for Work add-ons directly call the set
endpoint. The use of custom endpoints therefore constitutes the most private option currently
available.

If you use a model with an API key, GPT for Work does not log any of the Inputs submitted or
Outputs received. By using an API key, your AI provider usage (e.g. data retention, rate limits,
cost, moderation) is bound by the terms you negotiated with your AI provider.

If you use a model without an API key, we log all the Inputs and Outputs for support purposes
for a duration of 30 days. We also store them for product improvement purposes (excluding the
training of any language model) for no longer than 1 year. Outputs and Inputs may be stored for
up to 5 years and can only be accessed on an ad hoc and as-needed basis by the authorized
personnel.

In Google Sheets only, and only if cache is enabled, Inputs and Outputs of executions made
through GPT functions are cached encrypted for a short period of time (30 days) to prevent
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unexpected costs and loss of data due to Google Sheets automated recalculations. This caching
occurs regardless of whether you use a model with or without an API key.

Configurations

When you use the 'Bulk tools' functionality in Google Sheets or Excel, your bulk tools
Configurations are securely stored in encrypted form for a limited period (90 days) to support
the history feature.

Examples of data that may be contained in Configurations include your desired translation
glossary (if you are using the 'translate' tool) or your tailored classification instructions (if you
are using the 'classify/categorize' tool). To avoid any doubt, Configurations do not contain any
Submitted Document Portions.

Settings

These include the name of the model and the AI provider, the temperature (i.e., the setting that
controls the creativity of a model’s response), and any custom instruction you decide to insert to
provide context and shape how the chosen model responds.

Metadata relating to your Documents

GPT for Work stores the following additional data from your Document:

Google Sheets: spreadsheets ID (identifier of the spreadsheet), sheet IDs (identifier of the sheet
within a specific spreadsheet), sheet name; and

Google Docs: Google Doc ID.

Usage metadata

These are data events corresponding to the different actions of GPT for Work users (e.g., user
clicking on the 'Run' button).

API keys and custom endpoints

If you set up API keys for AI providers or use custom endpoints, they will be stored encrypted in
transit, at rest and in use on Google Cloud Platform.

When setting up a team, space owners and admins can choose whether team members are
allowed to use their own API keys and, in GPT for Excel Word, their own custom endpoints. In other
words, space owners and admins have complete control over which AI providers and models are
available to their space members.
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Subscription data

This includes the following stored data: current plan details, transaction details (amount, invoice ID
and payment date), details of the invoiced person or company (customer email and customer ID).
We do not store payment card credentials on Talarian's infrastructure and always rely on Stripe, a
third-party PCI-DSS-compliant payment processor, for payment card processing.

Is my data used by GPT for Work to train models?

No. Whether you use a model with or without an API key, Talarian does not use your Inputs and
Outputs to train language models. Also, according to their terms as of July 21, 2025, the AI provider
APIs we rely on (when using GPT for Work through Talarian's own API key(s)) currently do not use
your Inputs and Outputs to train their models.

To check the AI provider's models available with or without an API key, please see our list of
supported models.

Who owns Inputs and Outputs?

As between you and Talarian, you retain all rights in your Inputs and Outputs. More details are
available in GPT for Work terms of service.

What do you do with my API Key and custom endpoints, when I
use them within GPT for Work add-ons?

If you set up API keys for AI providers or use custom endpoints, they will be stored encrypted in
transit, at rest and in use on Google Cloud Platform.

Do you store payment card information?

We don't store payment card credentials. Payments are processed through Stripe
(https://stripe.com/en-fr). They are a PCI Service Provider Level 1 organization. Using Stripe means
we don't need to store your payment card credentials.

You can read more about security at Stripe here: https://stripe.com/docs/security/stripe.

Where is my data located?

The Google Cloud Platform datacenters on which your data is stored are located in the United
States - us-central1 region (Iowa). More details on Google Cloud Platform's region are available
here.
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Do you sell any of my data?

No, we never sell data.

Do you use third-party service providers?

Yes. GPT for Work relies on or interacts with several service providers in order to operate. They fall
within 2 different categories:

Talarian's third-party service providers

These are service providers with which we hold a contractual relationship. They help us with
various services including cloud hosting, generative AI provision or support ticket management.

Whenever we share data with these service providers, we make sure that they use it in compliance
with data protection legislation, and that the personal data processing they carry out is covered by
a specific data processing contract. They are of two sorts:

Talarian's subprocessors

They process personal data for which we are a processor, following our instructions. This
processing is carried out as part of the services you have subscribed to. You will find details of our
subprocessors in our Data Processing Agreement.

Service provider Purpose

Google LLC or any of its affiliates Data hosting, Generative AI*

Zendesk, Inc. Support

OpenAI OpCo, LLC or any of its affiliates Generative AI*

Anthropic, PBC or any of its affiliates Generative AI*

Perplexity, Inc. Generative AI*

Functional Software, Inc. (d/b/a Sentry) Error Monitoring

* Google LLC, OpenAI OpCo, LLC, Anthropic, PBC, and Perplexity, Inc. are engaged for Generative
AI purposes only to the extent (i) you are using GPT for Work through Talarian's own API key(s) and
(ii) choose any such third-party service provider as AI provider.

Talarian's processors
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They process data for which we act as the controller, and therefore act as processors.

Service provider Purpose

SalesForce, Inc. CRM

Sendinblue, SAS (d/b/a Brevo) Transactional and marketing email

Slack Technologies Limited Internal communication tool

Google Ireland Limited (Google Workspace) Collaboration tool

Microsoft Corporation (Microsoft Clarity) Front end analytics

Retool, Inc. Admin dashboards for customer support

Other third-party service providers

These are third-party service providers with which you hold directly a contractual relationship.
These can be of various types, notably:

AI providers that you use by creating and setting up API keys or via a custom endpoint. The full list of
these AI providers are set forth in section "Models you can use with an API key" of the following
page: https://gptforwork.com/docs/resources/models/ai-providers-and-models.

Payment processor. Payments are processed through Stripe (https://stripe.com/en-fr), which is a
PCI Service Provider Level 1 organization. By purchasing GPT for Work you accept to be bound
by the Stripe terms and conditions (https://stripe.com/en-fr/legal/consumer).

Can I have my data deleted?

Yes, you can.

As long as your GPT for Work account is active, we retain your data in accordance with our Privacy
policy and Data Processing Agreement. Upon deletion of your GPT for Work account, we may
archive your data only for a specified period of time in accordance with our internal data retention
policy, and in any case no longer than legally permitted.

To request all your data to be deleted following deletion of your GPT for Work account, submit
your request via our contact form and write 'Data Deletion request' as the subject line.

Deleting your data will interrupt GPT for Work's functionality. Signing up again with the same
Google or Microsoft account will not restore the deleted data.
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How can I send you a privacy complaint?

For privacy complaints, you can reach us at: legal@talarian.io.
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Guides
Explore Agent use cases, familiarize yourself with basic AI concepts, and learn how to write better
prompts and scrape the web from Google Sheets.

Agent use cases

Learn about the different spreadsheet use cases that you can tackle with the Agent in GPT for Sheets and
GPT for Excel.

Concepts

Familiarize yourself with the basic concepts related to GPT for Work, AI, and large language models (LLM).

How to write a good prompt

Write a good prompt to get the best results from our add-ons.

Scrape the web

Retrieve information from specific web pages.
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Agent use cases for Sheets and Excel
Learn about the different spreadsheet use cases that you can tackle with the Agent in GPT for
Sheets and GPT for Excel. You can explore the use cases by business application or product
capability.

Business applications

Use the Agent in GPT for Sheets or GPT for Excel to handle product management, SEO, paid ads, outbound
sales, market analysis, and customer feedback.

Product capabilities

Use the Agent in GPT for Sheets or GPT for Excel to handle content generation, translation, web search,
data preparation, data analysis, formulas, and categorization.
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Business applications for the Agent in
Sheets and Excel
The Agent in GPT for Sheets and GPT for Excel allows you to tackle common business tasks in bulk
with conversational AI. This page provides practical examples of how to use the Agent across
different business applications.

How to use the Agent examples
To try out the use cases in GPT for Sheets or GPT for Excel, use the built-in examples from the add-
on sidebar.

MS Excel

Create a new blank workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, click Examples and select the example you want to try out.3
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Product management

E-commerce

Use the Agent to generate product descriptions, product listings, and other content for your e-
commerce website.

In this example, the Agent is used to generate a title and description for the products in column A,
then categorize them and extract the main features.

MS Excel

Watch video on YouTube

Data prep (inventory)

Use the Agent to prepare your data for analysis or reporting. This can include cleaning,
transforming, or formatting your data to make it more useful for your purposes.

MS Excel

Watch video on YouTube

Click the send button to start the example.

The following video shows the entire process.

4
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SEO

Translate to multiple languages

Use the Agent to translate spreadsheet content to multiple languages in bulk. You can provide
specific instructions for the translation, and even use a glossary stored in another sheet to have
the translation follow your brand's terminology.

In this example, the Agent is used to translate the content of column A to the languages provided
in row 1.

MS Excel

Watch video on YouTube

SEO (h1, metas, FAQs)

Use the Agent to generate SEO-friendly content for your website. Bulk-generate meta titles and
descriptions, headers, FAQs, image alt texts, and more.

In this example, the Agent is used to generate titles and descriptions for car spare parts, then
generate FAQs about them.

MS Excel

Watch video on YouTube

Paid ads

Google Shopping (titles & categories)

Use the Agent to generate optimized content for your Google Shopping listings or for other
product catalogs or paid ads.

In this example, the Agent is used to improve product titles and assign categories based on the
official Google Shopping guidelines.

MS Excel

Watch video on YouTube
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Outbound sales

ICP fitness

Use the Agent to filter your leads and find companies and contacts that match your ideal customer
profile, based your own criteria.

In this example, the Agent is used to analyze the leads based on their industry fit, role fit, location,
and company size.

MS Excel

Watch video on YouTube

Market analysis

Market research

Use the Agent to generate market overviews or company profiles in bulk by fetching information
from the web.

In this example, the Agent is used to research the companies in column A, and find their website,
CEO name, and other information.

MS Excel

Watch video on YouTube

Customer feedback

Feedback analysis

Use the Agent to categorize, filter, tag and analyze customer feedback and survey responses. This
can include sentiment analysis, key topic extraction, brand and product mention identification, and
more.

In this example, the Agent is used to translate support tickets to a common language, classify
them based on sentiment, and define their relevance to product quality.
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MS Excel

Watch video on YouTube

What's next?
Use the Agent in GPT for Sheets or GPT for Excel.

Learn about the Agent's product capabilities.
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Product capabilities of the Agent in
Sheets and Excel
The Agent in GPT for Sheets and GPT for Excel allows you to tackle common tasks in bulk with
conversational AI. This page provides practical examples of how to make the most out of the
Agent's various capabilities.

How to use the Agent examples
To try out the use cases in GPT for Sheets or GPT for Excel, use the built-in examples from the add-
on sidebar.

MS Excel

Create a new blank workbook.1

On the ribbon, select Home > GPT for Excel Word.

INFO

If GPT for Excel Word is not visible on the ribbon, or if it's grayed out, select Home > Add-
ins > My Add-ins > GPT for Excel Word. Learn more.

2

In the sidebar, click Examples and select the example you want to try out.3
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Content generation

SEO (h1, metas, FAQs)

Use the Agent to generate SEO-friendly content for your website. Bulk-generate meta titles and
descriptions, headers, FAQs, image alt texts, and more.

In this example, the Agent is used to generate titles and descriptions for car spare parts, then
generate FAQs about them.

MS Excel

Watch video on YouTube

Translation

Translate to multiple languages

Use the Agent to translate spreadsheet content to multiple languages in bulk. You can provide
specific instructions for the translation, and even use a glossary stored in another sheet to have
the translation follow your brand's terminology.

In this example, the Agent is used to translate the content of column A to the languages provided
in row 1.

MS Excel

Watch video on YouTube

Click the send button to start the example.

The following video shows the entire process.

4
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Feedback analysis

Use the Agent to categorize, filter, tag and analyze customer feedback and survey responses. This
can include sentiment analysis, key topic extraction, brand and product mention identification, and
more.

In this example, the Agent is used to translate support tickets to a common language, classify
them based on sentiment, and define their relevance to product quality.

MS Excel

Watch video on YouTube

Web search

Market research

Use the Agent to generate market overviews or company profiles in bulk by fetching information
from the web.

In this example, the Agent is used to research the companies in column A, and find their website,
CEO name, and other information.

MS Excel

Watch video on YouTube

Data preparation

Data prep (inventory)

Use the Agent to prepare your data for analysis or reporting. This can include cleaning,
transforming, or formatting your data to make it more useful for your purposes.

MS Excel

Watch video on YouTube
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Data analysis

ICP fitness

Use the Agent to filter your leads and find companies and contacts that match your ideal customer
profile, based your own criteria.

In this example, the Agent is used to analyze the leads based on their industry fit, role fit, location,
and company size.

MS Excel

Watch video on YouTube

Feedback analysis

Use the Agent to categorize, filter, tag and analyze customer feedback and survey responses. This
can include sentiment analysis, key topic extraction, brand and product mention identification, and
more.

In this example, the Agent is used to translate support tickets to a common language, classify
them based on sentiment, and define their relevance to product quality.

MS Excel

Watch video on YouTube

Formulas

Generate and autofill formulas

Use the Agent to generate, troubleshoot, and explain spreadsheet formulas without writing any
formula code yourself. Simply describe in your own words what calculation or logic you need, and
the Agent creates the appropriate formulas. This is particularly useful for complex nested formulas
or functions you're unfamiliar with.

In this example, the Agent is used to generate a formula to calculate the seniority of employees in
years and months.

MS Excel

Watch video on YouTube
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Categorization

E-commerce

Use the Agent to generate product descriptions, product listings, and other content for your e-
commerce website.

In this example, the Agent is used to generate a title and description for the products in column A,
then categorize them and extract the main features.

MS Excel

Watch video on YouTube

Google Shopping (titles & categories)

Use the Agent to generate optimized content for your Google Shopping listings or for other
product catalogs or paid ads.

In this example, the Agent is used to improve product titles and assign categories based on the
official Google Shopping guidelines.

MS Excel

Watch video on YouTube

What's next?
Use the Agent in GPT for Sheets or GPT for Excel.

Learn about the Agent's business applications.

GPT for Work Documentation (Microsoft) 2026-05-13

397 / 415

https://www.youtube.com/watch?v=Etq2L22K0Q8
https://www.youtube.com/watch?v=fRc06mDN7Po
https://gptforwork.com/docs/gpt-for-sheets/agent
https://gptforwork.com/docs/gpt-for-excel/agent
https://gptforwork.com/docs/resources/guides/agent-use-cases/business-applications


Concepts
Learn about the key concepts related to GPT for Work.

AI concepts

AI provider

Company, platform, or server that provides models to GPT for Work add-ons. GPT for Work
integrates with multiple AI providers, including OpenAI, Anthropic, and Google. See the
complete list of supported models.

API endpoint

URL address that gives access to one or more models served by an AI provider. An API
endpoint acts as the "gateway" through which GPT for Work sends your prompts, model
settings, and other parameters, and from which it receives the model's responses. Using API
endpoints gives you access to more models and affords you more control and privacy.

You set up API endpoints for your space in the GPT for Work dashboard. All users in the
space automatically have access to any and all models available through the endpoints, but
only the space owner and admins can set and manage the endpoints. Learn more.

API key

Unique identifier that grants access to models served by AI providers. Using an API key gives
you access to more models and affords you more control and privacy. Using an API key can
also lower costs if you're on usage-based pricing.

You set API keys for your space in the GPT for Work dashboard. All users in the space
automatically have access to any and all models associated with the keys, but only the space
owner and admins can set and manage the keys. Billing for a key reflects its usage by all
users. Learn more.

Global instructions

Specific guidelines provided to the model to define its role, expertise, or how it should
respond to prompts. Global instructions are set in the sidebar of the GPT for Work add-ons,
and remain active in the document or spreadsheet until you change them.
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Formula (spreadsheet)

A spreadsheet formula is an expression you enter into a spreadsheet cell to calculate a value,
process text, retrieve data, or perform some other task that returns a result. Formulas can
contain functions, cell references, operators, as well as numbers, text, and other values. A
formula always starts with the equal sign = , which tells the spreadsheet to evaluate the
expression instead of treating the entry as plain text.

The following simple formula consists of single function, SUM , which adds values:

The following more complex formula, which consists of two functions, one nested inside the
other, runs the inner GPT  function only if the cell A1  is not blank, which is determined by
the outer IF  function. If A1  is not blank, the formula returns the result from the GPT
function; if A1  is blank, the formula returns an empty value.

Function (spreadsheet)

A spreadsheet function is a predefined formula that performs a specific task in a
spreadsheet, such as calculating values, processing text, or retrieving data. Functions always
return a result. Functions typically take one or more parameters as input, which tell them
how exactly to perform their task and generate their result. For example, the SUM  function
adds values:

Functions can be divided into native functions, which are built into the spreadsheet software,
such as SUM  in Excel and Sheets, and custom functions, which come from user scripts or
third-party software, such the GPT  function in GPT for Excel and GPT for Sheets.

You can use a function on its own (a simple formula) or combine it with other functions to
create more complex formulas, optionally with nesting and conditional logic.

Model

Large language model (LLM) used in a GPT for Work add-on.

The available models depend on whether you are using an API key or have access to cloud-
hosted models or local models through API endpoints. See the complete list of supported

=SUM(A1:A5)

=IF(A1="", "", GPT("Write a tagline for", A1))

=SUM(A1:A5)
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models.

Cloud-hosted model

Model served over the internet by a cloud-based LLM platform. This is in contrast to models
served by an LLM server running on a local machine. Compared to local models, cloud-
hosted models generally run on more powerful hardware, but require online access and
involve sending data over the internet to an external service. For using cloud-hosted models,
GPT for Work supports multiple AI providers, both model creators, such as OpenAI,
Anthropic, and Google, and model hosts, such as Anyscale, Fireworks AI, Together AI, or any
platform with an OpenAI-compatible API endpoint.

Local model

Model served by an LLM server running on a local machine, such as your own computer or
another computer on a local network. This is in contrast to models served over the internet
by cloud-based LLM platform. Compared to cloud-hosted models, local models offer
enhanced data privacy and offline access. For using local models, GPT for Work supports any
LLM server with an OpenAI-compatible API.

Web search model

All web search models can go beyond their built-in knowledge by accessing information from
search engines, like Google or Bing. This allows models, which have compressed historical
knowledge, to explore topics in greater depth, with more current data or with a specific
focus.

Web search context

Web search models do not fetch full page content. Instead, they read search result snippets,
like you would see on a Google search results page. The snippets are added to the context of
the models, so they can use the information to generate a response. The larger the context,
the more information a model can retrieve from each web source, producing richer and more
detailed responses. For some models, you can select the context size in the model settings.

Content fetching model

Some web search models can access the full content from specific URLs. The full content is
added to the context of the models, so they can use it to answer questions about the content
or extract information from it.

Reasoning model

Reasoning models are trained to think before they answer, producing an internal chain of
thought before responding to a prompt. They generate two types of output tokens:
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Reasoning tokens make up the model's internal chain of thought. These tokens are
typically not visible in the output from most providers.

Completion tokens make up the model's final visible response.

Vision model

Vision models can process images as input. The following features support vision models:

Custom prompt bulk tool in GPT for Sheets and GPT for Excel

Prompt images (Vision) bulk tool in GPT for Sheets and GPT for Excel

GPT_VISION function in GPT for Sheets and GPT for Excel

For information about supported and recommended vision models, see:

Use images in bulk tool prompts in Sheets / Use images in bulk tool prompts in Excel

Use images in GPT function prompts in Sheets / Use images in GPT function prompts in
Excel

Prompt

Input text given to the model to generate a response or perform a task. Prompts can be
included in the sidebar of the GPT for Work add-ons, or passed as arguments in GPT
functions. For guidance, see How to write a good prompt.

Rate limit

Restriction on the number of tokens or on the number of requests that can be processed
within a certain time frame (minute, day, month). AI providers set rate limits on their models.
Google also enforces rate limits on the daily number of requests. Learn more.

Token

A token is a unit of text, such as a word, subword, punctuation mark, or symbol. Models split
all input and output text into tokens for processing. Model providers use tokens as the basic
unit for measuring model usage. The total number of tokens in a prompt (input) and the
model's response (output) determines your credit consumption. For more information, see
Tokens and How credits are consumed.
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GPT for Work concepts

Agent

The Agent is the chat interface for spreadsheet work in GPT for Excel and GPT for Sheets.
Describe what you need in plain language — from everyday spreadsheet tasks to row-by-row
bulk processing across large datasets — and the Agent reads your data, determines the
required steps, and executes them directly in your spreadsheet.

For more information, see Agent in GPT for Sheets and Agent in GPT for Excel.

Agent model

Model used by the Agent to handle chat messages, thinking, and any spreadsheet task that
doesn't require bulk processing with AI. For a list of supported Agent models, see AI
providers & models.

Bulk tools

Bulk tools allow you to run prompts on specific spreadsheet columns at once without writing
any formulas. You configure and run bulk tools from the add-on sidebar. You can also easily
reuse past prompts and configurations with the History feature.

GPT for Work provides dedicated bulk tools for selected use cases, such as translation,
classification/categorization, and extraction, as well as a generic bulk tool for fully custom
prompts.
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For more information, see Bulk tools in GPT for Sheets and Bulk tools in GPT for Excel.

Bulk model

Models used in bulk tools (manually or Agent-run) and GPT functions to perform bulk
processing with AI. For a list of supported bulk models, see AI providers & models.

GPT functions

GPT functions are custom spreadsheet functions that allow you to prompt AI from inside
spreadsheet cells. GPT functions work exactly like native functions in that you can use them
on their own or combine them with other functions when creating formulas.

GPT for Work provides dedicated GPT functions for selected use cases, such as translation,
classification, and web search, as well as a generic GPT function for all other use cases. You
can define function-specific parameters to further refine how the AI generates responses.
You can find a list of all available functions with usage examples in the add-on sidebar.

For more information, see All GPT functions in GPT for Sheets and All GPT functions in GPT
for Excel.

Sidebar

Panel in GPT for Work add-ons where users can interact with the AI, input prompts, and
adjust settings. When you launch the GPT for Work add-ons, the sidebar opens on the right
side of the screen.
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MS Excel

MS Word

Space

A space is the administrative hub for GPT for Work. Available through the GPT for Work
dashboard, it centralizes purchases, billing, usage controls, and API keys for an individual
user or a team.

If you sign in to both GPT for Sheets and Docs (Google) and GPT for Excel and Word
(Microsoft), you will have two separate spaces. These spaces are independent: credits, users,
and API keys do not carry over between platforms.

You can be active in only one space at a time. If you join another user's space, you lose
access to your own space's credits, API keys, and API endpoints.

In the screenshot below, you can see the overview of a GPT for Sheets and Docs space with
three space users.
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How to write a good prompt
Write a good prompt to get the best results from our add-ons. Be very specific about what you
want and prompt exactly like you would brief a person to do the job, by providing clear instructions
and ample context.

While models can sometimes process multi-lingual prompts or generate a response in a different
language from the prompt language, it is highly recommended to write your prompt in the
language that you expect your response to be in.

You can also check out our OpenAI GPT prompt generator.

Label Description Examples

Task

What you want to achieve

Note: This should be
composed of at least a verb
and a noun. You can replace
"Task" by "Question" if it
makes more sense.

Task: write a cold email

Task: write a blogpost

Task: write 5 taglines

Task: summarize in 3 paragraphs

Task: translate from English to 
Spanish

Task: create a tweet thread of 10 
tweets

Question: How can I find an SEO 
expert?

Topic

What your text is about

Note: Don't hesitate to be
highly specific.

Topic: sell a shampoo

Topic: an ice-cream shop

Topic: food in Ancient Rome
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Label Description Examples

Role
What character the AI has to
impersonate

Role: Act as a teacher. Write in very 
basic terms, and illustrate with 
examples adapted to your audience. Then 
provide links to explore the topic 
further.

Role: Act as a tech reviewer. You write 
in-depth reviews including pros, cons, 
features, and benchmarks.

Role: Act as a technical writer. Your 
writing is very structured and 
hierarchical. Instructions are provided 
step by step so the reader can apply 
them without thinking.

Style
What type of language you
want to use

Style: casual

Style: formal

Style: business

Style: creative

Style: academic

Tone
How you want your text to
sound

Tone: joyful

Tone: angry

Tone: funny

Tone: serious

Tone: excited

Tone: sad
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Label Description Examples

Audience

Who this text is for

Note: This enables the model
to select appropriate words
and the right level of
abstraction.

Audience: 5-year old

Audience: teenager who likes rock 
music

Audience: my boss

Audience: topic expert

Length

How long the output is
expected to be (any unit)

Note: Language models have
limited numerical accuracy, so
it's good to be overly precise if
you have a hard limit.

Length: 4 paragraphs

Length: 250 words

Length: strictly under 30 characters 
including spaces

Format
What structure or syntax your
output must comply with

Format: HTML

Format: table

Format: markdown

Any other parameter or
instruction that is useful to you

Country: X

Product: door bell

Relate recipient job title to the user 
selling proposition

Sign as XYZ

Start with xxx

Include references to X, Y and Z

It is then extremely easy to write a good prompt that you can then use with our add-ons.

Spreadsheets

This is what your prompt should look like in a spreadsheet with GPT for Sheets or GPT for Excel
Custom prompt bulk tool:
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Task: Write a cold email
Style: Salesy
Tone: Funny
Topic: Sell the person on the idea of building their brand and growing their 
business through social media videos with our company Brandtegic.
Length: 3 paragraphs

Learn more about GPT for Sheets Custom prompt bulk tool or GPT for Excel Custom prompt bulk
tool.

Documents

This is what a prompt should look like in a document with GPT for Word:

This is what a prompt should look like in a document with GPT for Docs:

You can copy this prompt from the text below:

GPT for Work Documentation (Microsoft) 2026-05-13

408 / 415

https://gptforwork.com/docs/gpt-for-sheets/bulk-tools/reference#custom-prompt
https://gptforwork.com/docs/gpt-for-excel/bulk-tools/reference#custom-prompt
https://gptforwork.com/docs/gpt-for-excel/bulk-tools/reference#custom-prompt
https://gptforwork.com/docs/gpt-for-word
https://gptforwork.com/docs/gpt-for-docs


Scrape the web from Google Sheets
Retrieve information from specific web pages directly into your Google Sheets spreadsheet using
our web scraping script. The script imports text into your cells while automatically removing HTML
and formatting.

TIP

You can also use the Fetch content from URL bulk tool.

Install the script in your spreadsheet

Install the web scraping script in your spreadsheet to enable the import of web page content:

Install the script in your spreadsheet.1

Launch scraping:2

On multiple URLs at once using the Scrape menu

On a single URL using the GPT_SCRAPE function

From the Extensions menu in your spreadsheet, click Apps Script.

A new project opens on the Apps Script page.

1

Copy and paste the script into the script editor.2

/**
* @OnlyCurrentDoc
*/

const SHEETS_CELL_LIMIT = 50000;
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function onOpen() {
  SpreadsheetApp
  .getUi()
  .createMenu("Scrape")
  .addItem("Scrape URLs in column A", "ScrapeAB")
  .addToUi()
}

/**
  * @param {"https://en.wikipedia.org/wiki/ChatGPT"} url The url to scrape
  * @customfunction
  */
function GPT_SCRAPE(url) {
  const res = UrlFetchApp.fetch(url);
  if (res.getResponseCode() >= 300) {
    return `Error: response code ${res.getResponseCode()}`;
  }
  const html = res.getContentText();
  const text = cleanup_html(html);
  // html.substring(0,SHEETS_CELL_LIMIT),
  return text.substring(0,SHEETS_CELL_LIMIT);
}

function cleanup_html(html) {
  // remove tags
  const tag_free = html
    .replace(/<style([\s\S]*?)<\/style>/gi, "")
    .replace(/<script([\s\S]*?)<\/script>/gi, "")
    .replace(/<[^>]+>/g, "");

  // replace html entities
  let decoded = tag_free;
  try {
    const xml = XmlService.parse('<d>' + tag_free + '</d>');
    decoded = xml.getRootElement().getText();
  } catch (e) {
    // unable to decode some HTML entity
  }

  // remove repeated spaces
  const clean = decoded
    .replace(/\n\s*\n/gi, "\n")
    .replace(/&nbsp;/gi, " ")
    .trim();

  return clean;
}
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function ScrapeAB() {
  const range = SpreadsheetApp.getActiveSpreadsheet().getRange("A:B");
  const values = range.getValues().slice(1)

  let urls = 0
  let done = 0

  for (const row of values) {
    const url = row[0];
    const res = row[1];
    if (!url) continue;
    urls++;
    if (!res) continue;
    done++;
  }

  if (urls === done) {
    SpreadsheetApp.getUi().alert(`Found ${urls} urls, ${done} already 
scraped. Nothing to be done.`)
    return;
  }
  SpreadsheetApp.getUi().alert(`Found ${urls} urls, ${done} already 
scraped. Scraping ${urls - done}...`)

  for (let irow = 0; irow < values.length; irow++) {
    row = values[irow];
    const url = row[0];
    const res = row[1];
    if (!url || res) continue;
    const text = GPT_SCRAPE(url)
    range.getCell(irow+2, 2).setValue(text);
  }
}

Save the project and click Run.3
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An Authorization required pop-up appears.

Click Review permissions to accept the necessary access rights for the script.

You are prompted to select a Google account.

4

Choose the account you are using for the spreadsheet. This ensures the script works correctly
within your document.

5

Click Allow to grant these permissions.6
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INFO

The following permissions are necessary for the script to run:

View and manage spreadsheets that this application has been installed in: Required
for the script to specifically interact with the spreadsheets where it's installed, whether it's
adding, modifying, or removing data.
Connect to an external service: Required for the script to browse web pages and import
the content to your Google Sheets.

You can now scrape multiple URLs at once in your spreadsheet or scrape a single URL using
GPT_SCRAPE.

Scrape multiple URLs with the Scrape menu

You have installed the web scraping script in your spreadsheet.

You have entered the URLs in column A of your spreadsheet, starting from the second row.

This script processes the web page URLs in column A, and write the scraped content into column B,
ready for you to edit directly. It removes complex codes and styles, leaving only text, and includes
the page's title and main body text.

Prerequisites

From the Scrape menu, select Scrape URLs in column A.

A confirmation pop-up appears.

1

Click OK to launch the script.2
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Scrape a single URL with GPT_SCRAPE

You have installed the web scraping script in your spreadsheet.

Type a GPT_SCRAPE formula into a cell, for example =GPT_SCRAPE("https://talarian.io") ,
and press Enter to generate the result:

Prerequisites
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This function browses content from the specified web page and imports it into the cell. To edit a
cell's content, copy the cell and use Paste special, and Values only for pasting.

INFO

Using the GPT_SCRAPE function does not affect your credit usage.

Limitations

Note the following limitations of the web scraping script:

Caution is advised when scraping content from web pages to adhere to website policies and
prevent server overload. Spacing out requests can prevent issues such as IP blocking or service
restrictions.

Each import is capped at 50,000 characters of text. Content beyond this limit will be truncated.

Web pages heavily reliant on JavaScript might not be fully captured by this script.

This script is optimized for HTML content. It may not perform optimally with APIs that return
structured data, such as JSON.

What's next
Use bulk tools on the scraped content.
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